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POUR	COMMENCER

INSTALLATION

CHROMEBOOK
Liens	externes

INSTALLATION	SUR	WINDOWS
Windows
Installation
Démarrer	MuseScore
Désinstallation

Voir	aussi

INSTALLATION	SUR	MACOS
Installation
Désinstallation
Installer	avec	Apple	Remote	Desktop
Liens	externes

INSTALLER	SUR	LINUX
Linux
AppImage
Step	1	-	Download
Step	2	-	Give	execute	permission
Step	3	-	Run	it!
Installing	the	AppImage	(optional)
Using	command	line	options

Distribution	Packages
Fedora

Voir	aussi
External	links

CRÉER	UNE	NOUVELLE	PARTITION
Centre	de	démarrage
Créer	une	nouvelle	partition
Titre,	compositeur	et	autre	information

Sélectionner	un	modèle
Instrument	et	partie	vocales
Ajouter	une	portée
Ajouter	une	portée	liée
Sélectionner	l'armure	et	le	tempo
Indication	de	mesure,	levée	(anacrouse),	et	nombre	de	mesures

Ajuster	la	partition	après	sa	création
Modèles
Voir	aussi
Liens	externes

PARAMÈTRES	LINGUISTIQUES	ET	MISE	À	JOUR	DES	TRADUCTIONS
Changer	la	langue
Mettre	à	jour	les	traductions
Voir	aussi

VÉRIFIER	LES	MISES	À	JOUR
Vérification	automatique	de	mises	à	jour
Vérification	manuelle	de	mises	à	jour
Voir	aussi

BASES

SAISIE	DES	NOTES
Saisie	simple	des	notes	et	des	silences
Étape	1	:	Choisir	une	position	de	départ
Étape	2:	Mode	de	saisie	de	notes
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Étape	3:	Durée	de	note	(ou	de	silence)
Étape	4	:	Saisir	la	hauteur	(ou	un	silence)

Périphériques	d'entrée
Souris
Clavier
Clavier	MIDI
Clavier	de	piano	virtuel

Autres	modes	de	saisie
Coloration	des	notes	extrêmes	de	l'étendue	de	l'instrument
Petites	notes
Propriétés	des	notes
Changer	la	hauteur	d'une	note	(sans	changer	la	durée)
Voir	aussi
Liens	externes

AFFICHAGE	-	NAVIGATION
Menu	affichage
Barres	d'outils	/	Panneaux
Zoom
Afficher	la	Barre	d'état
Visualiser	deux	partitions
Options	de	visibilité
Plein	écran

Affichage	par	page/continu
Affichage	par	page
Affichage	continu

Navigateur
Barre	d'outils
Panneaux	latéraux
Rechercher
Voir	aussi

ANNULER	ET	RÉTABLIR

COPIER	/	COLLER
Notes
Copier	ou	couper
Coller
Échange	avec	le	presse	papier

Autres	éléments
Copier	ou	couper
Coller
Échange	avec	le	presse	papier

Répétition	rapide
Duplication
Filtre	de	sélection
Voir	aussi
Liens	externes

ENREGISTRER	/	EXPORTER	/	IMPRIMER
Menu	Fichier
Formats	dans	les	menus	'Enregistrer	sous',	'Enregistrer	une	copie',	'Enregistrer	la	sélection',	'Enregistrer	en	ligne'
Formats	dans	les	menus	'Exporter'	(et	'Exporter	les	parties')
Imprimer

Voir	aussi

MODE	ÉDITION
Notes
Positionnement	des	notes

Voir	aussi

MODES	DE	SÉLECTION
Sélection	d'un	objet	simple
Sélection	d'une	plage
Sélection	d'éléments	non	consécutifs
Sélectionner	tous	les	éléments	similaires
Ces	sélections	sont	utilisées	pour	:
Voir	aussi
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OPÉRATIONS	SUR	LES	MESURES
Ajout
Ajouter	une	mesure	à	la	fin	d'une	pièce
Ajouter	plusieurs	mesures	(à	la	fin	d'une	pièce)

Insertion
Insérer	une	mesure	vide
Insérer	plusieurs	mesures

Supprimer
Supprimer	une	simple	mesure
Supprimer	une	suite	de	mesures
Supprimer	depuis	une	mesure,	jusqu'à	la	fin
Supprimer	depuis	le	début,	jusqu'à	une	mesure

Propriétés
Portées
Durée	de	la	mesure
Autres

Numérotation
Scinder	et	joindre
Voir	aussi

PALETTES	ET	ESPACES	DE	TRAVAIL
Espaces	de	travail
Mode	Palette	seule
Accrochage	/	décrochage	des	panneaux	latéraux
Espace	de	travail	personnalisé

Palettes
Ajouter	des	symboles	à	votre	musique
Palettes	de	base	et	avancées
Palettes	de	l'espace	de	travail	"avancé"
Palettes	personnalisées
Menu	contextuel	des	palettes

Palette	Principale
Textes	et	Lignes	ajoutés	depuis	une	palette	personnalisée
Voir	aussi

TONALITÉ	DE	CONCERT
Voir	aussi

PARTAGER	LES	PARTITIONS	EN	LIGNE
Créer	un	compte
Partager	une	partition	directement	depuis	MuseScore
Télécharger	une	partition	sur	MuseScore.com
Éditer	une	partition	sur	MuseScore.com
Voir	aussi

NOTATION

ALTERNATIVES	DE	REPRISE
Texte
Lecture
Liens	externes

ALTÉRATIONS	ACCIDENTELLES
Recalculer	les	altérations
Voir	aussi
Liens	externes

ARMURES
Remplacer	une	armure	existante
Ajouter	une	nouvelle	armure
Supprimer	une	armure
Rappel	des	armures
Bécarres	dans	les	changements	d'armure
Armures	et	pauses	multimesures
Rappels	d'armure	et	sauts	de	section
Armures	personnalisées
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ARPÈGES	ET	GLISSANDOS
Liens	externes

ARTICULATIONS	ET	ORNEMENTS
Articulations
Ornements
Ajouter	une	articulation	ou	un	ornement
Ajouter	une	altération	accidentelle	à	une	articulation
Ajouter	un	point	d'orgue	à	une	barre	de	mesure
Raccourcis	clavier

Ajuster	la	position
Propriétés	des	articulations
Voir	aussi
Liens	externes

BENDS
Appliquer	un	bend
Ajuster	la	taille
Ajuster	le	positionnement
Bends	personnalisés

BARRES	DE	MESURE
Changer	le	type	de	barre
Créer	un	ensemble	de	portées
Voir	aussi

CLEFS
Ajouter	une	clef
Rappel	des	clefs
Supprimer	une	clef

CRESCENDO

CROCHETS	SYSTÈME
Supprimer
Ajouter
Changer
Éditer
Décalage	horizontal

DIVISIONS	IRRÉGULIÈRES,	N-OLETS
Instructions
Mode	Saisie	de	notes
Propriétés
Style
Voir	aussi
Liens	externes

FIORITURES
Instructions
Liens	externes

INDICATIONS	DE	MESURE
Créer	vos	propres	indications	de	mesure
Changer	les	ligatures	par	défaut
Supprimer	une	indication	de	mesure	personnalisée
Durée	de	la	mesure	différente	de	l'indication	de	mesure:	Anacrouse	et	Cadence
Indications	de	mesure	"locale"
Voir	aussi

LIAISONS	DE	PHRASÉ
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Première	méthode
Deuxième	méthode
Troisième	méthode
Ajustements
Liaisons	en	pointillés
Voir	aussi

LIAISONS	DE	PROLONGATION
Première	méthode
Seconde	méthode
Accords	liés
Inverser	une	liaison

LIGATURES
Ajuster	les	ligatures
Ajuster	l'angle	de	la	ligature
Hauteur	des	ligatures
Ajuster	les	ligature	orphelines
Inverser	le	sens	des	ligatures
Ligatures	horizontales
Restaurer	le	mode	de	connexion	des	ligatures
Voir	aussi
Liens	externes

LIGNE	OCTAVE
Appliquer	une	ligne	d'octave
Changer	la	durée
Lignes	personnalisées
Liens	externes

LIGNES
Appliquer	des	lignes	dans	une	partition
Modifier	la	longueur
Lignes	spéciales	et	propriétés	de	"ligne"
Copie	de	lignes
Lignes	d'ornements
Liens	externes
Voir	aussi

MESURE	DE	SILENCES
Mesure	de	silence
Pauses	multi-mesures
Instructions
Limitations

Diviser	une	pause	multi-mesures

NOTATION	POUR	PERCUSSIONS
Palette	pour	percussions
Méthodes	de	saisie	des	notes
Clavier	MIDI
Clavier	de	piano	virtuel
Clavier	d'ordinateur
Souris

Éditer	le	Set	de	batterie
Roulement
Liens	externes

REPRISES	ET	SAUTS
Lecture
Symboles	et	textes	de	répétition
Sauts
Repères
Exemples
Voir	aussi
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Liens	externes

RESPIRATIONS	ET	PAUSES

TABLATURE
Modifier	les	propriétés	de	la	tablature
Créer	une	nouvelle	portée	tablature
Avec	l'Assistant	de	création
Changer	le	type	de	portée

Éditer	les	paramètres	des	cordes
Combiner	les	portées	standard	et	tablature
Créer	un	système	standard/tablature	avec	l'Assistant	"Créer	une	nouvelle	partition"
Créer	un	système	standard/tablature	à	partir	d'une	portée	existante
Modifier	un	système	standard/tablature	de	lié	à	non	lié	(ou	vice-versa)

Saisie	de	nouvelles	notes
Modification	des	notes	existantes
Résumé	des	touches
Liens	externes

TRANSPOSITION
Transposition	chromatique,	par	"tonalité"
Transposition	chromatique,	par	intervalle
Transposition	diatonique
Instruments	transpositeurs
Voir	aussi{#see-also}

TRÉMOLO

VOIX
Quand	utiliser	des	voix?
Instructions
Cacher	les	silences
Intervertir	les	voix
Changer	une	note	de	voix	(without	swapping)
Voir	aussi
Liens	externes

SON	ET	LECTURE

BANQUES	DE	SONS	(SOUNDFONTS)
Généralités
Installer	une	SoundFont
Désinstaller	une	SoundFont

Synthétiseur
Listes	de	SoundFonts
SoundFonts	spécialisées

Résolution	des	problèmes
Voir	aussi
Liens	externes

CHANGEMENT	D'INSTRUMENT	EN	COURS	DE	PORTÉE
Insérer	un	changement	d'instrument	en	cours	de	portée
Voir	aussi

IMPORTATION	MIDI
Opérations	possibles

MODES	DE	LECTURE
Fenêtre	de	lecture
Décompte
Métronome
Boucle
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122
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123
124
124

MÉLANGEUR
Muet	et	Solo
Contrôleurs
Sons	-	Instruments
Changement	de	son	en	cours	de	portée	(pizz.,	con	sordino,	etc.)
Voir	aussi

SWING
Mettre	en	place	le	swing
Retour	à	un	rythme	binaire{#swing-off}
Paramètres	du	Swing
Paramètres	du	texte	de	Swing
Réglage	global	du	swing

SYNTHÉTISEUR
Généralités
Banque	de	sons	(SoundFont)
Onglet	Fluid
Charger	une	soundfont

Onglet	Zerberus
Volume
Onglet	Effets	Principaux
Onglet	Zita	1

Onglet	Réglage	du	diapason
Changer	la	fréquence	du	diapason
Régler	la	fréquence	par	défaut
Changer	la	Fréquence	du	diapason	pour	une	seule	partition

Voir	aussi

TEMPO
Indication	de	tempo
Ritardando	et	accelerando
Points	d'orgue

Fenêtre	de	lecture

NUANCES
Indications	de	nuances
Ajuster	le	volume	de	lecture	des	nuances

Fenêtre	de	lecture
Liens	externes

TEXTE

VOIR	AUSSI

STYLE	DE	TEXTE
Style	et	propriétés	de	texte
Type	de	texte
Créer	un	nouveau	style	de	texte
Options	d'application
Réinitialiser	le	style	de	texte
Voir	aussi

ÉDITION	DE	TEXTE
Symboles	et	caractères	spéciaux
Voir	aussi

DOIGTÉS
Voir	aussi

PAROLES
Caractères	spéciaux
Ajuster	individuellement	les	lignes	de	parole
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136
136
137
138
139
140
141
142
143
144
145
146
147

Voir	aussi
Liens	externes

REPÈRES
Comment	créer	des	Repères
Création	manuelle
Création	automatique

Remettre	les	repères	dans	l'ordre
Rechercher	un	Repère
Style	de	texte
Voir	aussi
Liens	externes

SYMBOLES	D'ACCORD
Syntaxe	des	symboles	d'accord
Style	de	symboles	d'accord
Apparence
Noms	des	notes
Position

Voir	aussi

TEXTE	DE	PORTÉE	-	TEXTE	DE	SYSTÈME
Texte	de	portée
Texte	de	système
Voir	aussi

TEXTES	DE	BASE
Ajouter	un	texte
Formater	un	texte
Style	de	texte
Propriétés	d'un	texte
Style	de	caractère	d'un	texte

Positionnement	d'un	élément	texte

FORMATAGE

MISE	EN	PAGE	ET	FORMATAGE
Agir	sur	la	mise	en	page
Mise	en	page	→	Paramètres	de	la	page
Mise	en	page	→	Étirer,	Rétrécir
Style	→	Général...	→	Partition
Style	→	Général...	→	Page
Interactions	entre	musique	et	marges	des	pages
Distance	entre	les	portées
Distance	entre	les	systèmes
Marges	des	paroles
Marges	de	cadre	vertical
Seuil	de	remplissage	du	dernier	système

Style	→	Général...	→	En-tête,	Pied	de	page,	Nombres
Style	→	Général...	→	Système
Style	→	Général...	→	Mesure
Style	→	Général...	→	Barres	de	mesure
Palette	→	Sauts	&	espacements
Style	→	Général...	→	Notes
Style	→	Général...	→	Clefs
Style	→	Général...	→	Arpèges
Style	→	Général...	→	Ligatures
Style	→	Général...	→	Liaisons
Style	→	Général...	→	Tailles
Style	→	Général...	→	Lignes
Style	→	Général...	→	Pédales	et	trilles
Style	→	Général...	→	Symboles	d'accord,	diagrammes	d'accord
Style	→	Général...	→	Basse	continue
Style	→	Général...	→	Articulations,	Ornements
Style	→	Général...	→	Altérations
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159

159
159

159
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161
161
163
163
164

164
164

Style	→	Général...	→	Divisions	irrégulières
Boutons	[Appliquer]	et	[Ok]
Appliquer	à	toutes	les	parties	en	une	seule	fois
Enregistrer	et	charger	un	style
Voir	aussi
Liens	externes

STYLE	GÉNÉRAL	:	MESURE
Options

CADRES
Cadre	horizontal
Cadre	vertical
Cadre	de	texte
Créer	un	cadre
Supprimer	un	cadre
Éditer	un	cadre
Appliquer	un	saut	à	un	cadre
Voir	aussi
Liens	externes

CAPTURE	D'IMAGE
Voir	aussi

IMAGE
Voir	aussi

PARAMÈTRES	DE	LA	PAGE
Taille	de	la	page
Marges
Échelle	-	Espace	de	portée
Divers

SAUTS	ET	ESPACEMENTS
Ajouter	un	saut	ou	un	espacement
Éditer	un	espacement
Supprimer	un	saut	ou	un	espacement
Saut	de	section
Propriétés	d'un	saut	de	section

Voir	aussi

ALIGNER	DES	ÉLÉMENTS
Aligner	sur	la	grille

FONCTIONNALITÉS	AVANCÉES

CHANGER	LES	HAUTEURS	DES	NOTES	SANS	CHANGER	LE	RYTHME
Voir	aussi	{#see-also}	:

DIAGRAMMES	D'ACCORD
Créer	un	diagramme	d'accord
Éditer	les	propriétés

EXTRACTION	DES	PARTIES	SÉPARÉES
Définir	les	parties
Définir	toutes	les	parties	en	une	fois

Exporter	les	parties
Enregistrer	une	partie

FORMATS	DE	FICHIER
Formats	natifs	de	MuseScore
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169

169

169

169

169

169

170

170

170

170
170
170
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171
171
171
171
172
172
172

Format	MuseScore	(*.mscz)
Format	MuseScore	non	compressé	(*.mscx)

Fichiers	de	sauvegarde	MuseScore
Fichier	de	sauvegarde	MuseScore	(*.mscz,	ou	*.mscx,)

Visualiser	et	imprimer	(export	seulement)
PDF	(*.pdf)
PNG	(*.png)
SVG	(*.svg)

Écouter	(export	seulement)
WAV	audio	(*.wav)
FLAC	audio	(*.flac)
Ogg	Vorbis	(*.ogg)
MP3	(*.mp3)

Partager	avec	d'autres	logiciels	de	notation	musicale
MusicXML	(*.xml)
MusicXML	compressé	(*.mxl)
MIDI	(*.mid,	*.midi,	*.kar)
MuseData	(*.md)	(import	seulement)
Capella	(*.cap,	*.capx)	(Import	seulement)
Bagpipe	Music	Writer	(*.bww)	(import	seulement)
BB	(*.mgu,	*.sgu)	(import	seulement)
Overture	(*.ove)	(import	seulement)
Guitar	Pro	(*.GTP,	*.GP3,	*.GP4,	*.GP5,	*.GPX)	(Import	seulement)

Voir	aussi

INSPECTEUR	ET	PROPRIÉTÉS	D'OBJET

L'INSPECTEUR

LES	CATÉGORIES	DANS	L'INSPECTEUR
Élément
Groupe	d’éléments
Segment
Accord
Note
Sélection

PROPRIÉTÉS	DANS	LE	MENU	CONTEXTUEL

PROPRIÉTÉS	DES	ARTICULATIONS

PROPRIÉTÉS	DU	DIAGRAMME	D'ACCORD

PROPRIÉTÉS	DES	LIGNES

PROPRIÉTÉS	DE	LA	MESURE

PROPRIÉTÉS	DE	LA	PORTÉE

PROPRIÉTÉS	DU	TEXTE

PROPRIÉTÉS	DE	L'INDICATION	DE	MESURE

VOIR	AUSSI

LES	PLUGINS
Généralités
Installation
Sur	Windows
Sur	macOS
Sur	Linux

Activer	/	désactiver	des	plugins
Créer	/	Éditer	/	Lancer	des	plugins
Plugins	pré-installés	par	défaut
ABC	Import
Break	Every	X	Measures
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178
178
178
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181
182
182
182

182
183
183
184
184
184

184
184
185
185
186
187

187
188
189
189
191
192
192
193
194

Notes	→	Color	Notes
Create	Score
helloQml
Notes	→	Note	Names
Panel
random
random2
run
scorelist
ScoreView
Walk

Voir	aussi

LIGATURES	SUR	DEUX	PORTÉES
Voir	aussi

MODES	DE	SAISIE
Une	à	une	(défaut)
Changer	les	hauteurs
Rythme
Temps	réel	(automatique)
Temps	réel	(manuel)
Voir	aussi
Liens	externes

NOTATION	POUR	MUSIQUE	ANCIENNE
Notation	sans	barre
Mensurstrich
Ambitus
Mensural	time	signatures
Voir	aussi

OUTILS
Ajouter/Supprimer	les	sauts	de	ligne
Éclater
Rassembler
Rassembler	depuis	plusieurs	portées
Rassembler	depuis	une	seule	portée

Remplir	avec	des	slashs
Activer	la	notation	rythmique	avec	des	slashs
Remettre	les	repères	dans	l'ordre
Copier	les	paroles	dans	le	presse-papier
Voir	aussi

PALETTE	PRINCIPALE
Symboles
Trouver	un	symbole
Utiliser	un	symbole
Fusion	de	symboles

Voir	aussi

PROPRIÉTÉS	DE	LA	PARTITION
Balises	méta	préexistantes
Modifier	une	balise	méta
Ajouter	une	nouvelle	balise	méta
En-têtes	et	pieds	de	page
Voir	aussi

PROPRIÉTÉS	DE	LA	PORTÉE
Propriétés	de	la	portée	(ou	de	la	partie)	-	Options
Propriétés	de	la	portée	:	Options	spécifiques	aux	instruments	à	cordes	pincées
Propriétés	avancées	de	style
Portée	Standard	pour	Percussion	-	Options	spécifiques
Tablature	-	Options	spécifiques
Indications	de	frette
Figures	rythmiques
Prévisualisation
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Changer	d'instrument
voir	aussi

PRÉFÉRENCES
Général
Fond
Saisie	des	notes
Partition
E/S
Import
Exporter
Raccourcis	clavier
Mises	à	jour
Voir	aussi

RÉCUPÉRATION	DE	FICHIERS	APRÈS	UN	CRASH
Méthode	pour	sauvegarder	des	partitions	après	une	session	de	récupération
Retrouver	les	partition	récupérées	et	enregistrées	automatiquement
Voir	aussi
Liens	externes

TÊTES	DE	NOTES
Groupes	de	tête	de	note
Changer	de	type	de	tête	de	note
Changer	de	groupe	de	têtes	de	notes
Têtes	de	notes	partagées

NOUVELLES	FONCTIONNALITÉS	DE	MUSESCORE	2

VOIR	AUSSI

SUPPORT

AIDER	ET	AMÉLIORER	LA	TRADUCTION
Traduction	du	logiciel
Traduction	du	site	et	du	manuel	en	ligne
Voir	aussi

INCOMPATIBILITÉS	CONNUES
Incompatibilités	matérielles
Incompatibilités	logicielles
AVG	Internet	Security	bloque	MuseScore
Problème	de	polices	sous	Mac	OS	X
Problème	de	polices	sous	Linux
Fenêtre	de	dialogue	"Enregistrer	sous"	vide	sous	Linux

APPENDICES

ACCESSIBILITÉ
Introduction
Premier	lancement	de	MuseScore
Se	repérer	dans	l'interface	de	MuseScore
La	fenêtre	principale
Lire	la	partition	-	Lecture	de	la	partition	-	Exploration	de	la	partition
Se	déplacer	en	avant	ou	en	arrière	dans	le	temps
Déplacements	entre	les	notes	d'un	accord	-	Moving	between	notes	at	a	given	point	in	time.
Filtrer	l'exploration	de	la	partition

Joueur	de	partition	-	Lecteur	de	partition
Éditer	une	partition
Personnalisation

GLOSSAIRE
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Liens	externes

LIMITATIONS	CONNUES	DE	MUSESCORE	2.1
Indications	de	mesure	locales
Regrouper	les	rythmes
Portée	tablature	liée	à	une	portée	standard
Changement	d'instrument
Mélangeur
En-tête	et	Pied	de	page,	Nombres

RACCOURCIS	CLAVIER
Navigation
Saisie	des	notes
Valeurs	rythmiques
Voix
Hauteurs
Intervalles

Mise	en	page
Articulations
Saisie	des	Textes
Saisie	des	Paroles
Affichage
Divers

OPTIONS	DE	LA	LIGNE	DE	COMMANDE
Qt	Toolkit	Options
Voir	aussi
Liens	externes
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Publié sur MuseScore (https://musescore.org)

Manuel pour MuseScore version 2.0 et supérieure, maintenu par la communauté MuseScore

Comment contribuer à la traduction du manuel, du logiciel ou du site ? C'est par ici.

Pour commencer
Ce chapitre vous aide à installer et lancer MuseScore pour la première fois. Il vous guidera aussi pour
créer une nouvelle partition.

Installation
MuseScore fonctionne sous différents systèmes d'exploitations, et notamment Windows, Mac OS X,
et Linux.

Chromebook

This translation is outdated, see the English version for a reference: Install on Chromebook

MuseScore ne fonctionnera pas nativement sur Chrome OS, mais il existe des solutions.

1. Via Crouton: Involves installing a Linux based operating system which runs in parallel with
Chrome OS, and then installing MuseScore on Linux.

2. Via software-on-demand service such as Rollapp: By just visiting this website, you can run
MuseScore in the browser, but you can only start scores from scratch and only save them to
your online MuseScore account through the menu File → Save Online..., and sound and
playback does not work.

Liens externes

MuseScore sur un Chromebook
Check the installation procedure from the comments in this thread
Comment changer la langue dans MuseScore

Une question sans réponse ? Postez la sur le forum.

Installation sur Windows
MuseScore fonctionne sous différents systèmes d'exploitations, et notamment Windows, Mac OS X,
et Linux.

Windows

Installation

Vous pouvez obtenir l'assistant d'installation pour Windows en allant sur la page de téléchargement du
site de Musescore. Cliquez sur le lien pour commencer le téléchargement. Votre navigateur internet
vous demandera de confirmer que vous voulez télécharger ce fichier. Cliquez sur Enregistrer le
fichier.

Quand le téléchargement est fini, double-cliquez sur le fichier pour commencer l'installation. Windows
vous invitera à confirmer avec une fenêtre de sécurité avant le lancement du programme. Cliquez sur
Exécuter pour continuer, vous verrez brièvement :
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suivi de :

Si vous ne voyez pas l'installateur mais autre chose, il est possible que l'extension ".MSI" ne soit pas
associé à msiexec.exe. Vous pouvez soit :

Corriger l'association de fichier dans w$ ,
Ou Programmes par défaut
Ou votre moteur de recherche préféré : "windows 7" "programmes par défaut" ;
Ou télécharger la version portable de MuseScore.

et de :

16

https://musescore.org/en/node/58196#comment-268961
https://support.microsoft.com/fr-fr/help/18539/windows-7-change-default-programs
https://musescore.org/en/download/musescore-portable.exe


Si vous cliquez sur Cancel, ici ou plus tard, vous verrez :

Si vous cliquez sur Next pour continuer, l'assistant affiche les termes de la licence GPL du programme
:
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Assurez-vous de cocher I accept the terms in the License Agreement  et cliquez sur Next pour
continuer. Confirmez ensuite l'emplacement pour installer Musescore.

La valeur par défaut devrait être correcte. Vous pouvez éventuellement changer le répertoire
d'installation si vous souhaitez conserver une ancienne version sur votre ordinateur. Les versions 2.0
et 1.x peuvent coexister et leur répertoire d'installation par défaut sont déjà différents, il n'est donc pas
nécessaire de changer le répertoire si vous voulez conserver MuseScore 1 et MuseScore 2 sur votre
ordinateur. Une fois le répertoire d'installation modifié, cliquez sur Next pour continuer.
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Cliquez sur Install pour continuer.

Attendez quelques minutes que l'assistant installe les fichiers nécessaires et les configurations. Vous
verrez :

puis :

19



et finalement :

Cliquez sur Finish pour quitter l'assistant. Si vous laissez la case Launch MuseScore cochée,
MuseScore va se lancer automatiquement à la fermeture de l'assistant. Une fois que vous avez cliqué
sur Finish, vous pouvez supprimer le fichier d'installation que vous avez téléchargé.

Démarrer MuseScore

Pour démarrer MuseScore choisissez Démarrer → Tous les programmes → MuseScore 2 → MuseScore
2.

Désinstallation

Vous pouvez désinstaller sur Windows 32-bit avec la commande suivante :

    cd C:\Program Files\MuseScore
    Uninstall.exe /S
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et sur windows 64-bit avec :

    cd C:\Program Files (x86)\MuseScore
    Uninstall.exe /S

Voir aussi

Comment changer la langue dans MuseScore
Comment installer Musescore sur Windows sans droits d'administration
Comment lancer MuseScore en tant qu'administrateur sur Windows

Une question sans réponse ? Postez la sur le forum.

Installation sur macOS

Installation

Vous trouverez le fichier DMG sur la page de téléchargement du site de Musescore. Cliquez sur le lien
pour commencer le téléchargement.

1. Glissez/déposez l'icône MuseScore dans l'icône du dossier Applications. Si vous n'êtes pas
identifié en tant qu'administrateur, Mac OS X vous demandera un mot de passe : cliquez sur
S'authentifier et saisissez votre mot de passe.

21

https://musescore.org/en/node/12678
https://musescore.org/en/node/11193
https://musescore.org/en/node/16316
https://musescore.org/fr/forum
https://musescore.org/fr/node/36


2. Vous pouvez maintenant lancer MuseScore à partir du dossier Applications, Spotlight, ou du
Launchpad.

Désinstallation

Effacez simplement MuseScore du dossier Applications.

Installer avec Apple Remote Desktop

Vous pouvez copier-coller le fichier DMG dans le dossier /Applications de tous les ordinateurs ou
utiliser la fonction ARD, puis installer MuseScore par quelques commandes Unix envoyées par la
fonction ARD :

hdiutil mount <chemin_du_fichier_.dmg>/MuseScore-2.0.3.dmg
cp "/Volumes/MuseScore-2.0.3/MuseScore 2.app" /Applications
hdiutil unmount /Volumes/MuseScore-2.0.3
rm -rf <chemin_du_fichier_.dmg>/MuseScore-2.0.3.dmg

Si vous voulez deployer un PKG, vous pouvez en faire un avec pkgbuild ou voir
https://github.com/scriptingosx/quickpkg.

Liens externes

Comment changer la langue de MuseScore

Une question sans réponse ? Postez la sur le forum.

Installer sur Linux

This translation is outdated, see the English version for a reference: Install on Linux

Linux

Merci de consulter la page de téléchargement pour les instructions relatives à MuseScore sur Linux.
Des paquets sont disponibles pour Debian, Ubuntu, Fedora et PCLinuxOS. D'autres distributions
nécessiteront de compiler l'application à partir du code source. Concernant les instructions spécifiques
pour Fedora, voir ci-dessous.

With MuseScore 2.0.3 you can, for the first time, get hold of a copy for Linux straight from the
Downloads page, just like Windows and Mac users. This is possible thanks to the AppImage
packaging format, which runs on pretty much all Linux distributions. If you prefer, there is still the
option to get it the traditional way via your distribution's package manager (but you may have to wait
for it to get packaged by the relevant maintainer). Of course, you can always build from source.

AppImage

The AppImage format is a new way of packaging Linux applications. AppImages are portable - they
don't have to be installed - and they run on pretty much any Linux distribution. Dependencies are
included in the one AppImage file.

Step 1 - Download

Before you download an AppImage, you need to know your processor's architecture. These terminal
commands will show it:

arch

or

uname -m

The output will be something like "i686", "x86_64" or "armv7":

i686 (or similar) - 32 bit Intel/AMD processor. (Found on older machines.)
x86_64 (or similar) - 64 bit Intel/AMD processor. (Modern laptop and desktop computers, most
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Chromebooks.)
armv7 (or later) - ARM processor. (Phones & tablets, Raspberry Pi 2/3 running Ubuntu Mate,
some Chromebooks. Usually 32 bit at present.)

Now you can head over to the Download page and find the AppImage that best matches your
architecture. Once downloaded, the file will be named "MuseScore-X.Y.Z-$(arch).AppImage".

Step 2 - Give execute permission

Before you can use the AppImage you need to give permission for it to be run as a program.

From the Terminal:

This command gives the user (u) permission to execute (x) the AppImage. It works on all Linux
systems.

cd ~/Downloads
chmod u+x MuseScore*.AppImage

Note: Use the "cd" command to change directory to wherever you saved the AppImage.

From a File Manager:

If you prefer to avoid the command line, there is usually a way give execute permission from inside a
File Manager.

In GNOME Files (Nautilus), simply:

1. Right-click on the AppImage and select "Properties".
2. Open the "Permissions" tab.
3. Enable the option labelled "Allow executing file as a program".

The process may be slightly different in other file managers.

Step 3 - Run it!

Now you should be able to run the program simply by double-clicking on it!

When you downloaded the AppImage it was probably saved in your Downloads folder, but you can
move somewhere else it at any time (e.g. you could put it on your desktop for easy access). If you
ever want to remove it then simply delete it.

Installing the AppImage (optional)

You can run the AppImage without installing it, but you must install it if you want it to be completely
integrated with your desktop environment. This has the following benefits:

Adds the AppImage to your Applications Menu or Launcher
Sets the correct icons for MuseScore's files (MSCZ, MSCX) and for MusicXML files (MXL, XML)
Makes the AppImage available via your File Manager's right-click "Open with..." menu

To install it, run the AppImage from the Terminal with the "install" option (see immediately below).
This copies a desktop file and various icons to your computer. If you want to remove them you will
need to run the "remove" option before you delete the AppImage. This does not affect any scores
created with any version of MuseScore.

Using command line options

Running the AppImage from the Terminal allows you to use various command line options. The
AppImage has some special options in addition to MuseScore's normal command line options.

You will need to change directory (cd) to wherever the AppImage is saved your system, for example:

cd ~/Desktop
./MuseScore*.AppImage *option*

Or give the path to the AppImage:
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~/desktop/MuseScore*.AppImage *option*

Use the "--help" and "man" options to get more information about the available command line options:

./MuseScore*.AppImage --help   # displays a complete list of command line options

./MuseScore*.AppImage man      # displays the manual page (explains what the options do)

Distribution Packages

Fedora

1. Importer la clé GPG :

su
rpm --import http://prereleases.musescore.org/linux/Fedora/RPM-GPG-KEY-Seve

2. Rendez-vous sur la page de téléchargement du site de MuseScore. Cliquez sur le lien de la
version stable pour Fedora et choisissez le paquet rpm correspondant à votre architecture.

3. En fonction de votre architecture, utilisez l'une des deux séries de commandes pour installer
MuseScore :

pour architecture i386

su
: yum localinstall musescore-X.Y-1.fc10.i386.rpm

pour architecture x86_64

su
yum localinstall musescore-X.Y-1.fc10.x86_64.rpm

!! Fedora 22 utilise dnf à la place de yum avec les mêmes syntaxes.!!
Si vous rencontrez des difficultés avec le son, consultez Fedora 11 and sound

Voir aussi

External links

How to run the MuseScore AppImage on Linux - video
How to change the language in MuseScore

Une question sans réponse ? Postez la sur le forum.

Créer une nouvelle partition
Au démarrage de Musescore, Le centre de démarrage va s'ouvrir.

Centre de démarrage

C'est la première fenêtre qui apparait quand vous démarrez MuseScore pour la première fois. Vous le
retrouvez dans le menu Affichage → Centre de démarrage...  ou F4.
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Il est possible de choisir parmi les options suivantes :

Créer une nouvelle partition (en cliquant sur l'icone avec le signe +) ;
Ouvrir une partition précédemment ouverte ;
Ouvrir une partition existante ;
Voir la partition du jour 'sous le feux des projecteurs' (in the spotlight) ;
Rechercher une partition dans musecore.com ;
Liens vers les applications mobiles ;
Lien pour suivre Musescore sur les réseaux sociaux.

Créer une nouvelle partition

Pour créer une partition depuis le menu principal (plutôt que depuis le centre de démarrage) il suffit
d'aller dans le menu Fichier → Nouveau..., ou Ctrl+N (Mac : Cmd+N) et la fenêtre Créer une nouvelle
partition s'ouvre.

Titre, compositeur et autre information

25

http://musescore.com


Entrer le titre, le compositeur et toute information jugée utile comme montré ci-dessus ; cette étape
est optionnelle, vous pourrez entrer un titre à tout moment , voir Cadre vertical).

Clic Suivant > pour accéder à la fenêtre suivante.

Sélectionner un modèle

Ici, il est possible de choisir un modèle à partir duquel la partition sera créée. Le premier modèle vous
permet de choisir exactement le ou les instruments que vous voulez dans votre partition.
Les modèles sont discutés en détail plus bas. Clic Suivant >

Vous pouvez aussi créer vos propres modèles, qui seront proposés dans la section modèles
personnalisés. Voir plus bas.
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Instrument et partie vocales

La fenêtre Instruments est divisée en deux colonnes. À gauche, la liste des instruments et parties
vocales à disposition ; à droite, initialement vide, la colonne contiendra les instruments choisis pour la
nouvelle partition.

À gauche, la liste des familles d'instruments. Cliquez sur une famille pour dérouler la liste complète,
sélectionnez un instrument et cliquez sur Ajouter (ou directement double clic). L'instrument apparaîtra
dans la colonne de droite. Chaque instrument ajouté de cette manière(Ajouter) se voit affecter un
canal individuel dans le Mélangeur.
Vous pouvez ajouter d'autres instruments ou des parties vocales, si besoin.

Le réglage par défaut est "Instruments courants" mais vous pouvez choisir dans d'autres catégories,
incluant "instruments pour le jazz" et "musique ancienne".

Le type de portée habituel est standard (5 lignes), mais certains instruments peuvent utiliser d'autres
sortes de portées (percussions, instruments à cordes pincées).

L'ordre des instruments dans la colonne de droite reflète comment ils apparaîtront dans la partition.
Pour changer cet ordre, cliquer sur un nom d'instrument et utiliser les boutons Haut ou Bas pour les
déplacer. Quand cela est fait, cliquer sur Suivant >.

Ajouter une portée

Vous permet de créer un groupe de mêmes instruments sur un même canal du Mélangeur, en
ajoutant une portée à un instrument existant :

1. Sélectionnez un instrument de la colonne de droite (ex : portée guitare électrique, image ci-
dessous), clic Ajouter une portée ; une portée est ajouté avec son propre réglage.

2. Ajuster le type de portée par le menu déroulant si nécéssaire.
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Vous pouvez utiliser Ajouter une portée pour créer un système de portée/tablature non liées pour la
guitare ou pour d'autres instruments à cordes par exemple (voir Combiner les portées standard et
tablature).

Ajouter une portée liée

Optionnel : Cliquer sur une portée dans la liste des instruments ajoutés et ensuite sur Ajouter une
portée liée.

Note : Pour ajuster la distance entre les portées d'un instrument multiples portées, crées avec les
boutons Ajouter une portée ou Ajouter une portée liée, utilisez les réglages Distance dans
l'accolade.

Sélectionner l'armure et le tempo
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L'assistant vous demande deux choses : l'armure initiale et le tempo de la partition. Sélectionner
chacun d'eux (ou pas) et cliquer sur Suivant > pour continuer.

Indication de mesure, levée (anacrouse), et nombre de mesures

Vous pouvez sélectionner l'indication de mesure ici. Si la partition commence avec une levée, alors
cocher la case "Mesure de levée" et ajuster l'indication de mesure (un paramètre connu pour être celui
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de la durée nominale de la mesure dans 'Propriétés de la mesure').

Le nombre de mesures peut être spécifié ici, mais il est possible de l'amender plus tard.

Cliquer sur Finir pour créer la partition.

Ajuster la partition après sa création

Vous pouvez changer n'importe quel réglage spécifié dans l'assistant de création d'une nouvelle
partition, même après avoir commencé à travailler sur cette nouvelle partition.

Pour ajouter/supprimer des mesures ou créer une levée, voir Opérations sur les mesures

Pour changer n'importe quel texte, voir Édition de textes.
Pour ajouter un titre manquant (ou autre type de texte), utiliser le menu Ajouter → Texte →
Titre (ou autre type de texte)

Pour ajouter/supprimer un instrument ou changer l'ordre des instruments dans la partition,
utiliser la touche I , ou le menu Édition → Instruments....
Vous pouvez également choisir de voir ou de ne pas voir certaines portées (instruments) en
utilisant les cases à cocher sur chaque ligne de la colonne 'Visible' de droite.

Modèles

Le premier écran de l'assistant de nouvelle partition comporte une option pour "Créer une nouvelle
partition à partir d'un modèle" (voir ci-dessus pour plus de détails). Pour créer une partition avec cette
méthode, sélectionner un modèle pour continuer.

L'écran suivant montre la liste des modèles. Sélectionner un modèle et cliquer sur Suivant >.
Continuer et terminer l'assistant comme d'habitude.

Ces fichiers MuseScore sont standards, stockés dans un dossier modèle (un dossier système et un
privé). Vous pouvez créer votre propre modèle en sauvegardant vos partitions dans ces
emplacements.

Sur Windows, le dossier modèle du système est habituellement situé ici : C:\Program Files\MuseScore
2\templates ou pour les versions 64-bits ici : C:\Program Files (x86)\MuseScore 2\templates.

Sur Linux, allez dans /usr/share/mscore-xxx si vous avez installé le programme à partir du
gestionnaire de paquets. Si vous avez vous-même compilé MuseScore sur Linux, alors regardez ici :
/usr/local/share/mscore-xxx (avec xxx étant la version que vous utilisez).

Sur Mac, allez dans /Applications/MuseScore 2.app/Contents/Resources/templates.

Vous pouvez configurer l'emplacement privé pour vos modèles personnels avec Édition →
Préférences... → Général, MuseScore montrera les modèles du système et de l'emplacement privé.

Voir aussi

Armures
Indications de mesure
Clefs
Tempo
Propriétés de la portée

Liens externes

Video tutorial: MuseScore in Minutes: Lesson 1 - Score Setup

Une question sans réponse ? Postez la sur le forum.

Paramètres linguistiques et mise à jour des traductions
MuseScore sera installé dans la langue de votre système d'exploitation (la langue utilisée par la
plupart des programmes, en général, elle dépend de votre pays et des paramètres de langue de votre
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PC ou de votre compte).

Changer la langue

1. Aller dans Édition → Préférences... (Mac: MuseScore → Préférences...)

2. Dans l'onglet Général, il y a une section Langue:

Vous pouvez changer la langue et aussi mettre à jour la traduction en cliquant sur le bouton Mettre à
jour les traductions, une nouvelle fenêtre s'affiche, avec la langue sélectionnée en début de liste -
voir Mettre à jour les traductions.

Comme indiqué, vous devrez redémarrer MuseScore pour que le changement de langue soit pris en
compte.

Mettre à jour les traductions

Vous pouvez mettre à jour les traductions via le menu Édition > Préférences comme expliqué ci-
dessus, mais il y a une autre méthode :

1. Aller dans Aide → Gestionnaire de ressources

2. Appuyer sur le bouton "mettre à jour" pour votre langue.
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Ici encore, vous devez redémarrer MuseScore pour que la mise à jour soit effective.

Voir aussi

Aider et améliorer la traduction

Une question sans réponse ? Postez la sur le forum.

Vérifier les mises à jour
Il y a deux façons de vérifier si une mise à jour est disponible :

Vérification automatique de mises à jour

1. Allez dans le menu Édition → Préferences (Mac: MuseScore → Préferences)
2. Sélectionnez l'onglet Mises à jour

3. Cochez la case
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Maintenant, MuseScore vérifiera la disponibilité de nouvelles mises à jour à chaque lancement, et
vous le notifiera si besoin.

Vérification manuelle de mises à jour

1. Allez dans le menu Aide → Rechercher les mises à jour

2. Une fenêtre de dialogue apparaîtra avec le statut de la mise à jour : "Vous utilisez la version la
plus récente" ou "Une mise à jour pour MuseScore est disponible :" suivie d'un lien pour la
télécharger.

Voir aussi

Préférences : Mises à jour

Une question sans réponse ? Postez la sur le forum.

Bases
33
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Le chapitre précédent "Bien commencer" vous guide pour l'installation et pour créer créer une
nouvelle partition. Le chapitre "Bases" donne un aperçu de MuseScore et décrit les méthodes
générales pour interagir avec la partition.

Saisie des notes

Saisie simple des notes et des silences

Pendant la saisie des notes et quelque soit le périphérique utilisé, le curseur avance automatiquement
dans la partition.

Ajouter des notes ou des silences en 4 étapes:

1. Sélectionnez le point de départ pour la saisie
2. Sélectionnez le menu Notes → Saisie de notes
3. Sélectionnez la durée de la note ou du silence que vous souhaitez entrer
4. Entrez la hauteur de la note (ou un silence directement) en utilisant son raccourci clavier, la

souris, ou un clavier MIDI.

Pour ajouter des notes qui commencent ou finissent à des moments différents (polyphonie), voir
Voix. Pour les accords (plusieurs notes de la même durée qui commencent au même moment),
continuez votre lecture.

Étape 1 : Choisir une position de départ

Sélectionnez une note ou un silence, point de départ de la saisie. La saisie de notes dans MuseScore
remplace les notes et silences existants dans une mesure par vos nouvelles notes (écriture par
dessus, pas d'insertion donc). Toutefois, vous pouvez insérer de nouvelles mesures n'importe où dans
la partition (voir Opérations sur les mesures : Insertion), ou utiliser copier/coller pour déplacer un
passage.

Étape 2: Mode de saisie de notes

Le bouton "N" dans la barre d'outils Saisie de notes indique si vous êtes en mode saisie de notes ou
pas.
Pour entrer dans le mode saisie de notes, vous pouvez cliquer sur le bouton ou vous pouvez utiliser le
raccourci N. Pour quitter le mode de saisie de notes, appuyez à nouveau sur N ou Échap.

Note : La petite flèche à droite du bouton "N", déroule un menu permettant d'accéder aux autre modes
de saisie.

Étape 3: Durée de note (ou de silence)

Après être entré en mode Saisie de notes, sélectionnez la durée depuis la barre d'outils Saisie de
notes, ou utilisez le raccourci correspondant.
Pour une division irrégulière du temps (comme 3 croches dans le temps de deux, un triolet), voir
Divisions irrégulières

Étape 4 : Saisir la hauteur (ou un silence)

Pour tous les instruments (à l'exception des percussions), vous pouvez ajouter les hauteurs de notes
avec la souris en cliquant directement sur la portée. (Pour les percussions voir Notation pour
percussion).
Cependant, il est beaucoup plus rapide d'utiliser un clavier MIDI (voir plus bas) ou même le clavier de
votre ordinateur. L'exemple qui suit utilise cette méthode.

Périphériques d'entrée

Souris

Il est aisé de saisir les notes avec la souris, cependant dès qu'il s'agit d'en saisir un grand nombre, le
clavier est plus rapide.

Saisissez juste la durée dans la barre d'outils Saisie de notes et cliquez sur la portée à l'endroit
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précis où vous voulez l'ajouter ; le déplacement du pointeur de la souris sur la portée offre la
prévisualisation de la position d'insertion finale.

Clavier

Choisissez une durée avec 1→9, puis une hauteur avec A→G ou zéro pour un silence.

Les raccourcis par défaut pour les durées de notes sont les suivants :

1: Quadruple croche
2: Triple croche
3: Double croche
4: Croche
5: Noire
6: Blanche
7: Ronde
8: Brève ou carrée
9: Longa
.: Un point de prolongation juste après la durée change cette durée en note/silence pointée

Entrez les hauteurs en tapant sur les lettres correspondantes aux noms des notes en notation
anglaise :

C=Do D=Ré E=Mi F=Fa G=Sol A=La B=Si

Créer un silence 0 (zéro) : par exemple, taper C D 0 E donne le résultat ci-dessous.

Notez que la durée saisie (ci-dessous la noire) est mémorisée pour toutes les notes/silences, jusqu'à
ce qu'une autre durée soit saisie.

Si vous voulez ajouter une note dans l'accord précédent, appuyez sur Maj en même temps.
C D Maj+F Maj+A E F

Pour créer des accords avec des notes de différentes durées. Voir Voix.

Pour créer une note pointée, appuyez sur .. Par exemple 5 . C 4 D E F G A

Emplacement par défaut des notes saisies :
Quand vous entrez une note depuis votre clavier, MuseScore choisie par défaut la hauteur la plus
proche de la note précédente.
Pour les accords, les notes sont toujours ajoutées au-dessus, mais vous pouvez corriger de +/- une
octave(s) avec les raccourcis suivants :

Ctrl+↑ (Mac: ⌘+↑) : Augmente la hauteur de la note d'une octave.
Ctrl+↓ (Mac: ⌘+↓) : Diminue la hauteur de la note d'une octave.

Autres raccourcis utiles en mode de Saisie de notes :
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↑ (Haut) : Augmente la hauteur de la note d'un demi-ton (utilise des ♯).
↓ (Bas) : Diminue la hauteur de la note d'un demi-ton (utilise des ♭).
Alt+Maj+↑ : Augmente la hauteur de la note en utilisant l'armure.
Alt+Maj+↓ : Diminue la hauteur de la note en utilisant l'armure.
J : Change la note pour son équivalent enharmonique, vers le haut.
Maj+J: Change la note pour son équivalent enharmonique, vers le bas (e.g., F to E#).
R : Duplique la note ou l'accord précédent.
Q : Divise en deux la durée de la note précédente.
W : Double la durée de la note précédente.
Maj+Q (depuis la version 2.1) : Diminue la durée de la valeur d'un point (par exemple, une
blanche pointée devient une blanche ou encore une noire devient une croche pointée, etc).
Maj+W (depuis la version 2.1) : Augmente la durée de la valeur d'un point (par exemple, une noire
devient une noire pointée ou encore une blanche pointée devient une ronde, etc).
Backspace : Annule la dernière saisie.
Maj+← : Intervertit les deux dernières notes saisies.
Maj+→ : Annule l'action de Maj+← en échangeant à nouveau les deux dernières notes saisies.
X : Inverse la direction de la hampe de la note.
Maj+X : Tête de note en miroir, déplace la tête de note de l'autre coté de la hampe.

Clavier MIDI

Vous pouvez aussi insérer des notes avec un clavier MIDI.

1. Connectez votre clavier MIDI à votre ordinateur et allumez votre clavier
2. Démarrez MuseScore (Ceci doit être effectué après la mise en route du clavier)
3. Créez une nouvelle partition
4. Cliquez sur une silence pour indiquer ou vous voulez commencer
5. Appuyez sur N pour entrer dans le mode Saisie de notes
6. Selectionnez une durée de note, par exemple 5 pour la noire, comme décrit ci-dessus
7. Appuyez sur une touche de votre clavier MIDI

La note devrait être ajoutée à la partition.

Note : Le clavier MIDI permet la saisie d'une note ou d'un accord à la fois. Ce mode de saisie est
rapide et efficace.

Certains programmes permettent la "saisie en temps réel", où le musicien joue et le logiciel essaie de
produire la notation musicale. Malheureusement, le résultat est souvent décevant. Aussi, MuseScore
n'utilise pas cette saisie et se concentre sur des modes de saisie plus efficaces.

Si vous avez plusieurs équipements MIDI connectés à votre ordinateur, vous pouvez dire à
MuseScore lequel il doit "écouter".

Aller à Édition → Préférences... (Mac: MuseScore → Préférences...). Dans la boite de dialogue,
choisissez l'onglet E/S et sélectionnez votre équipement dans la section "PortAudio", "Entrée MIDI".

Clavier de piano virtuel

Vous pouvez également entrer les notes en utilisant les touches du clavier du piano virtuel : P (ou
menu Affichage → Clavier de piano).

La méthode de saisie est similaire à celle du clavier Midi. Les notes sont entrées en cliquant sur les
touches appropriées. Pour entrer un accord, clic sur une note de l'accord, puis pressez et maintenez
Maj en cliquant sur les notes suivantes (pour les versions antérieures à 2.1, utilisez Ctrl (Mac: Cmd)).

Autres modes de saisie

Depuis MuseScore 2.1, en plus de Une à une et Changer les hauteurs, plusieurs nouveaux modes
de saisie de notes sont proposés ; ils sont maintenant tous regroupés dans un menu déroulant,
accessibles en cliquant sur la petite flèche, dans la barre d'outils principale (tout à gauche)
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Une à une (défaut) - Entrer les notes avec la souris ou le clavier (Mode de saisie simple).
Changer les hauteurs - Remplacer les hauteurs en conservant les rythmes.
Rythme - Entrer les durées par simple clic ou par une touche.
Temps réel (automatique) - Jouer la pièce au tempo indiqué par le métronome.
Temps réel (manuel) - Jouer la pièce au tempo commandé par pressions sur une touche ou une
pédale.

Coloration des notes extrêmes de l'étendue de l'instrument

Les notes dans le registre d'un instrument apparaissent en noir à l'écran. Celles en dehors de ce
registre apparaissent en rouge. Pour certains instruments, le registre dépend du niveau du musicien.
Pour ces instruments, les notes en dehors du registre d'un amateur apparaissent en jaune foncé, et
les notes en dehors du registre d'un professionnel sont en rouge.

Ces couleurs sont affichées à l'écran uniquement à titre informatif, elles n'apparaitront pas à
l'impression. Pour désactiver la coloration à l'écran, aller dans Édition → Préférences... (Mac:
MuseScore → Préférences...), puis l'onglet Saisie de notes, et décocher "Mettre en couleur les notes
extrêmes de l'étendue de l'instrument".

Petites notes

1. Sélectionnez les notes que vous souhaitez rendre plus petites
2. Dans l'inspecteur vous pouvez changer la taille des notes ou des accords en cochant les cases

"Petite" (dans la partie, "Accord" ou "Note" de l'inspecteur)
Vous pouvez changer la proportion des notes dans Style → Général → Tailles

Note : Dans l'inspecteur, "petite" de la section 'Note' ne change que la taille de la tête de note ; pour
les accords, la hampe, les ligatures, sont aussi réduits.

Propriétés des notes

Voir Mise en page et formatage, en particulier les sections sur les notes, altérations et les
divisions irrégulières
Voir aussi Inspecteur et propriétés d'objets pour les propriétés d'une note ou d'une sélection

Changer la hauteur d'une note (sans changer la durée)

S'il n'y a qu'une seule note, vous pouvez la sélectionner et changer la hauteur avec la souris ou les
flèches du clavier.
S'il y a plus d'une note à changer et pas de changement de rythme, vous pouvez transposer (si
l'intervalle est exactement le même pour toutes) ou utiliser le mode Remplacer les notes sans changer
les rythmes.

Si les altérations ne sont pas correctes, essayez le menu Notes > Recalculer les altérations.

Voir aussi
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Notation pour percussion
Préférences
Divisions irrégulières
Voix

Liens externes

Comment entrer un accord, vidéo en anglais
Comment entrer un silence, en anglais
Comment créer une hampe sur deux portées, en anglais
Vidéo tutoriel : MuseScore in Minutes : Leçon 3 - Saisie des notes
Vidéo tutoriel : MuseScore in Minutes : Leçon 4 - Clavier MIDI
Vidéo tutoriel : MuseScore in Minutes : Leçon 5 - Autres idées pour la saisie de notes

Une question sans réponse ? Postez la sur le forum.

Affichage - Navigation

This translation is outdated, see the English version for a reference: Viewing and navigation

Menu affichage

Vous pouvez visualiser votre partition selon différents modes.

A l'exception de Affichage par page / Affichage continu, toutes les options ci-dessous sont
disponibles dans le menu Affichage de MuseScore ou Alt+A.

Barres d'outils / Panneaux

Centre de démarrage : F4
Palettes : F9
Palette principale : Maj+F9.
Inspecteur : F8
Fenêtre de lecture : F11
Navigateurr : F12
Mélangeur : F10
Synthétiseur :
Filtre de sélection : F6
Clavier de piano : P

Zoom

Quel que soit le mode d'affichage (continu ou par page), vous pouvez changer le niveau de zoom
(n'affecte pas la taille d'impression) :

Dans le menu déroulant vous pouvez choisir avec le % de zoom, "largeur de page", "page entière",
"deux pages" pour visualiser la partition.

Vous trouverez les options Zoom Avant et Zoom Arrière et leurs raccourcis clavier dans le menu
Affichage, et vous pourrez aussi zoomer ou dézoomer avec la molette de la souris en pressant la
touche Ctrl (Mac : Cmd).
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Zoom (+) : Ctrl++ (Mac : Cmd ++)
Zoom (‒) : Ctrl +- (Mac : Cmd +-)
Zoom 100 % : Ctrl +0 (Mac : Cmd +0)

Afficher la Barre d'état

La Barre d'état (ou zone de notification) en bas de l'écran, donne des informations sur la sélection
active. Cochez/décochez cette option pour la cacher ou la voir.

Visualiser deux partitions

Vous pouvez visualiser deux partitions côte à côte :

ou empilées :
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Vous pouvez faire glisser la barre séparant les deux partitions pour ajuster l'espace de chaque
fenêtre.

Options de visibilité

Cette section vous permet de cacher/voir divers éléments non imprimables.

Afficher les éléments invisibles : cacher/voir les éléments rendus invisibles à l'impression.
Afficher les caractères non imprimables : cacher/voir les Sauts et espacements.
Afficher les cadres : cacher/voir les pointillés des Cadres.
Afficher les marges : cacher/voir les Marges des pages.

Plein écran

Le mode plein écran étend MuseScore sur tout votre écran pour obtenir un contenu plus visible

Affichage → Plein écran (Ctrl+U) :
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Affichage par page/continu

Affichage par page, vous voyez votre partition telle qu'elle apparaîtra lorsqu'elle sera imprimée
ou exportée dans un fichier PDF ou comme fichier image.
Affichage continu, la partition est affichée sans aucun retour à ligne des systèmes, comme un
ruban.

Note, lors du passage de l'affichage continu à l'affichage par page, la partition est reformatée pour le
nouvel affichage et des ajustements manuels peuvent être nécessaires.

Vous pouvez passer d'un mode d'affichage à l'autre ici :

Affichage par page

Dans l'affichage par page, la partition est affichée sur une ou plusieurs pages de taille spécifique avec
des marges, et vous pouvez voir tous les sauts de lignes et de pages, incluant ceux ajoutés
manuellement et ceux automatiquement calculés par le programme.

Les sauts de systèmes ou de pages ajoutés manuellement sont très utiles pour :

Obtenir des tournes de pages judicieuses dans les parties orchestrales par exemple ;
Dilater les mesures pour faciliter la lecture ou l'écriture pour les débutants (mais pas qu'eux).

Affichage continu

Dans l'affichage continu, la partition est visualisée sans sauts de système. Si le début de la partition
n'est pas visible, alors des indications de numéros de mesure, noms d'instruments, clefs, indications
de mesures et armures sont affichés.
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Avant d'imprimer une partition, revenez en mode affichage par page pour vérifier la mise en page.

Note : Étant donné la mise en page plus simple, MuseScore pourrait fonctionner plus rapidement en
mode d'affichage continu.

Navigateur

Si vous souhaitez vous situer dans une longue partition, ou vous déplacer sur une page en particulier,
utilisez le navigateur en bas de l'écran par défaut, ou sur le coté droit le la fenêtre principale si vous
choisissez de faire défiler les pages verticalement (voir Préférences : Faire défiler les pages).

Pour activer / désactiver le navigateur, allez dans le menu Affichage et sélectionnez Navigateur, ou
utilisez le raccourci F12 (Mac : fn+F12).

Le rectangle bleu représente la zone de la partition visible dans la fenêtre principale. Vous pouvez
faire glisser soit le rectangle bleu soit la barre de défilement, ou cliquer sur une zone pour l'afficher
immédiatement :

Barre d'outils

La zone des barres d'outils (icônes), située entre la barre de menu principal et la fenêtre
principale, contient au choix :

Opération sur les fichiers : Nouvelle partition, Ouvrir une partition, Enregistrer, annuler,
rétablir, zoom, mode
d'affichage.
Outils du lecteur : Activer MIDI, Play/Stop, activer la lecture en boucle, jouer les reprises,
entendre le métronome.
Concert Pitch: Displays score in written or concert (sounding) pitch.
Capture d'image
Saisie de notes : Note entry mode, Duration, Tie, Rest, Accidentals, Flip stem direction, Voice
(1, 2, 3, 4).

Pour choisir quels outils afficher, cliquez droit sur un espace vide de la barre d'outils, et dans le menu
proposé, cochez ou décochez selon vos besoin.

Ce menu permet aussi de cacher/voir le Clavier de Piano, le filtre de Sélection , l'Outil texte, les
Palettes, et l'Inspecteur.

Panneaux latéraux

Les espaces de travail (palettes), Inspecteur, et filtre de sélection, sont proposés sous forme de
panneaux latéraux accrochés à la fenêtre principale. Pour les libérer et en faire des panneaux volants,
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plusieurs méthodes :

Saisissez-le avec la souris ;
Clic sur le double chevron ;
Double clic dans la zone du titre.

Pour revenir à la position accroché, plusieurs méthodes également :

Cliquez-glissez le panneau sur le haut d'un panneau latéral existant et il fusionnera avec ce
dernier.
Cliquez-glissez le panneau sur le milieu d'un panneau latéral existant et il s'accrochera par
dessus. Les deux panneaux seront accessibles via les onglets en bas du panneau.
Double clic dans la zone du titre, le raccrochera à sa dernière position.

Rechercher

La fonction Rechercher (aller à) permet de se déplacer rapidement vers un numéro de mesure, un
repère ou un numéro de page, de la partition.

Le menu Édition → Rechercher ou le raccourci Ctrl+F (Mac : Cmd+F), ouvre une barre d'outil avec un
champ de saisie "Aller à :" en bas de la fenêtre principale, où vous pouvez entrer au choix :

Un numéro de mesure, (counting every measure starting with 1, irrespective of pickup
measures, section breaks or manual changes to measure number offsets).

Un nom de repère, le premier caractère doit être une lettre, le(s) suivant(s) peut être un ou des
chiffres ; la recherche est insensible à la casse.

To go to a numerical rehearsal mark (esp. one that does not match the measure number), enter
the number using the format rXX (where XX is the rehearsal mark. To find a rehearsal mark that
starts with "R" use rrXX. To find a rehearsal mark that starts with "P" and continues with a
number, use rpXX). This works starting with version 2.1.

Un numéro de page au format pXX ou XX est le numéro de page.

Note, un repère commençant par " p " ou " P " ne pourra pas être trouvé dans les version antérieure
à la 2.1.

Voir aussi

Faire défiler les pages horizontalement / Verticalement
Enregistrer/exporter/imprimer
Formats de fichier
Mise en page et formatage
Raccourcis clavier - navigation

Une question sans réponse ? Postez la sur le forum.

Annuler et rétablir
MuseScore mémorise un nombre illimité d'actions annuler/rétablir.

Les raccourcis standards sont :

Annuler Ctrl+Z (Mac: ⌘+Z)
Rétablir Ctrl+Maj+Z ou Ctrl+Y (Mac: ⌘+Maj+Z)

Ou utilisez les boutons de la barre d'outils :

Une question sans réponse ? Postez la sur le forum.

Copier / coller
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Copier/coller est un outil utile pour répéter une section de musique, ou pour déplacer un passage d'un
temps ou d'une mesure.

MuseScore supporte les commandes standards Copier, Couper, Coller et depuis la version 2.1,
Échange avec le presse papier ; elles peuvent agir sur des groupes de :

Notes de musique : pour répéter ou décaler une plage musicale.
Éléments divers : tels les articulations, les textes de portée et de système, dynamics, doigtés,
etc.

Note : Les Lignes ne peuvent pas être copiées, mais peuvent être dupliquées (voir →en-dessous).

Échap avant de débuter une procédure de copie, pour vous assurer de ne pas être en Mode de saisie
de notes ni en mode Édition.

Notes

Copier ou couper

Copier/couper un accord

1. Maj+Clic sur une note de l'accord, l'accord entier est sélectionné.
2. Choisissez dans le menu Édition → , ou dans le menu contextuel (clic droit) :

Copier ou Ctrl+C (Mac : ⌘+C).
Couper ou Ctrl+X (Mac : ⌘+X).

Copier/couper une région de notes/accords

1. Clic sur la première note de votre sélection.
2. Maj+Clic sur la dernière note de votre sélection. Un rectangle bleu met en évidence la sélection.
3. Choisissez dans le menu Édition → , ou dans le menu contextuel (clic droit) :

Copier ou Ctrl+C (Mac : ⌘+C).
Coller ou Ctrl+X (Mac : ⌘+X).

Coller

1. Clic sur la note ou la mesure à partir de laquelle vous souhaitez coller la sélection
2. Menu Édition → Coller, clic droit Coller ou Ctrl+V (Mac : ⌘+V)

Échange avec le presse papier

Avec la version 2.1 arrive aussi la commande Échange avec le presse papier, c'est une
combinaison de Couper et de Coller.

If you select a destination area different than the size of the clipboard, MuseScore will automatically
adjust the selection area to the size of the items on the clipboard starting with the item on the left.
After this command is executed the information on the clipboard will be pasted to the starting of the
selection area and the destination will be copied to the clipboard.

1. Clic sur la note/mesure où le remplacement par le contenu du presse papier doit commencer.
2. Menu Édition → Échange avec le presse papier , clic droit ou Ctrl+Maj+X (Mac : ⌘+Maj+X)

Note : Il est possible de copier/coller ou d'échanger seulement la hauteur d'une note (et aucune des
autres propriétés), en cliquant sur la tête de note et en appliquant la procédure copier/coller ou
copier/échange(r) avec le presse papier. La hauteur de la note copiée écrasera la hauteur de la note
de destination, sans en changer la hauteur.

Autres éléments

Les autres éléments, comme les textes de portée ou de système, les diagrammes d'accord, les
doigtées, etc ; peuvent être coupés, copiés, collés un à un . Les articulations (sforzato, staccatto, etc),
peuvent être procédés par sélection multiple.

Copier ou couper
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Même procédure que pour "Copier ou couper" des notes voir plus haut

Coller

Même procédure que pour "Coller" des notes voir plus haut

À propos des articulations, elles sont collées sur la note de destination dans exactement le même
ordre (continu ou intermittent) dans lequel elles étaient dans la sélection initiale.

Échange avec le presse papier

La commande Échange avec le presse papier n'est pas adaptée aux éléments individuels (autre que
plage de notes) ; employée dans ce cas là, elle pourrait donner des résultats inattendus.

Répétition rapide

1. Sélectionner une note ou une mesure.
2. Appuyer sur R et MuseScore duplique l'objet sélectionné immédiatement après la sélection

initiale (écrasement).

Duplication

Pour dupliquer un texte, une ligne ou un autre objet :

1. Ctrl+Maj (Mac: ⌘+Maj), clic maintenu sur l'élément et glissez-le n'importe où dans la partition.
2. Relâchez le bouton de la souris et l'élément sélectionné est cloné à l'endroit désiré.

Filtre de sélection

Il est possible de filtrer une sélection, en choisissant exactement ce qui sera copié/collé.

1. Activer le filtre de sélection avec F6 (Mac: fn+F6) ou Affichage → Filtre de sélection

L'onglet filtre de sélection apparaît par défaut en dessous des palettes. Il peut être déplacé dans une
fenêtre flottante, et s'il est glissé directement dans les palettes ou dans l'inspecteur, alors les deux
sont disponibles via un onglet en bas.

1. Désélectionner ce que vous ne voulez pas copier
Exemple : Articulations et liaisons ne sont pas sélectionnées.
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2. Copier/coller comme précédemment
(dans l'exemple, copier les mesures 4 et 5 et les coller dans les mesures 12 et 13)

3. Regarder le résultat - les liaisons n'ont pas été copiées :

Voir aussi

Si vous souhaitez changer les notes sans altérer le rythme, vous pouvez combiner transposition ou
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mode re-calcul des altérations avec l'outil copier/coller.

Liens externes

Tutoriel vidéo: Paroles, copie et nuances

Une question sans réponse ? Postez la sur le forum.

Enregistrer / Exporter / Imprimer
Enregistrer et exporter sont répartis en deux menus : 'Enregistrer' et 'Enregistrer sous' (de même que
'Enregistrer une copie' et 'Enregistrer la sélection') pour les fichiers natifs de MuseScore (.mscz et
.mscx) et 'Exporter' (et 'Exporter les parties') pour les formats non natifs (MusicXML, MIDI, formats
visuels et audio divers). 'Imprimer' sert à imprimer votre fichier MuseScore directement sur une
imprimante depuis MuseScore.

Menu Fichier

Sont disponibles : 'Enregistrer', 'Enregistrer sous', 'Enregistrer une copie', 'Enregistrer la sélection',
'Enregistrer en ligne', 'Exporter', 'Exporter les parties' et 'Imprimer'

Formats dans les menus 'Enregistrer sous', 'Enregistrer une copie', 'Enregistrer la sélection', 'Enregistrer en ligne'
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Formats dans les menus 'Exporter' (et 'Exporter les parties')

Note: Le format non compressé de MuseScore est disponible à la fois dans 'Enregistrer' and
'Exporter'.

Imprimer

En fonction du modèle de votre imprimante vous disposez de différentes fonctions. Généralement
sont disponibles les options suivantes : la plage d'impression - Tout, Sélection, Page courante, ou
Pages - nombres de copies et copies assemblées
Si vous disposez d'une imprimante PDF, vous pouvez également exporter en PDF en l'utilisant.

Voir aussi

Formats de fichier
Extraction des parties

Une question sans réponse ? Postez la sur le forum.

Mode Édition
De nombreux éléments de la partition peuvent être édités dans le Mode Édition :

Double-clic : Entrer dans le Mode Édition ou Ctrl+E
Esc : Sortir du Mode Édition

En Mode Édition, certains éléments comportent des poignées qui peuvent être déplacées en les
faisant glisser avec la souris ou avec les raccourcis clavier.

Liaison dans le Mode Édition:

Raccourcis clavier disponibles :

← : Déplace la poignée vers la gauche de 0.1 espace (de portée)
espace de portée = distance entre deux lignes de portée (Mise en page → Paramètres de la
page).
→ : Déplace la poignée vers la droite de 0.1 espace
↑ : Déplace la poignée vers le haut de 0.1 espace
↓ : Déplace la poignée vers le bas de 0.1 espace
Ctrl+← (Mac: ⌘+←) : Déplace la poignée vers la gauche de 1 espace
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Ctrl+→ (Mac: ⌘+→) : Déplace la poignée vers la droite de 1 espace
Ctrl+↑ (Mac : ⌘+↑): Déplace la poignée vers le haut de 1 espace
Ctrl+↓ (Mac : ⌘+↓): Déplace la poignée vers le bas de 1 espace
Alt+← : Déplace la poignée vers la gauche de 0.01 unité
Alt+→ : Déplace la poignée vers la droite de 0.01 unité
Alt+↑ : Déplace la poignée vers le haut de 0.01 unité
Alt+↓ : Déplace la poignée vers le bas de 0.01 unité
Maj+← : Déplace le point d'ancrage de la poignée vers la gauche
Maj+→ : Déplace le point d'ancrage de la poignée vers la droite
Tab : Sélectionne la prochaine poignée

Si vous avez besoin de déplacer des éléments de la partition manuellement, double-cliquez dessus et
utilisez les flèches directionnelles.

When an endpoint handle is selected, an anchor a dotted line showing what part of the score the
line is connected to may appear. To move an anchor, use Shift+→ or Shift+←.

Notes

Positionnement des notes

Pour déplacer une note à droite ou à gauche (ex : pour éviter une collision ou pour compenser les
têtes de notes partagées), sélectionnez la tête de note et changez dans l'inspecteur, la valeur du
décalage horizontal.

Vous pouvez faire la même chose en mode édition de note comme suit :

1. Entrez en mode édition de note en double-cliquant une tête de note ou en cliquant droit une
tête de note et choisissant "Éditer l'élément" ou encore Ctrl + E sur une tête de note
sélectionnée.

2. Utilisez les touches fléchées (+ Ctrl pour x10 l'effet de chaque pression).

3. Pressez Échap, et MuseScore repositionne le reste de la note (tige, crochet, lignes
supplémentaires).

Note : Dans le mode Édition pour une tige de note, ne permet d'en modifier que la longueur. pour le
décalage horizontal ou/et vertical, utilisez l' inspecteur.

Voir aussi

Édition de texte
Liaison
Crochet et accolade
Lignes
Ligatures
Crescendo

Une question sans réponse ? Postez la sur le forum.

Modes de sélection
Différents modes de sélection sont disponibles (pour sélectionner des objets).

Sélection d'un objet simple

Simplement cliquer dessus.

Sélection d'une plage

1. Sélectionner le premier élément (cliquer dessus)
2. Maintenir appuyée la touche Maj
3. Sélectionner le dernier élément (cliquer dessus)

Tous les éléments sélectionnés dans la plage apparaîtront dans un rectangle bleu.
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Note 1 : Certains éléments peuvent être sélectionnés par plage : notes, silences, articulations...
Note 2 : Voir Copier/coller : Filtre de sélection pour sélectionner seulement certains objets dans votre
plage.

Sélection d'éléments non consécutifs

1. Sélectionner le premier élément (cliquer dessus)
2. Maintenir appuyée la touche Ctrl
3. Sélectionner les autres éléments (cliquer dessus)

La note 1 ci-dessus est toujours valable.

Sélectionner tous les éléments similaires

1. Sélectionner un élément
2. Clic droit → Sélectionner >

3. Plusieurs options sont disponibles :

Tous les éléments similaires : dans la partition entière
Tous les éléments similaires dans la même portée : seulement dans la même portée
Tous les éléments similaires dans une plage de sélection : seulement si une → plage de
sélection est active, sélectionne les éléments similaires seulement dans la plage de
sélection.
Plus...

Exemple : Un bémol (accidentel) sélectionné

Vous pouvez cocher (et combiner) les sélections suivantes :

Même sous-type : dans cet exemple seuls les bémols seront sélectionnés (et pas les
dièses ni les bécarres); certains éléments ont un sous-type (par exemple articulations,
altérations accidentelles...)
Même portée : seulement les éléments d'une même portée
Même voix : seulement les éléments d'une même voix
Même système : seulement les éléments du même système
Même sélection : si une sélection est active, seulement les éléments de cette sélection

Différentes actions peuvent être effectuées (seulement un choix): Ajouter, Enlever, Remplacer et
chercher.

Ces sélections sont utilisées pour :

Copier/coller
Mode Edition pour déplacer des objets similaires
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Inspecteur et propriétés d'objets

Voir aussi

Chapitre Bases, en particulier Saisie des notes
Chapitre Notation, en particulier Altérations accidentelles
Chapitre Textes, en particulier Édition de texte et Mouvements de symboles et textes de portée
basés sur la grille

Une question sans réponse ? Postez la sur le forum.

Opérations sur les mesures

Ajout

Ajouter une mesure à la fin d'une pièce

Appuyer sur Ctrl+B (Mac : ⌘+B)
Ou menu Ajouter → Mesures → Ajouter une mesure.

Ajouter plusieurs mesures (à la fin d'une pièce)

Appuyer sur Alt+Maj+B (Mac: Option+Maj+B)
Ou menu Ajouter → Mesures → Ajouter des mesures.

Insertion

Insérer une mesure vide

Sélectionner une mesure, puis appuyer sur Insert, pour insérer une nouvelle mesure vide avant
la mesure sélectionnée.
Ou menu Ajouter → Mesures → Insérer une mesure pour insérer une nouvelle mesure vide
avant la mesure sélectionnée.

Insérer plusieurs mesures

Appuyer surCtrl+Insert (pas de raccourcis sur Mac), entrez le nombre désiré dans le champs.
Ou menu Ajouter → Mesures → Insérer des mesures, entrez le nombre désiré dans le champs.

Supprimer

Supprimer une simple mesure

Sélectionner une mesure, puis appuyer sur Ctrl+Suppr (Mac : Cmd+Fn+Suppr).

Supprimer une suite de mesures

1. Clic sur la première mesure, maintenez Maj en cliquant sur la dernière mesure du groupe.
2. Puis Ctrl+Suppr (Mac : Cmd+Suppr).

Supprimer depuis une mesure, jusqu'à la fin

1. Clic sur la première mesure, puis Ctrl+Maj+Fin (Mac : Cmd+Maj+Fin); release the keys.
2. Puis Ctrl+Suppr (Mac : Cmd+Suppr).

Supprimer depuis le début, jusqu'à une mesure

1. Clic sur la dernière mesure du groupe, puis Ctrl+Maj+Home (Mac : Cmd+Maj+Home)
2. Puis Ctrl+Suppr (Mac : Cmd+Suppr).

Note: In multi-staff scores, measure deletion also removes all corresponding measures in the other
staves of the system, even if these don't appear to be selected.
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If you wish to delete only the elements (notes, symbols, text) and not the measure itself, then
selectionnez a measure or range of measures and click Suppr. The selected measures are filled with
whole measure rests.

Propriétés

Pour éditer les propriétés d'une mesure, clic-droit sur une partie vide de la mesure et sélectionner
propriétés de la mesure :

Portées

La propriété visible vous permet d'afficher/masquer les notes et les lignes de portée de la
mesure courante.
La propriété sans hampes vous permet d'afficher/masquer toutes les hampes de notes de la
mesure courante. Les notes qui ont normalement une hampe comme les blanches et les noires
montrent uniquement la tête de note quand sans hampes est coché.

Durée de la mesure

La durée nominale est l'indication de mesure affichée dans la partition.
Vous pouvez changer la durée réelle de la mesure par n'importe quelle valeur indépendamment
de l'indication de mesure affichée dans la partition.
Normalement, la durée nominale et la durée réelle de la mesure sont identiques. Toutefois, une
mesure (par exemple levée, anacrouse) peut avoir une durée réelle plus courte.

Dans la figure ci-dessous, la noire en levée a une mesure d'une durée nominale de 4/4, mais une
durée réelle de 1/4. Les mesures du milieu ont toutes les deux une durée nominale et réelle de 4/4. La
mesure complémentaire avec une blanche pointée à la fin présente une durée réelle de 3/4 :

Autres

Mesures non comptées 
Utiliser "Mesure non comptée" pour les mesures "irrégulières", à savoir celles qui ne devraient

52



pas être comptées dans les numéros de mesure. Normalement une mesure de levée est
marquée comme "Mesure non comptée".

Ajouter au numéro de mesure 
Vous pouvez aussi utiliser l'option "Ajouter au numéro de mesure" pour modifier le numéro de la
mesure. Vous pouvez entrer un nombre positif ou négatif. Merci de noter que cela affecte les
mesures suivantes. Une valeur de "-1" a le même effet que de marquer la mesure comme
"Mesure non comptée".

Étirer la mise en page 
Vous pouvez avec cette option augmenter ou diminuer l'espace horizontal entre les éléments de
la partition (notes, silences, etc.).

Nombre de répétitions 
Dans la la dernière mesure d'une répétition, vous pouvez définir le nombre de fois qu'elle est
jouée.

Diviser les pauses multimesures 
Cette propriété divise une pause multimesure au début de la mesure sélectionnée. Cette option
devrait être vérifiée avant de cocher l'option "Créer des pauses multimesures" dans Style →
Général, dans l'onglet "Partition".
Les pauses multimesures sont automatiquement divisées lors d'importants changements tels
que les repères de répétition, les changements d'indications de mesure, les doubles barres, les
mesures irrégulières, etc... Cette option est décochée par défaut pour la partition, et cochée par
défaut pour les parties séparées.

Numérotation

MuseScore affiche automatiquement les numéros des premières mesures de chaque système
(exception faite pour les mesures portant le numéro 1), mais d'autres options de numérotation sont
possibles.
À partir du menu principal, choisir Style → Général, dans la colonne de gauche, choisir l'onglet "En-
tête, Pied de page, Nombres". En bas de la colonne de droite se trouve la section "Numéros de
mesure".

Cocher la case "Numéros de mesure" pour activer les numéros de mesure automatiques.

Cocher "Afficher aussi sur la première" si vous souhaitez afficher le numéro de la première mesure.

Cocher "Toutes les portées" si vous souhaitez les numéros sur toutes les portées. Sinon, seule la
portée du haut de chaque système comportera un numéro de mesure.

Vous pouvez afficher les numéros "À chaque système" sur la première mesure de chaque ligne, ou
afficher les numéros par "Intervalle" et spécifier la taille de l'intervalle. Par exemple, un intervalle de 1
pour afficher un numéro à chaque mesure; ou un intervalle de 5 pour afficher un numéro toutes les 5
mesures.

Scinder et joindre

Pour avoir une mesure plus longue ou plus courte, vous pouvez changer la durée ou l'indication de
mesure dans les propriétés de la mesure, mais il y a maintenant cette nouvelle option pour scinder ou
joindre des mesures. Les ligatures seront automatiquement modifiées.

Note : S'applique à toutes les portées du système.

Joindre

1. Sélectionnez les mesures que vous souhaitez joindre
2. Édition → Mesures → Joindre les mesures
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Scinder

1. Sélectionner une note ou un accord
2. Édition → Mesures → Scinder la mesure

Voir aussi

Comment supprimer des mesures (en anglais)
Comment étirer une mesure à travers plusieurs systèmes (en anglais)
Comment obtenir une partition sans indications de mesure (et sans clefs) (en anglais)

Une question sans réponse ? Postez la sur le forum.

Palettes et Espaces de travail
Une palette est une compilation de symboles musicaux. Un espace de travail est un ensemble de
palettes regroupées dans un panneau sur le côté gauche (par défaut) de la fenêtre principale du
programme.

Vous pouvez afficher / masquer les palettes en utilisant le menu Affichage → Palettes, ou utiliser le
raccourci F9 (Mac: fn+F9).

Espaces de travail

MuseScore dispose par défaut de deux espaces de travail : de base (par défaut) et avancé (avec
plus de palettes et donc plus de symboles). Vous pouvez passer de l'un à l'autre grâce au menu
déroulant en bas de l'espace de travail courant.

Les noms des palettes d'un espace de travail sont listés sous le mot "Palettes". Pour ouvrir ou fermer
une palette, cliquez simplement sur son nom ou sur la flèche correspondante.
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Les palettes des espaces de travail fournis par défaut dans MuseScore ne sont pas éditables. Pour
pouvoir éditer une palette, vous devez d'abord créer un espace de travail personnalisé, le nommer, et
éditer les palettes ou en créer de nouvelles.

Mode Palette seule

Si vous ne voulez pas que plusieurs palettes puissent rester ouvertes en même temps : clic-droit tout
en haut de l'espace de travail et cochez "palette seule".

Accrochage / décrochage des panneaux latéraux

Pour accrocher ou décrocher voir les panneaux latéraux.

Espace de travail personnalisé

Un espace de travail personnalisé se crée par duplication et renommage de l'espace de travail
actif.

Cliquez sur le " + " du menu déroulant des espaces de travail (dans le bas du panneau des
palettes), donnez un nom, il est créé.
ou
Édition → Espace de travail  → Nouveau, donnez un nom, il est créé.

Dans ce nouvel espace de travail, vous pouvez éditer les palettes (après avoir coché activer
l'édition dans le menu contextuel de la palette), les supprimer, les réorganiser, les sauvegarder, en
créer ou en charger (précédemment sauvegardées).

Palettes

Ajouter des symboles à votre musique

Glissez/déposez les symboles depuis une palette sur la partition.
ou
Double-clic sur le symbole d'une palette, c'est équivalent au glisser/déposer, sur chacun des
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éléments sélectionnés de la partition.

Par exemple, vous pouvez rapidement ajouter des symboles de "tenuto" à un groupe de notes :

1. Sélectionner les notes
2. Dans la palette "Articulations et ornements", double-cliquer sur le symbole "tenuto".

Palettes de base et avancées

Vous pouvez choisir entre les palettes "De base" et "Avancé", ou créer une palette personnalisée.

Palettes de l'espace de travail "avancé"

Fioritures
Clefs
Armures
Indications de mesure
Barres de mesure
Lignes
Arpèges et Glissandos
Respirations et pauses
crochets système
Articulations et ornements
Altérations
Nuances
Doigté
Têtes de note
Tremolo
Reprises
Tempo
Texte
Sauts et espacements
Ornements pour cornemuse
Propriétés des ligatures
Cadres et Mesures
Diagrammes d'accord

Palettes personnalisées

Une fois votre espace de travail personnalisé créé (voir plus haut), vous pourrez, selon vos besoins,
en réordonner les palettes, en créer de nouvelles, en supprimer ; vous pourrez même en modifier les
éléments en activant l'édition par leur menu contextuel.

Pour ajouter un élément de la partition à une palette personnalisée (ligne, texte, nuance, diagramme
d'accord, etc), maintenez Ctrl+Maj tout en cliquant/glissant le symbole sur la palette. Les symboles de
la palette principale peuvent également être ajoutés à une palette personnalisée.

Menu contextuel des palettes

Clic droit sur une palette d'un espace de travail personnalisé :

Propriétés de la palette, Permet des ajustements sur l’apparence de la palette :

56

https://musescore.org/en/handbook/custom-palettes
https://musescore.org/fr/manuel/fioritures
https://musescore.org/fr/manuel/clef
https://musescore.org/fr/manuel/armature
https://musescore.org/fr/manuel/indications-de-mesure
https://musescore.org/fr/manuel/barres-de-mesure
https://musescore.org/fr/manuel/lignes
https://musescore.org/fr/manuel/arp%C3%A8ges-et-glissandos
https://musescore.org/fr/manuel/respiration
https://musescore.org/fr/manuel/crochets-syst%C3%A8me
https://musescore.org/fr/manuel/articulations-et-ornements
https://musescore.org/fr/manuel/alt%C3%A9rations
https://musescore.org/fr/manuel/nuances
https://musescore.org/fr/manuel/doigt%C3%A9s
https://musescore.org/fr/manuel/t%C3%AAtes-de-notes
https://musescore.org/fr/manuel/tr%C3%A9molo-0
https://musescore.org/fr/manuel/reprises
https://musescore.org/fr/manuel/tempo
https://musescore.org/fr/manuel/texte
https://musescore.org/fr/manuel/sauts-et-espacements
https://musescore.org/fr/manuel/ligatures-0
https://musescore.org/fr/manuel/cadre
https://musescore.org/fr/manuel/op%C3%A9rations-sur-les-mesures
https://musescore.org/fr/manuel/diagrammes-daccord
https://musescore.org/fr/manuel/palettes-et-espaces-de-travail#custom-workspace


Nom de la palette
Taille de la cellule : Largeur, hauteur
Décalage de l'élément : Ajustement vertical des éléments dans la palette (pas d'effet sur la
partition).
Échelle : Taille relative des éléments dans l'espace travail (pas d'effet sur la partition).
Afficher la grille : Cocher cette option pour matérialiser la séparation entre les éléments de
la palette.
Afficher "plus d’éléments" : Cocher cette option permet un menu contextuel dans les
éléments de la palette.

Insérer une nouvelle palette
Monter la palette / Descendre la palette.
Activer l'édition : Cocher cette option pour que la palette soit éditable (décocher pour éviter les
maladresses).
Enregistrer la palette : Permet d'enregistrer la palette dans un fichier.
Charger une palette :
Supprimer la palette : ! ! ATTENTION ! !, supprime la palette sans avertissement, même si
"Activer l'édition" est décoché (un avertissement sera présent dans la prochaine version).

Menu contextuel des éléments d'une palette (après avoir coché "Activer l'édition") :

Effacer : Efface l’élément de la palette
Propriétés : Ouvre la boite de dialogue Propriétés de la cellule.

Nom : Nom qui apparait au survol de l'élément avec la souris.
Décalage du contenu (X, Y) : Ajuste la position de l'élément dans la palette.
Échelle actuelle : Change la taille de l'élément dans la palette.
Dessiner la portée : Fait apparaitre une portée derrière l'élément.

Plus d’éléments : Ouvre la Palette Principale directement à la section dédiée.

Note : Changer une valeurs dans les propriétés de cellule affecte seulement l'apparence de l'élément
dans la palette, pas dans la partition.

Palette Principale

D'autres symboles musicaux sont disponibles dans la Palette principale, Maj+F9 ou Z (Mac:
fn+Shift+F9).

Textes et Lignes ajoutés depuis une palette personnalisée

Si le symbole ajouté à la partition depuis une palette personnalisée contient un élément de texte (texte
de portée, nuance, doigté, reprise, etc), alors les propriétés de type de police, de taille, de couleur et
d'alignement s'adapteront selon les règles suivantes :

1. Les textes, dont les propriétés de style n'ont pas été modifiées par l'utilisateur (défaut),
adopteront le style de texte de l'élément concerné, actif dans la partition.

2. Les textes, dont le style a été modifié avant enregistrement dans une palette personnalisée,
conserveront les modification de style.

When adding a ligne, line properties always remain unchanged (i.e. as set by the user before saving
to a custom workspace, or as predefined in the Basic/Advanced workspaces).

Voir aussi

Palettes personnalisées
Palette principale

Une question sans réponse ? Postez la sur le forum.

Tonalité de concert
La tonalité de concert vous permet d'afficher soit les notes dans le ton des instruments
transpositeurs, soit les notes réelles. Cela peut changer les armures ou les clefs pour les adapter aux
instruments transpositeurs.
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Note: Avant d'imprimer, assurez-vous que les parties ne sont pas en mode tonalité de concert si
vous avez des instruments transpositeurs dans votre partition.

Voir aussi

Transposition: Instruments transpositeurs
Altérations accidentelles: Recalculer les altérations

Une question sans réponse ? Postez la sur le forum.

Partager les partitions en ligne
Rendez-vous sur musescore.com/sheetmusic pour visualiser une liste de partitions réalisées avec
MuseScore.

Vous pouvez enregistrer et partager vos partitions en ligne sur MuseScore.com. Vous pouvez choisir
d'enregistrer une partition privée pour un accès personnel à partir de n'importe quel ordinateur ou la
partager publiquement. MuseScore.com permet la visualisation et la lecture des partitions dans votre
navigateur internet - une fonctionnalité supplémentaire intitulée VideoScores permet la synchronisation
entre la partition et une vidéo YouTube. Pour une utilisation en dehors d'un navigateur internet, vous
pouvez télécharger la partition dans divers formats (y compris PDF, MIDI, MP3, MusicXML, et le
format natif de MuseScore bien sûr).

Créer un compte

1. Visitez MuseScore.com et cliquez sur "Créer un compte". Choisissez un nom d'utilisateur et
entrez une adresse email valide puis appuyez sur "Créer un compte".

2. Attendez quelques minutes pour recevoir un email du support de MuseScore.com. Si vous ne
recevez rien, vérifiez votre dossier spam.

3. Cliquez sur le lien de l'email et accédez à votre profil pour changer votre mot de passe.

Partager une partition directement depuis MuseScore

Vous pouvez enregistrer une partition en ligne directement depuis le menu Fichier → Enregistrer en
ligne :

58

https://musescore.org/fr/forum
http://musescore.com/sheetmusic?utm_source=handbook
http://musesore.com?utm_source=handbook
http://musescore.com/?utm_source=handbook
http://musescore.com/user/register2
http://musescore.com/user?utm_source=handbook


Si vous ne possédez pas encore de compte MuseScore, commencez par en créer un en cliquant sur
le lien "Créer un compte" et votre navigateur internet vous fera accéder à
https://musescore.com/user/register.

Ensuite, entrez votre adresse email ou votre nom d'utilisateur, puis votre mot de passe. Une fois
connecté, vous pourrez saisir les informations de votre partition :
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1. Le titre est le titre de votre partition.
2. La description est à renseigner ici.
3. L'option rendre la partition privée permet une fois cochée que la partition soit visible

uniquement par vous (ou via un lien confidentiel). L'option décochée rend la partition publique,
accessible à tous.

4. Choisissez une licence. En utilisant une licence Creative Commons, vous autorisez
implicitement l'utilisation de vos partitions sous les conditions de celle-ci.

5. Vous pouvez ajouter des balises (tags) séparées par une virgule, pour aider à identifier les
partitions sur MuseScore.com.

6. Dans le cas où vous avez déjà enregistré votre partition, elle sera automatiquement mise à jour,
et depuis la version 2.1, vous pouvez entrer des informations dans la section Changelog.
Décochez Mettre à jour la partition existante pour enregistrer comme une nouvelle partition :

1. Depuis la version 2.1. Si vous utilisez une soundfont différente de celle par défaut et que votre
configuration vous permet d'exporter en MP3, une case à cocher "Upload score audio" sera
visible et accessible. Si cette case est cochée, MuseScore génèrera le son de la partition en
utilisant les réglages du synthétiser et l'enverra à MuseScore.com.

Télécharger une partition sur MuseScore.com

Vous pouvez également télécharger directement une partition sur MuseScore.com.

1. Cliquez sur le lien de téléchargement sur MuseScore.com.
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2. Vous avez les mêmes options que dans le menu Enregistrer en ligne.
3. Vous avez aussi accès à plus d'informations, comme le Genre.

Note : Si vous atteignez la limite de téléchargement de cinq partitions, vous pouvez toujours
télécharger directement depuis MuseScore, mais seules les cinq dernières seront visibles. Si vous
souhaitez plus que ce quota, passez à un Compte Pro.

Éditer une partition sur MuseScore.com

Si vous souhaitez modifier l'une de vos partitions sur MuseScore.com, éditez le fichier MuseScore sur
votre ordinateur et suivez les étapes ci-dessous.

1. Allez sur la page de MuseScore.com.
2. Cliquez sur le lien d'édition
3. Dans le formulaire, vous pouvez remplacer le fichier de la partition, les informations et privilèges.

Voir aussi

Comment supprimer une partition enregistrée sur MuseScore.com

Une question sans réponse ? Postez la sur le forum.

Notation
Dans le chapitre précédent "Bases" vous avez appris la Saisie des notes et les intéractions avec les
palettes. Le chapitre "Notation" décrit les différents types de notation, plus en détail, including more
advanced music notation.

Voir aussi "Fonctionnalités avancées"

Alternatives de reprise
Les alternatives de reprise (mesures de première et de deuxième fois) permettent d'indiquer des fins
différentes lors d'une reprise :

Pour placer une mesure de première fois (ou n-ième), faites glisser-déposer l'indication depuis la
Palette Lignes.

Pour une alternative de plusieurs mesures, déposez d'abord l'indication sur la première
mesure. Ensuite, double cliquez sur l'indication pour entrer en mode Édition et cliquez sur
Maj+→ pour étendre l'indication d'une ou plusieurs mesures. Vous pouvez également réduire
l'indication en cliquant sur Maj+←.

Ces commandes déplacent le début et la fin des reprises pour le mode lecture de Musescore ainsi que
pour la disposition sur plusieurs systèmes. Le déplacement du début ou de la fin des reprises à
l'aide de la souris ou des flèches du clavier sans Maj va modifier le graphisme mais pas le
mode de lecture, causant des erreurs de lecture dans les reprises.
Quand vous déplacez les poignées de la reprise à l'aide de la souris, une ligne pointillée apparaît pour
visualiser l'endroit ou la reprise est prise en compte par le mode de lecture :

Texte
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Vous pouvez changer le texte et d'autres propriétés de l'alternative de reprise. Cliquez-droit sur la
ligne et choisissez Propriétés de la ligne ... .
Les images ci-dessous montrent un texte "1-5" pour la première alternative de reprise.

En double-cliquant sur l'alternative de reprise, vous avez également accès au menu Propriétés de la
reprise .... Vous pouvez ici changer le texte (le même que dans le menu Propriétés de la ligne
...) et la liste des répétitions.
Cet autre exemple montre une alternative de reprise jouée pour les répétitions 1,2,4,5 et 7 tandis que
l'autre alternative sera jouée pour les reprises 3,6 et au-delà si besoin.

Lecture

Si votre reprise reprend un passage plus de deux fois et que vous voulez que le mode de lecture en
tienne compte, vous devez cliquer droit sur la mesure, aller dans Propriétés de la mesure ...  et
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changer le nombre de répétitions. Voir Opérations sur les mesures : Autres.

Liens externes

Video tutorial: Repeats, 1st and 2nd time endings
Screencast: Add alternative repeats with MuseScore

Une question sans réponse ? Postez la sur le forum.

Altérations accidentelles
Les altérations accidentelles peuvent être ajoutées ou modifiées en faisant glisser l'un des
symboles d'altérations depuis la palette Altérations jusqu'à une note dans la partition :

Si vous souhaitez seulement modifier la hauteur d'une note, vous pouvez aussi sélectionner la note et
appuyer sur :

↑: augmente la hauteur de la note d'un demi-ton (favorise les dièses).
↓: diminue la hauteur de la note d'un demi-ton (favorise les bémols).
Ctrl+↑ (Mac: Cmd+↑): augmente la hauteur de la note d'une octave.
Ctrl+↓ (Mac: Cmd+↓): diminue la hauteur de la note d'une octave.
J: change la note pour un son enharmonique.

Pour changer une altération accidentelle existante en altération de précaution (entre parenthèses),
faites glisser les parenthèses depuis la palette Altérations sur une altération accidentelle existante (et
non sur la tête de la note). Pour supprimer les parenthèses, sélectionnez l'altération accidentelle et
appuyez sur Suppr.

Si vous modifiez ultérieurement la hauteur avec les touches de curseur, les réglages manuels de
l'altération accidentelle sont supprimés.

Recalculer les altérations

La fonction du menu Notes → Recalculer les altérations essaie de deviner les bonnes altérations
dans la partition entière.

Voir aussi

Armures : Changer

Liens externes

Altérations accidentelles sur Wikipédia

Une question sans réponse ? Postez la sur le forum.

Armures
Les armures peuvent être créées ou modifiées en faisant glisser le symbole depuis la palette Armures
jusqu'à une mesure, ou sur une armure existante.

F9 (Mac: fn+F9) affiche / masque le panneau des palettes.
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Remplacer une armure existante

Faites glisser l'armure depuis la palette directement sur l'armure dans la partition OU
Si vous souhaitez changer l'armure d'une seule portée de votre partition (ce qui pourrait être le
cas en musique contemporaine par exemple), appuyez sur Ctrl (Mac: ⌘) pendant que vous
faites glisser l'armure sur la bonne portée.

Ajouter une nouvelle armure

Faites glisser l'armure depuis la palette sur une partie vide de la mesure. Cela placera l'armure
au début de la mesure. OU
Si vous souhaitez ajouter une armure sur une seule portée de votre partition (ce qui pourrait être
le cas en musique contemporaine par exemple), appuyez sur Ctrl (Mac: ⌘) pendant que vous
faites glisser l'armure sur la bonne portée.

Supprimer une armure

Cliquez sur l'armure existante et appuyez sur Suppr, OU
Faites glisser l'armure vierge depuis la palette dans la mesure.

Rappel des armures

Dans l'inspecteur, pour une armure sélectionnée, une option "Afficher le rappel" est disponible. De
plus, dans le menu Style → Général → Page vous trouverez une option pour "créer le rappel des
armures". L'inspecteur n'affectera que l'armure sélectionnée, le réglage de style affectera la partition
entière.

Bécarres dans les changements d'armure

Vous pouvez choisir d'indiquer des bécarres dans certains cas lors d'un changement d'armure. Sous
Style → Général → Altérations vous verrez plusieurs options :

Résultats en fonction de l'option choisie :

Uniquement pour les changements vers Do majeur / La mineur (défaut)

Avant l'armure si le changement utilise moins de ♯ ou de ♭ :

64



Après l'armure si le changement utilise moins de ♯ ou de ♭. Avant s'il passe de ♯ à ♭,
ou inversement :

Vous pouvez cliquer appliquer les changements, ou OK.
Si vous avez des parties séparées, vous pouvez cliquer Appliquer à l’ensemble des parties.

Armures et pauses multimesures

Les pauses multi-mesures sont interrompues s'il y a un changement d'armure :

Rappels d'armure et sauts de section

Un rappel d'armure ne sera pas affiché juste avant un saut de section.
Voir Sauts et espacements : Saut de section

Armures personnalisées

Appuyez surMaj+K pour afficher la palette principale des armures :

Vous pouvez même utiliser des doubles bémols, doubles dièses, etc.
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Note : La lecture audio d'une armure personnalisée n'est pas supportée.

Une question sans réponse ? Postez la sur le forum.

Arpèges et glissandos
Les arpèges sont ajoutés en faisant glisser le symbole depuis la palette Arpèges et glissandos
jusqu'à une note d'un accord.

Pour changer la longueur d'un arpège, double-cliquez dessus et faites glisser la poignée du haut ou
du bas.

Les Glissandos sont ajoutés en faisant glisser le symbole depuis la palette Arpèges et glissandos
jusqu'à la première de deux notes consécutives dans une même portée.
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Vous pouvez éditer ou supprimer le texte d'un glissando en cliquant droit dessus et en sélectionnant
"Propriétés du glissando" dans le menu ou dans l'inspecteur. S'il n'y a pas assez de place entre les
deux notes, MuseScore n'affichera pas le texte.

Liens externes

Arpèges sur Wikipédia
Glissandos sur Wikipédia

Une question sans réponse ? Postez la sur le forum.

Articulations et ornements
Une liste complète des symboles se trouve dans la palette Articulations et Ornements, de l'espace
de travail avancé. Une liste réduite de trouve dans l'espace de travail de base.

Articulations

Les Articulations sont des symboles ajoutés à la partition pour donner une indication sur la manière
dont une note ou un accord doit être joué(e). Les principaux symboles sont :

Point d'orgue
Piqué
Mezzo-staccato / Portato
Staccatissimo
Tenuto
Sforzato
Marcato

Des articulations spéciales pour instruments à cordes (pincées ou frottées), pour instruments à vent,
etc, sont également disponibles.

Ornements

Mordants, Mordants Inversés, Pralltrillers
Trilles
Gruppetto (wikipédia)
Bends

Note: les Appoggiaturas et les acciaccaturas se trouvent dans la palette Fioritures.

Ajouter une articulation ou un ornement

1. Sélectionnez une note ou un groupe de notes.
2. Double-clic sur le symbole dans la palette.
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Vous pouvez également ajouter un symbole par glisser/déposer depuis la palette directement sur une
tête de note.

Ajouter une altération accidentelle à une articulation

Pour ajouter une altération accidentelle à une articulation, comme un trille, ajoutez-la depuis la Palette
des caractères spéciaux (F2) dans un objet texte.

Alternativement, appliquez l'altération à la note depuis la Palette Principale.

Ajouter un point d'orgue à une barre de mesure

Un point d'orgue peut être appliqué directement à une barre de mesure en la sélectionnant et double-
cliquant sur le point d'orgue dans la palette.

Un point d'orgue peut être ajouté directement à une barre en le sélectionnant et en double-cliquant le
point d'orgue depuis la palette.

Raccourcis clavier

Staccato : Ajouter/Retirer Maj+S
Tenuto : Ajouter/Retirer Maj+N
Sforzato (accent) : Ajouter/Retirer Maj+V
Marcato : Ajouter/Retirer Maj+O
Ajouter une Acciaccatura (fioriture) : /

Les raccourcis clavier de MuseScore peuvent être personnalisés dans le menu Édition > Préférences
.

Ajuster la position

Une fois ajouté depuis la palette, une articulation ou un ornement est sélectionné et peut être déplacé
verticalement avec les touches du clavier :

Touche ↑ou↓ pour les déplacements fins (pas de 0.1 esp.) ;

Ctrl+↑ ou Ctrl+↓ (Mac : Cmd+↑ ou Cmd+↓) déplacement rapide (pas de 1 esp.).

Pour basculer un symbole de l'autre coté de la note (si pertinent), sélectionnez-le, puis X.

Pour déplacer un symbole dans les 4 directions avec le clavier :

1. Double clic sur le symbole pour entrer en mode Édition, ou clic (sélection) puis Ctrl+E (Mac:
Cmd+E) , ou encore clic droit sur le symbole puis "Éditer l’élément" ;

2. Déplacements :

Flèche pour les ajustements fins (pas de 0.1 esp.); ou
Ctrl+Flèche (Mac: Cmd+Flèche) pour des ajustements plus rapides (pas de 1 esp.).

Vous pouvez également utiliser l'Inspecteur pour ajuster les décalages horizontaux et verticaux
d'élément(s) sélectionné(s).

Note: Les symboles peuvent être repositionnés directement avec la souris (moins précis).

Propriétés des articulations

Les propriétés des articulations (différentes selon le type d'articulation sélectionnée), sont accessibles
dans l'inspecteur.

D'autres propriétés (direction, point d'ancrage) sont accessibles par le menu contextuel : clic droit
Propriétés de l'articulation….

Le menu Style… → Général… → Articulations, Ornements vous permet d'effectuer des réglages
généraux.
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Voir aussi

Fioritures

Liens externes

Ornements sur Wikipédia

Articulations et ornements.PNG

Bends

Le symbole de l'Outil Bend , de trouve dans la palette Articulations et Ornements de l'espace de
travail avancé.

Appliquer un bend

Plusieurs façons de procéder :

Sélectionnez une note puis double-clic sur le symbole du bend dans la palette.
Faites glisser le symbole du bend depuis la palette, sur la note.

Par défaut, l'outil insère un bend de la valeur d'une ronde. Pour l'éditer, clic droit > propriétés du
bend. Un ensemble de 5 types de bends est proposé sur la gauche :

Comme vous pouvez le voir dans l'image au-dessus, le bend est représenté par un graphique
Les petits carré bleus sur la courbe grise sont les points de contrôle, le profil en résultant donne le
type du bend :

Profil montant = Tiré
Profil descendant = Relâché
Profil plat = Tenu

L'axe vertical du graphique représente l'amplitude du bend vers le haut ou vers le bas : l'unité est le
quart de ton (4 pour un ton, 3 tons max).

L'axe horizontal du graphique représente le rendu visuel du bend : l'unité est l'esp. (Espace de
portée). Chaque ajout de carré allonge le symbole du bend de 1 esp. et inversement

La courbe est modifiée par ajout/suppression de carrés bleus : cliquez sur une intersection libre pour
ajouter un point de contrôle ou sur un point pour le supprimer ; les points extrêmes ne peuvent qu'être
montés ou baissés.

Ajuster la taille
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La hauteur du symbole du bend est automatiquement ajustée pour qu'il soit juste au-dessus de la
portée. Cependant, il existe une méthode détournée pour l'éditer :

1. Créez juste au-dessus de votre note, une deuxième note, sur la ligne/interligne la plus haute de
la portée.

2. Appliquez un bend sur cette dernière : la hauteur du symbole de bend sera minimale.
3. Descendez la note pour augmenter la hauteur du bend.
4. Faites glisser le symbole de bend jusqu'à la position souhaitée.
5. Rendez la note invisible et muette dans l'Inspecteur).

Ajuster le positionnement

Plusieurs façons de procéder :

Faites glisser le symbole de bend avec la souris.
Clic sur le symbole et ajustez le décalage horizontal et/ou vertical dans l'Inspecteur.
Double clic sur le symbole ; ou juste clic dessus puis Ctrl+E (Mac: Cmd+E); ou clic droit sur le
symbole > "Éditer l’élément". Puis utilisez les flèches du clavier pour un ajustement fin (pas de
0.1) ; ou Ctrl+Flèches (Mac: Cmd+Flèches) pour des déplacements plus rapides (pas de 1 esp.).

Bends personnalisés

Après avoir créé votre bend dans la partition, vous pouvez l'enregistrer pour réemploi : maintenez
Ctrl+Maj (Mac: Cmd+Maj) pendant que vous faites glisser le symbole dans une cellule vide de la palette
Articulations et Ornements de l'espace de travail personnalisé.

Une question sans réponse ? Postez la sur le forum.

Barres de mesure

Changer le type de barre

Les barres de mesure sont modifiées en faisant glisser le symbole souhaité depuis la palette "Barres
de mesure" jusqu'à la barre à modifier dans la partition.

Pour rendre invisible une barre de mesure, sélectionnez la barre et appuyez sur V, ou décochez la
case Visible dans l'inspecteur, qui peut être affiché à partir du menu Affichage ou en appuyant sur F8
(Mac: fn+F8).

Créer un ensemble de portées

Pour étendre les barres de mesures sur plusieurs portées, double-cliquez sur une barre de mesure
(voir Mode Édition).

Faites glisser la poignée bleue vers le bas jusqu'à la portée suivante.

La barre de mesure sur plusieurs portées apparaît après avoir quitté le Mode Édition.
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Voir aussi

Opérations sur les mesures

Une question sans réponse ? Postez la sur le forum.

Clefs
Les Clefs sont créées ou modifiées en faisant glisser le symbole depuis la palette "Clefs" jusqu'à une
mesure ou une autre clef. Utilisez F9 (Mac: ⌥+⌘+K) pour afficher ou masquer la palette.

Note : Certaines clefs ne sont disponibles que depuis le menu Affichage > Palette principale
(Ctrl+F9).

Ajouter une clef

Faites glisser une clef depuis la palette jusqu'à un espace vide d'une mesure - cela créera une clef au
début de la mesure.

Faites glisser la clef sur une note en particulier pour créer un changement de clef dans une mesure -
si cette mesure n'est pas la première, la clef s'affiche en plus petit.

Exemple d'une partition pour piano, dans laquelle la portée du haut commence en clef de Sol et passe
immédiatement en clef de Fa, puis après une note et un silence, revient en clef de Sol.

Note : une clef glissée sur une note (et en particulier sur la première note), n'affectera pas les
propriétés des clefs de courtoisie.

Pour voir si le changement de clef apparaîtra sur une note ou sur une mesure, vérifiez quel élément
change de couleur lorsque vous faites glisser la clef.

Vous pouvez d'abord sélectionner la note, ou la mesure, et double-cliquer sur la clef dans la palette
pour être sûr que le changement soit bien placé.

71

https://musescore.org/fr/manuel/op%C3%A9rations-sur-les-mesures
https://musescore.org/fr/forum


Rappel des clefs

Lors d'un changement de clef en début de système, un rappel de clef est généré à la fin du système
précédent. Pour voir ou cacher les rappels de clefs, allez à Style → Général... → Page et cochez ou
décochez "créer le rappel des clefs".

Supprimer une clef

Sélectionner une clef et appuyez sur Suppr.

Notes : Changer de clef ne change pas la hauteur des notes. Au lieu de cela, les notes sont
repositionnées pour conserver leur hauteur.

Une question sans réponse ? Postez la sur le forum.

Crescendo
Les crescendos sont des objets ligne. Pour créer un crescendo, sélectionnez une note pour marquer
le point de départ.

<: Crée un crescendo
>: Crée un diminuendo (decrescendo)

Vous pouvez aussi créer des crescendos en faisant glisser le symbole depuis la palette "Lignes".

1. < crée un crescendo

2. Double-clic sur le symbole pour passer en mode édition.
Puis sélectionnez le point de fin à déplacer (simple clic dessus) :

3. Maj+→ ou Maj+← déplace l'ancrage du point de fin sélectionné, qui détermine quelles notes seront
affectées par la lecture, et pour l'étendre à travers les sauts de ligne :

4. → ou ← et Ctrl+→ ou Ctrl+← (Mac: Cmd+→ ou Cmd+←) déplace le point de fin sélectionné sans
modifier son ancrage. Cette méthode est adaptée aux petits ajustements pour l'apparence
visuelle du crescendo.
Pour étendre le crescendo sous plus ou moins de notes, utilisez Maj+→ ou Maj+← pour changer
l'ancrage (voir ci-dessus).
La commande de réinitialisation Ctrl+R (Mac: Cmd+R) annulera ces petits ajustements, mais
n'annulera pas les modifications de l'ancrage.
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Les crescendos et les diminuendos seront affectés par la lecture seulement si des nuances sont
utilisées avant et après.

Une question sans réponse ? Postez la sur le forum.

Crochets système

Supprimer

Sélectionnez le crochet et appuyer sur Suppr

Ajouter

Faites glisser le symbole de crochet depuis la palette "Crochets système" jusqu'à un espace vide de
la première mesure d'un système.

Changer

Faites glisser le symbole de crochet depuis la palette jusqu'au crochet de la partition à modifier.

Éditer

Double-cliquez sur le crochet pour entrer dans le Mode Édition. Dans ce mode Édition, vous pouvez
faire glisser la hauteur d'un crochet pour relier les portées d'un système.

Décalage horizontal

Si vous avez besoin de déplacer un crochet plus loin sur la gauche ou sur la droite, double-cliquez sur
le crochet pour entrer dans le mode d'édition et appuyez sur Maj+← ou Maj+→.

Une question sans réponse ? Postez la sur le forum.

Divisions irrégulières, N-olets
Les divisions irrégulières sont utilisées pour écrire des divisions que l'indication de mesure rend
impossible. Par exemple, un triolet de croches en 4/4 divise une noire en trois au lieu de deux.

Instructions

Pour créer un triolet, commencez par sélectionner une note sur la partition qui a pour durée la durée
totale du futur triolet. Par exemple, un triolet de croches a la durée totale d'une noire.

Dans le menu principal, choisissez Notes → Divisions irrégulières → Triolet. Ceci va créer un
triolet en divisant la durée totale de la note en trois parties égales.

Les trois parties ainsi créées peuvent maintenant être éditées.
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Mode Saisie de notes

En mode Saisie de notes, la méthode de saisie est légèrement différente de celle proposée ci-dessus.
Vous devez choisir la durée totale du n-olet avant sa hauteur tonale. Regardons pas à pas la méthode
pour créer un triolet de croches :

1. Passez en mode Saisie de notes en cliquant sur N
2. Vérifiez que le curseur est bien à l'emplacement du début du triolet ( utilisez les touches de

direction droite et gauche si besoin )
3. Choisissez la durée totale du n-olet dans la barre d'outils. Pour cet exemple donc, une noire ( ou

appuyez sur la touche 5 du clavier ).
4. Depuis le menu principal, choisissez Notes → Divisions irrégulières → Triolet, ou appuyez

sur Ctrl+3 (Mac: ⌘+3)
5. Notez que la durée sélectionnée passe automatiquement à la croche. Cliquez sur la portée pour

ajouter des hauteurs ou entrez-les sur votre clavier d'ordinateur ou votre clavier midi.

Propriétés

Pour changer les propriétés d'un n-olet, cliquez sur son numéro ou sa parenthèse et utilisez
l'Inspecteur (F8).

Si jamais ni le numéro ni la parenthèse n'apparaissent, sélectionnez une note du n-olet et utilisez le
bouton Division irrégulière pour voir apparaître le dialogue suivant :

Direction, choisissez Automatique pour placer la parenthèse du même coté que les hampes.
Choisissez Vers le haut ou Vers le baspour forcer la position de la parenthèse vers le haut ou le bas.

Nombre, choisissez Nombrepour un entier, Relation pour le rapport entre la division choisie et la division
d'origine et Rien pour ne pas montrer de nombre.

Pour Type de crochet système , choisissez Automatiquepour afficher des parenthèses avec les notes
détachées et cacher les parenthèses sur les notes attachées. Choisissez Crochet ou Rien pour forcer
l'affichage ou non des parenthèses.

Si vous déplacez le numéro ou la parenthèse d'un n-olet, vous pouvez voir évoluer les options de
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décalage vertical et horizontal. Par défaut les décalages sont à 0,00esp.

NOT FOUND: insepector2.png

Vous pouvez revenir aux valeurs par défaut à l'aide de la flèche de retour en arrière située à droite.

NOT FOUND: insepector_restoredafaultsettings.png

Style

Allez à Style → Général... et selectionnez Divisions irrégulières. Cela vous permet de changer les
propriétés des n-olets.

Deux ajustements sont possibles : vertical et horizontal

L'ajustement vertical a quatre options :

Inclinaison minimale : par défaut 0,50esp ; plage de 0,10es à 1,00esp
Distance verticale de la hampe : par défaut 0,25esp ; plage de -5,00esp à 5,00esp
Distance verticale entre les têtes de notes : par défaut 0,50esp ; plage de -5,00esp à
5,00esp
Bouton 'Évitez les portées', coché par défaut

L'ajustement horizontal a quatre options :

Distance avant la hampe de la première note : par défaut 0,50esp ; plage de -5,00esp à
5,00esp
Distance avant la tête de la première note : par défaut 0,00esp ; plage de -5,00esp à
5,00esp
Distance après la hampe de la dernière note : par défaut 0,50esp ; plage de -5,00esp à
5,00esp
Distance après la tête de la dernière note : par défaut 0,00esp ; plage de -5,00esp à
5,00esp
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Voir aussi

Comment créer des triolets et autres n-olets

Liens externes

Tuplet at Wikipedia
How To Create Triplets in MuseScore [video]
The User Guide to Tuplets in MuseScore [video]

Une question sans réponse ? Postez la sur le forum.

Fioritures
Les fioritures courtes (Acciaccatura) sont représentées par une petite note barrée d'un trait sur sa
hampe. Les fioritures longues (Appoggiatura) ne sont pas barrées. Les deux sont placées avant la
note de taille normale.

Instructions

Créez une fioriture en faisant glisser le symbole souhaité depuis la palette "Fioritures" jusqu'à une
note normale de la partition. Il est également possible de créer une fioriture en sélectionnant une tête
de note de la partition et en double-cliquant sur le symbole de fioriture dans la palette "Fioritures".

Pour ajouter plus d'une fioriture, faites glisser successivement les fioritures sur la tête de note.

Pour ajouter un accord de fioritures, entrez la première fioriture et sélectionnez-la, puis utilisezMaj+
noms des notes (C, D, E etc...) pour ajouter les autres fioritures à l'accord.

Si vous souhaitez changer la durée d'une fioriture précédemment créée, sélectionnez-la et choisissez
la durée souhaitée dans la barre d'outils, ou entrez cette durée avec les raccourcis clavier : 1 à 9 (voir
Saisie des notes).

Les fioritures après une note (telles qu'une terminaison de trille) peuvent être ajustées manuellement
avec Ctrl + touches directionnelles.

Liens externes

Fioritures sur Wikipedia
Appoggiatures sur Wikipedia
Acciaccatura sur Wikipedia

Une question sans réponse ? Postez la sur le forum.

Indications de mesure
Plusieurs Indications de mesure sont disponibles dans la palette "Indications de mesure". Vous
pouvez glisser déposer une indication de mesure directement sur une mesure de la partition (voir
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Palette pour le travail avec les palettes dans MuseScore).

Créer vos propres indications de mesure

Si vous souhaitez utiliser une indication de mesure qui ne figure pas dans la palette par défaut, ouvrez
la Palette Principale à la section Indication de Mesure (Maj+T) pour créer une nouvelle indication. Vous
pouvez éditer le texte du numérateur et du dénominateur dans la section Créer une indication de
mesure.

En appuyant sur le bouton Ajouter l'indication de mesure est ajoutée à la palette centrale. Vous
pouvez ensuite la faire glisser sur une mesure de la partition directement depuis cette palette.
Attention, l'indication de mesure n'apparaîtra pas dans la palette de l'espace de travail. Si vous voulez
l'ajouter à cette palette, voir Palette personnalisée.

Changer les ligatures par défaut

Il suffit de cliquer sur les notes que vous souhaitez modifier pour changer les ligatures par défaut.

Par exemple, par défaut 5/8 est lié en 3+2 croches. Cliquez sur la 3ème et 4ème notes pour changer
la manière dont elles sont groupées et obtenir 2+3 croches. N'oubliez pas de changer les ligatures

pour les deux autres subdivisions. Pour les triples croches, faites glisser les icônes 
sur la note la plus à droite. Ici, l'icône "Début de la ligature" a été déposée sur la 9ème note et l'icone
"Ligature de croche entre deux double croches" sur le 13ème note.

Supprimer une indication de mesure personnalisée

Les indications de mesure que vous n'utilisez plus peuvent être supprimées de la palette principale
avec un clic droit dans la palette → "Effacer".

Durée de la mesure différente de l'indication de mesure: Anacrouse et Cadence

Dans certains cas, la durée réelle de la mesure est différente de la durée indiquée par l'indication de
mesure. C'est le cas par exemple pour les anacrouses ou les cadences. Pour changer la durée réelle
d'une mesure sans changer l'indication de mesure, voir Opérations sur les mesures: Propriétés, Durée
de la mesure.

Indications de mesure "locale"
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Dans certains cas, une indication de mesure peut être différente sur une portée d'un même système,
voici par exemple la 26eme variation Goldberg de JS Bach:

MuseScore offre le concept d'indication de mesure globale et locale pour saisir ce genre de partition.
Une indication de mesure globale s'applique pour toutes les portées d'un même système, une
indication locale ne s'applique qu'à une seule portée. Pour changer l'indication de mesure globale, il
suffit de faire glisser et déposer une indication depuis la palette.

L'indication locale peut être paramétrée dans les propriétés de l'indication de mesure et peut être
différente de l'indication globale pour chaque portée (Dans l'exemple la main droite est en 18/16 ).

NOT FOUND: Time_Signature_Properties_en.png

Le texte de l'indication de mesure peut aussi être indépendant des valeurs globale ou locale.

Il est aussi possible de créer une indication de mesure locale en faisant glisser une indication depuis
la palette en maintenant la touche Ctrl appuyée. L'indication locale sera alors créée uniquement sur la
portée où on la dépose.

Voir aussi

Pauses multimesures
Sauts et espacements

Une question sans réponse ? Postez la sur le forum.

Liaisons de phrasé
Une liaison de phrasé est représentée par une courbe entre deux ou plusieurs notes indiquant
qu'elles sont jouées sans séparation. Si vous souhaitez lier deux notes de même hauteur, voir
Liaisons de prolongation.

Première méthode

1. Quittez le mode Saisie des notes et sélectionnez la première note :

2. S créé la liaison :

3. Maj+flèche droite déplace la fin de la liaison sur la note suivante :
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4. X inverse la direction de la liaison :

5. Esc quitte le mode Édition des liaisons:

Deuxième méthode

1. Quittez le mode Saisie des notes et sélectionnez la première note
2. Maintenez appuyé Ctrl (⌘sur Mac) ou Maj et sélectionnez la première note puis la dernière note
3. Appuyez sur S

Troisième méthode

1. Pendant le mode Saisie des notes, entrez la première note de la section liée
2. Appuyez sur S pour commencer la section liée
3. Entrez les notes restantes dans la section liée
4. Appuyez sur S pour terminer la section liée

Ajustements

Les poignées (représentées dans les images des étapes 2 à 4 ci-dessus) peuvent être ajustées avec
la souris. Les deux poignées aux extrémités ajustent le début et la fin de la liaison, tandis que les deux
poignées intérieures ajustent le contour.

Une liaison peut s'étendre sur plusieurs systèmes ou pages. Le début et la fin de la liaison sont ancrés
à une note, un accord ou un silence. Si les notes sont repositionnées à cause d'un changement de
mise en page, d'étirement ou de style, alors la taille de la liaison est ajustée.

Cet exemple montre une liaison étendue depuis le bas de la clef de fa jusqu'au haut de la clef de sol.
En utilisant la souris, sélectionnez la première note de la liaison, maintenez appuyé Ctrl (resp. ⌘ sur
Mac) et sélectionnez la dernière note de la liaison, et appuyez sur S pour ajouter la liaison.

Liaisons en pointillés

Les liaisons en pointillés sont parfois utilisées dans les chansons où une liaison peut varier d'une
strophe à l'autre. Les liaisons en pointillés sont également utilisées pour indiquer une suggestion de
l'éditeur (par opposition aux indications originales du compositeur). Pour modifier une liaison existante
en pointillés ou discontinue, sélectionnez-la et dans l'inspecteur (F8), modifiez Type de ligne de
Continue à Pointillés ou En tiretés.

X inverse la direction d'une liaison sélectionnée.
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Voir aussi

Liaisons de prolongation
Mode Édition
Saisie des notes

Une question sans réponse ? Postez la sur le forum.

Liaisons de prolongation
Une liaison de prolongation est représentée par une courbe entre deux notes de même hauteur. Si
vous souhaitez une liaison qui englobe plusieurs notes de hauteurs différentes, voir Liaisons de
phrasé.

Première méthode

Sélectionnez la première note :

+ crée la liaison :

+ ou le bouton liaison , situé en haut à droite des notes dans la barre d'outils "Saisie des notes".

Seconde méthode

Pour créer une liaison durant la saisie des notes, appuyez sur + ou sur le bouton de liaison ,
après la première note à lier.

Accords liés

Pour ajouter des liaisons entre deux accords, sélectionnez la hampe du premier accord, ou Maj + clic

sur le premier accord et appuyez sur + ou sur le bouton de liaison . Le mode Saisie des notes ne
doit pas être actif.

Inverser une liaison

X inverse la direction verticale d'une liaison sélectionnée.

Une question sans réponse ? Postez la sur le forum.
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Ligatures
Les ligatures sont ajustées automatiquement en fonction de l'indication de mesure. Pour changer
l'ajustement par défaut, clic droit sur l'indication de mesure puis "Propriétés de l'indication de mesure."
Voir Changer les ligatures par défaut.

Ajuster les ligatures

Au choix :

Glissez un symbole de ligature depuis la palette Propriétés des ligatures sur un note
Sélectionnez une ou plusieurs notes et double cliquez sur le symbole de ligature dans la
palette.

 Commencer la ligature sur cette note.

 Ne pas terminer la ligature sur cette note (ou sur ce silence).

 Ne pas ligaturer cette note.

 Commencer une double barre sur cette note.

 Commencer une triple barre sur cette note.

 (revenir au) mode automatique : le mode que MuseScore choisit lors de la saisie des notes,
dépendant de l'indication mesure courante.

 Commencer un deccelerando rythmique sur cette note.

 Commencer un accelerando rythmique sur cette note.

Ajuster l'angle de la ligature

1. Double-clic sur une ligature pour être en Mode édition, la poignée droite est automatiquement
activée.

2. Haut/Bas ou avec la souris, pour corriger l'angle de la ligature.
3. Échap pour sortir du mode édition.

Vous pouvez aussi le faire dans l'Inspecteur :

1. Sélectionnez la ligature.
2. Cochez "Position personnalisée" dans la section Ligature.
3. Ajustez les valeurs du camp "Position".

Hauteur des ligatures

Pour ajuster la distance entre les têtes de notes et les ligatures (longueur des hampes) :

81



1. Double-clic sur la ligature pour entrer en Mode édition.
2. Sélectionnez la poignée gauche puis Haut/Bas ou avec la souris, pour ajuster la hauteur de la

ligature
3. Échap pour sortir du mode édition.

Vous pouvez aussi le faire dans l'Inspecteur :

1. Sélectionnez la ligature.
2. Cochez "Position personnalisée" dans la section Ligature (décochez Horizontale le cas échéant).
3. Ajustez les deux valeurs du champ Position.

Ajuster les ligature orphelines

1. Sélectionnez la ligature.
2. Ajustez les valeurs de "Augmenter à gauche" et "Augmenter à droite" de la section Ligature de

l'Inspecteur.

Inverser le sens des ligatures

Pour inverser une ligature du haut vers le bas ou vice-versa, ou bien :

1. Sélectionnez une ou plusieurs ligatures.
2. Et au choix :

Touche X ;
utilisez le bouton de la barre saisie de notes__, entre le double bémol et le sélecteur de
voix (qui montre une note avec des hampes vers le haut et vers le bas)
Sélectionnez Automatique, Haut ou Bas dans la section "Direction" de l'Inspecteur.

Ligatures horizontales

1. Sélectionnez une ou plusieurs ligatures.
2. Cochez "Horizontale" dans la section Ligature de l'inspecteur.

If you want all note beams in the score to be horizontal there is a "Flatten all beams" option in Style →
Général → Ligatures.

Style → Général → Ligatures, cocher Aplanir l'ensemble des ligatures, vous permet de le faire pour
toute la partition.

Restaurer le mode de connexion des ligatures

Pour restaurer le mode de connexion des ligatures dans le mode de l'indication de mesure courante :
Mise en page→ Restaurer le mode de connexion des ligatures. La commande s'applique à la
sélection active, ou à défaut, à toute la partition.

Pour changer l'angle de la ligature, ou la distance entre la ligature et les notes (c'est-à-dire la longueur
des hampes), double-cliquez sur la ligature pour entrer dans le Mode Édition, avec la poignée à
l'extrémité droite sélectionnée. les flèches haut/bas du clavier permettront de changer l'angle.
Sélectionnez la poignée à l'extrémité gauche et utilisez les touches des flèches haut/bas pour allonger
ou raccourcir les hampes. Appuyer sur Échap pour sortir du mode d'édition une fois les changements
effectués.

Voir aussi

Ligatures entre deux portées
Mode Édition
Saisie des notes

Liens externes

Comment ajouter une ligature incluant un silence
Comment placer une ligature entre deux notes

Une question sans réponse ? Postez la sur le forum.
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Ligne octave
Les lignes d'octave (ottava) sont utilisées pour indiquer qu'une section de musique doit être jouée à
une octave différente de celle écrite (plus haute ou plus basse). Les lignes peuvent être en traits
continus ou pointillés. Les octaves sont disponibles dans la palette Lignes des espaces de travail de
base ou avancé.

8─────┐ou 8va─────┐: jouer une octave au-dessus de ce qui est écrit (uniquement
en clé de sol)

8─────┘ou 8vb─────┘: jouer une octave en dessous de ce qui est écrit
(uniquement en clé de fa)

Ces lignes (8va/8vb) sont particulièrement fréquentes dans les partitions de piano, mais on les trouve
aussi parfois dans des partitions d'autres instruments.1 15ma (2 octaves au-dessus) et 15mb (2
octaves en dessous) sont aussi parfois utilisées.

(Debussy. Études, Book II, X)

Appliquer une ligne d'octave

Plusieurs méthodes :

Sélectionner une note, puis double-clic sur la ligne d'octave depuis la palette, la ligne sera
étendue jusqu'à la fin de la mesure.
Sélectionner une étendue de notes (contiguës), puis double-clic sur la ligne d'octave depuis la
palette.
Sélectionner deux notes non contiguës, puis double-clic sur la ligne d'octave depuis la palette, la
ligne sera étendue jusqu'à l'avant dernière note sélectionnée.
Cliquer-déposer la ligne d'octave depuis la palette jusqu'à une note, la ligne sera étendue
jusqu'à la fin de la mesure.
Sélectionner une ou plusieurs mesures contiguës, puis double-clic sur une ligne d'octave depuis
la palette.

Changer la durée

Pour étendre ou réduire une ligne d'octave, qui soit interprétée par le lecteur de MuseScore :

1. Sortir du mode Saisie des notes → Esc

2. Double-clic sur la ligne souhaitée pour passer en mode Édition

3. Déplacer les poignées en utilisant les raccourcis suivants :

Maj+→ pour déplacer l'ancre vers la droite, d'une note (ou d'une mesure)
Maj+←pour déplacer l'ancre vers la gauche, d'une note (ou d'une mesure)

Pour seulement ajuster la durée sans modifier la lecture, faire glisser les poignées avec la souris ou
en utilisant les raccourcis suivants :

→ pour déplacer l'ancre vers la droite de 0,1 esp. (espace entre deux lignes de portée).
← pour déplacer l'ancre vers la gauche de 0,1 esp.
Ctrl+→ (Mac: Cmd+→) pour déplacer l'ancre vers la droite d'1 esp.
Ctrl+← (Mac: Cmd+→) pour déplacer l'ancre vers la gauche d'1 esp.
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Lignes personnalisées

Il est possible de personnaliser une ligne d'octave et/ou son texte. Dans la partition, clic droit sur la
ligne puis choisir Propriétés de la ligne ... . Sauvegarder les résultats par glisser/déposer sur la
palette personnalisée de votre choix Ctrl+Maj (Mac: Cmd+Maj).

Liens externes

Octave sur Wikipédia

1. Gerou/Lusk. Essential Dictionary of Music Notation (Internet Archive). (Dictionnaire abrégé de la
notation musicale en anglais) ↩

Une question sans réponse ? Postez la sur le forum.

Lignes
La palette Lignes, tout comme les autres palettes, fonctionne par glisser/déposer. Utilisez la souris
pour faire glisser un élément depuis la palette jusque dans la partition. Comme avec toutes les
palettes, les éléments visibles dans le panneau dépendent du réglage de l'espace de travail courant.
Ici le contenu de la palette dans l'espace de travail avancé :

Appliquer des lignes dans une partition

3 méthodes :

Sélectionnez une note et double cliquez une des lignes dans la palette.

Sélectionnez un groupe de notes : Clic sur la première note puis Maj + clic sur la dernière note,
puis double cliquez une des lignes dans la palette. Cela donnera une ligne plus courte que la
précédente sélection.

Cliquez/glissez une ligne depuis la palette, sur une note ou une sélection de notes de la
partition.
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Note, les liaisons de phrasé peuvent aussi être créées avec la touche . S.

Modifier la longueur

Si vous changez la longueur d'une ligne en utilisant la souris, la position des ancrages (les notes et
mesures auxquelles il s'appliquent) ne change pas. Donc la méthode suivante est recommandée pour
ajuster le point de départ et de fin d'une ligne :

1. Échap pour quitter la saisie des notes si vous y étiez.
2. Double-cliquez sur la ligne que vous souhaitez modifier : des poignées apparaissent dont une

bleue.
3. Déplacez les poignées en utilisant les raccourcis suivants :

Maj+→ pour déplacer l'ancrage vers la droite d'une mesure.
Maj+← pour déplacer l'ancrage vers la gauche d'une mesure.

4. Si vous avez besoin de changer la longueur visuellement sans changer les notes ou les
mesures sur lesquelles la ligne est ancrée, alors déplacez les poignées avec la souris ou utilisez
les raccourcis suivants :

→ pour déplacer la poignée sur la droite unité par unité
← pour déplacer la poignée sur la gauche unité par unité

Lignes spéciales et propriétés de "ligne"

Les lignes comme les octaves (8va, 8vb, 15ma, etc.) et les voltas (1ère et 2ème fois, etc.) peuvent
contenir des textes intégrés ou des crochets aux extrémités.

Une fois ajoutées à votre partition, elles peuvent être personnalisées selon vos besoins, et être
ajoutées à une palette de votre Espace de travail personnalisé, pour emploi ultérieur (voir plus bas).

1. Clic droit sur une "ligne" > Propriétés de la ligne...

2. Entrez le texte devant apparaitre au "début", dans le "prolongement" (ex. au début du système
suivant), et/ou à la "fin" de la ligne. Puis clic sur ... pour contrôler le formatage et le
positionnement de chaque partie du texte par rapport à la "ligne".

3. Crochet : Avec ou sans crochet, vous permet de définir la hauteur et les deux angles
séparément (45° ou 90°).

4. En sortant de la boîte "propriétés de la ligne" , vous pouvez régler l'épaisseur de la ligne dans
l'inspecteur, où vous pouvez également choisir le Style de ligne (ex. continue, en tireté,
pointillée).

Voir aussi Propriétés de la ligne.

Copie de lignes

Une fois définie, la ligne ne peut pas être copiée/collée de manière standard ; cependant vous pouvez
la dupliquer depuis la partition : Ctrl+Maj (Mac: Cmd+Maj), cliquez sur la ligne et glissez-là à l'endroit
que vous désirez.

Note : Pour enregistrer le résultat dans une palette, voir Palette personnalisée.

Lignes d'ornements

Pour ajouter une altération à une ligne d'ornement, comme une ligne de trille, sélectionnez la ligne et
double-cliquez sur le symbole dans la palette Altérations.

Liens externes

Marquages pédale piano en anglais.
Barré guitare en anglais.

Voir aussi

Crescendo
Volta (Mesures de première et deuxième fois)
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Musique ancienne, Ambitus

Une question sans réponse ? Postez la sur le forum.

Mesure de silences

Mesure de silence

Une mesure entière de silence est notée avec une pause centrée (image au-dessus), quelque soit
l'indication de mesure.

Pour créer une pause, sélectionnez la mesure et appuyez sur Suppr, toutes les notes et tous les
silences dans cette mesure sont remplacés par une pause.

Pauses multi-mesures

Les pauses multi-mesures indiquent une longue durée de silence pour un instrument et sont
fréquemment utilisées dans les partitions pour ensemble. Elles sont automatiquement interrompues
aux points importants, tels que les doubles barres, repères de répétition, armures ou indications de
mesure, etc.

Le nombre au-dessus de la pause multi-mesures indique le nombre de mesures de silence
concernées.

Instructions

1. Depuis le menu, choisissez Style → Général
2. Cliquez sur l'onglet "Partition" s'il n'est pas déjà sélectionné
3. Cochez la case "Créer des pauses multi-mesures"

Alternativement, appuyez sur M sur votre clavier pour activer/désactiver les pauses multi-mesures.

Limitations

L'option du style combine automatiquement les mesures vides avec les pauses multi-mesures dans
toute la partition. Par conséquent, il est recommandé d'entrer toutes les notes avant d'activer les
pauses multi-mesures.

Diviser une pause multi-mesures

Voir "Opérations sur les mesures" > Diviser des pauses multi-mesures

Vous pourriez souhaiter avoir une pause multi-mesures divisée en deux pauses multi-mesures.

Cette option peut être vérifiée avant de cocher l'option "Créer des pauses multi-mesures" dans l'onglet
"Partition" du menu Style → Général.
Sélectionnez la première mesure à partir de laquelle vous souhaitez commencer la seconde pause
multi-mesures, et faites un clic-droit dessus : Propriétés de la mesure → Diviser les pauses multi-
mesures.

Note : les pauses multi-mesures sont interrompues s'il y a un repère de répétition (pas un simple
texte), un saut de section, un changement d'armure ou d'indication de mesure, ou une double barre.

Une question sans réponse ? Postez la sur le forum.

Notation pour percussions
Même si la saisie de notes pour percussions diffère de celle pour instruments à hauteurs de notes
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variables (piano, violon...), vous devez quand même vous familiariser avec le processus de Saisie des
notes standard de MuseScore.

Sur une portée pour percussions de 5 lignes, chaque instrument se voit assigner un emplacement,
ligne ou interligne, et une forme de tête de note spécifique. Les partition pour batterie utilisent
communément deux voix :

voix 1 (en haut), les notes, hampes vers le haut, habituellement jouées avec les mains ;
voix 2 (en bas), les notes, hampes vers le bas, habituellement jouées avec les pieds (voir ci-
dessous).

Palette pour percussions

Les lettres A–G avant certaines notes dans la palette, sont les raccourcis assignés aux
instruments (bass drum, snare, closed hi-hat, etc.), et n'ont aucun rapport avec les hauteurs de
notes (ces raccourcis peuvent être changés si besoin par le bouton Éditer le set de batterie) en bas à
gauche.

Quand la Palette pour percussions est affichée, le double-clic sur une note de la palette ou l'entrée
d'un raccourci clavier ajoute la note (de l'instrument) sur la portées pour percussion.

Les couleurs des notes correspondent aux voix : bleu pour la voix 1 et vert pour la voix 2 (les voix
peuvent être changées si besoin par le bouton Éditer le set de batterie) en bas à gauche.

Cette affectation de voix n'est valide que pour les notes entrées au clavier ou à la souris, les notes
entrées par un clavier MIDI ou par le clavier de piano virtuel peuvent être affectées à n'importe
laquelle des 4 voix.

Méthodes de saisie des notes

Clavier externe MIDI ;
Clavier de piano virtuel ;
Clavier du PC ;
Souris.

Clavier MIDI

C'est la méthode la plus facile pour saisir une notation pour percussion dans votre partition.
Certains claviers MIDI comportent des symboles de percussions marqués sur chaque touche. Si vous
appuyez sur la touche de la charleston, alors MuseScore ajoutera la notation correspondante sur la
portée pour percussion. MuseScore gère automatiquement la direction des hampes et le type de tête
de note.

Méthode :

1. Clic sur une note ou un silence sur une portée pour percussion, là où vous voulez commencer.
2. Entrer en mode Saisie de notesN.
3. Sélectionner la voix adaptée. (ex : snares, sidesticks et toutes les cymbales en voix 1; bass

drum en voix 2.
4. Sélectionnez la Durée de note.
5. Sur le clavier MIDI, pressez la touche de l'instrument, pour ajouter sa notation sur la portée.
6. Pour ajouter une deuxième note au même temps : maintenez la touche de la note précédente

pendant que vous entrez la note.

Note : Certains claviers MIDI (ex : Casio) affichent comme aide, des symboles de percussion à coté
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des touches. Voir GM2 drum map pour des détails à propos des codes pour entrer les notes pour
instruments à percussion.

Clavier de piano virtuel

P affiche le clavier du piano virtuel (ou Affichage → clavier de piano). Quand une portée pour
percussions est sélectionnée, hors mode Saisie de notes, vous pouvez cliquer sur les touches du
clavier de piano virtuel pour entendre les sons à l'avance.

Méthode :

1. Clic sur une note ou un silence sur une portée pour percussions, là où vous voulez
commencer.

2. Entrez en mode Saisie de notes : N.
3. Sélectionnez la voix adaptée. (ex : snares, sidesticks et toutes les cymbales en voix 1; bass

drum en voix 2).
4. Sélectionnez une Durée de note depuis la barre d'outil de saisie des notes.
5. Sur le clavier du piano virtuel, entrez l'instrument, pour ajouter sa notation sur la portée.
6. Pour ajouter une deuxième note au même temps : maintenez Ctrl pendant que vous entrez la

note.

Par défaut, le panneau du clavier de piano virtuel est accroché en bas de la fenêtre principale, et à
gauche si il est partagé avec la palette Outils de percussions (en mode saisie de notes pour
percussions).
Il peut être décroché et raccroché ou partagé de plusieurs façons :

Draguez le panneau vers le centre et vers le bas : il occupera toute la largeur, recouvrant la
palette percussions, qui restera accessible par les onglets (en bas, à gauche).
Draguez le panneau à droite/gauche pour le repositionner à coté de la palette percussion.

Clavier d'ordinateur

1. Clic sur une note ou un silence sur une portée pour percussion, là où vous voulez commencer.
2. Entrer en mode Saisie de notes N, la palette Drum input palette now appears at the bottom of the

screen.
3. Sélectionnez une Durée de note depuis la barre d'outil de saisie des notes.
4. A/G selon les notes que vous désirez entrer.
5. Pour ajouter une deuxième note au même temps : maintenez Ctrl pendant que vous entrez la

note ([A–G]).

7 sons de percussions sont pré-définis avec des raccourcis par défaut (A-G), Éditer le set de
batterie vous permet de les redéfinir ainsi que de modifier d'autres propriétés du contenu de la
palette de saisie pour percussions (voir →ci-dessous).

Souris

Note : la saisie d'une notation pour des instruments de percussions à sons indéterminés fonctionne
différemment de la saisie d'une notation pour les autres instruments. Voici donc les étapes spéciales :

1. Clic là où vous voulez commencer.
2. Entrez en mode Saisie de notesN.
3. Sélectionnez une Durée de note depuis la barre d'outil de saisie des notes.
4. Sélectionnez un type de note (tel que grosse caisse, ou caisse claire) depuis la palette pour

percussions, puis cliquez sur la portée de percussions pour ajouter la note dans la partition OU
double-clic sur la note dans la palette pour percussions.

Éditer le Set de batterie

Clic sur Éditer le set de batterie à gauche de la palette des percussions , ouvre le dialogue
Éditer le set de batterie.

Ou bien, clic droit sur une portée de percussion, puis "Éditer le set de batterie". Sur le coté gauche de
la fenêtre, la liste des codes/notes MIDI, percussion associée et éventuellement leur raccourci clavier.
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Si vous souhaitez saisir une nouvelle note pour percussion à la même position qu'une note existante -
par exemple si vous voulez faire sonner simultanément la caisse claire et la charleston - et que vous
entrez la nouvelle note via le clavier de l'ordinateur, vous aurez besoin de maintenir appuyée la touche
Maj en entrant la nouvelle note afin de ne pas écraser la note existante. C'est la même méthode que
celle utilisée pour saisir les notes d'un accord pour un instrument à sons déterminés.

Sélectionner une ligne dans la colonne de gauche permet d'éditer les propriétés de la note
correspondante :

Nom, qui s'affiche au survol de la note.
Tête de note : Choisissez dans la liste déroulante la tête de note .

Ligne de la portée, ou interligne qui recevra la note :

"0" pour la ligne du haut dans une portée de 5 lignes.
Valeurs négatives, +1 ligne/interligne vers le haut
Valeurs positives, +1 ligne/interligne vers le bas

Direction de la hampe : Auto, vers le haut ou vers le bas.

Voix par défaut : ne concerne pas les notes entrées par un clavier MIDI ou par le clavier de
piano virtuel.
Raccourci clavier : pour entrer la note.

Les sets de batterie sont stockés dans des fichiers .drm, les personnalisations peuvent être
enregistrées dans un fichiers en cliquant Enregistrer, ou chargées avec Charger

Note: Dans MuseScore 2.1, quelques notes des percussion Ténor ne donnent aucun son ; un fichier
DRM pour palier à ce problème peut être téléchargé : MarchingTenorsKeyMap.drm.

Roulement

Pour créer un roulement de tambour, utilisez un Tremolo.
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Liens externes

Tutoriel vidéo : MuseScore en quelques minutes: Leçon 7 - Notation pour Tablature et
percussions
Parties de percussions [vidéo]
Éditer le set de batterie dans MuseScore 1.1 [vidéo]
Enregistrer les changements du set de batterie dans MuseScore 1.1 [video]
Guide de notation pour batterie et percussions

Une question sans réponse ? Postez la sur le forum.

Reprises et sauts
Le début et la fin d'une simple reprise peuvent être définis en utilisant les barres de reprise
appropriées. Pour en savoir plus au sujet des mesures de première et seconde fois, consultez les
Alternatives de reprise.

Lecture

Pour que les répétitions soient prises en compte lors de la lecture, assurez-vous que le bouton "Jouer

les reprises"  soit activé dans la barre d'outils. De même, vous pouvez désactiver les reprises
durant la lecture via ce même bouton.

Dans la dernière mesure de la répétition, vous pouvez définir le nombre de fois que celle-ci est jouée
grâce aux Propriétés de la mesure "Nombre de répétitions".

Symboles et textes de répétition

Les symboles et textes de répétition se trouvent dans la palette Reprises. Cette palette contient les
symboles de répétition de mesure, segno et coda. Elle contient également les textes 'D.S.', 'D.C.', 'To
Coda' et Fine :

Pour ajouter un symbole de reprise à votre partition, utilisez l'une des méthodes suivantes :

Glissez/déposez le symbole depuis la palette dans la mesure désirée (et non au-dessus) (la
mesure change alors de couleur),
Sélectionnez la mesure puis double-clic sur le symbole désiré dans la palette.

Le symbole se placera au-dessus de cette mesure dans la partition.

Sauts

Les sauts comportent en général trois parties :

Aller à étiquette
Jouer jusqu'à étiquette
Continuer à étiquette

Les étiquettes sont les noms que vous donnez à certaines mesures. Deux étiquettes ("Début", "Fin")
indiquent le début et la fin de la partition et n'ont pas besoin d'être ajoutées explicitement. Les
étiquettes que vous ajoutez sont appelées des repères. Les sauts transfèrent la lecture de repères en
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repères.

Repères

Les repères sont les endroits visés par les sauts, de plus, des repères implicites 'Début' et 'Fin' sont
disponibles :

Segno (étiquette : segno)
Signe de variation (étiquette : varsegno)
Coda (étiquette : codab)
Autre coda (étiquette : varcoda)
Fine (étiquette : fine)
Aller à la coda (étiquette : coda)

Exemples

A l'instruction de saut Da Capo, la lecture passe au début (grâce au repère implicite Début) et rejoue
la partition entière (jusqu'au repère implicite Fin).

A l'instruction de saut Da Capo al Fine, la lecture passe au début (grâce au repère implicite Début) et
rejoue la partition jusqu'au repère de fin (étiquette Fine).

L'indication Dal Segno al Fine (ou D.S. al Fine) renvoie au signe (étiquette segno) et rejoue la partition
jusqu'au repère de fin (étiquette Fine).

L'indication Dal Segno al Coda (ou D.S. al Coda) renvoie au signe (étiquette segno) et rejoue jusqu'au
repère Aller à la Coda (étiquette coda). La lecture continue alors à partir du symbole de coda
(étiquette codab).

Les propriétés des sauts (par exemple les noms des étiquettes) peuvent être définies via un clic droit
sur le symbole ou via l'Inspecteur. Les étiquettes des repères peuvent être modifiées uniquement via
l'Inspecteur. Il vous faudra les modifier si vous utilisez plusieurs sauts et repères.

Voir aussi

Alternatives de reprise

Liens externes

MuseScore in Minutes: Repeats and Endings, part 2 (video tutorial)
How to separate a coda from the rest of the score (MuseScore HowTo)

Une question sans réponse ? Postez la sur le forum.

Respirations et pauses
Pour placer un symbole de respiration, faites-le glisser depuis la palette "Respirations et pauses" (à
partir de l'espace de travail Avancé) jusqu'à une note dans la partition. Le symbole de respiration se
place après la note.

Symbole de respiration dans une partition :
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Le symbole de césure fonctionne de la même manière.

Une question sans réponse ? Postez la sur le forum.

Tablature
La musique pour les instruments à cordes frettées est couramment notée en utilisant la tablature,
également désignée par tab, qui fournit une représentation visuelle des cordes et des frettes.

La tablature peut également être combinée avec la notation standard traditionnelle:

Modifier les propriétés de la tablature

Quand une portée tablature est créée dans l'Assistant de création, elle l'est, par défaut, avec l'accord
le plus courant de l'instrument en question — dans le cas d'une guitare, par exemple, cela suppose
l'accord standard de: E2, A2, D3, G3, B3, E4.
Pour modifier l'accord — ou toutes les autres propriétés de la tablature, — faire clic-droit sur la portée
(dans la partition) et sélectionner Propriétés de la portée voir → ci-dessous pour plus de détails.

A partir des Propriétés de la portée vous pouvez accéder aux Propriétés avancées de style, où des
réglages détaillés peuvent être apportés à l'affichage de la tablature.

Créer une nouvelle portée tablature

Avec l'Assistant de création

Utilisez la méthode suivante si vous souhaitez créer une tablature dans une nouvelle partition (pour
les systèmes combinés standard/tablature, voir → ci-dessous):

1. Sélectionner Fichier → Nouveau ou utiliser le raccourciCtrl + N (Mac: Cmd+N) pour ouvrir
l'Assistant de création.

2. Saisir les détails de la partition (optionnel) . Cliquer Suivant.
3. Dans la page Sélectionner le fichier modèle, cliquer sur Choisir Instruments.
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4. Dans la page Instruments, sélectionner une (ou plus) des options de tablature sous "Cordes
pincées" dans la colonne de gauche (voir image ci-dessous). Puis cliquer Ajouter.

5. Compléter le reste de l'Assistant de création.

Note: Vous pouvez utiliser la liste déroulante sous la liste des Instruments pour changer la catégorie
affichée. Alternativement, vous pouvez rechercher un instrument en utilisant le champ "Chercher"
sous la liste des Instruments.

Si la tablature souhaitée n'est pas disponible dans la liste Choisir Instruments :

1. Sélectionner une portée tablature présente dans les "Cordes pincées (à l'étape 4 ci-dessus).
2. Appuyer Ajouter pour la déplacer dans la colonne de droite.
3. Vérifier le menu déroulant à droite de l'instrument nouvellement ajouté pour l'option Tab la plus

appropriée, le cas échéant.
Compléter le reste de l'Assistant de création, et quitter.

4. Modifier le nombre de cordes et de l'accord de la tablature, si besoin, dans les Propriétés de la
portée (voir → ci-dessous).

5. Changer le nom de l'instrument dans les Propriétés de la portée, si nécessaire.

Ceci vous permet de créer une tablature pour tout instrument à cordes frettées
chromatiquement.

Changer le type de portée

Pour convertir une portée standard existante en tablature, ou une tablature en portée standard:

1. Clic-droit sur la portée et sélectionner Propriétés de la portée . Si "Instrument" est déjà réglé
pour un instrument à cordes pincées, quitter les Propriétés de la portée et aller à l'étape 4.

2. Si "Instrument" n'est pas de type cordes pincées, cliquer sur Changer instrument et sélectionner
un instrument approprié depuis "Cordes pincées".

3. Cliquer sur OK deux fois pour quitter les propriétés de la portée.
4. Ouvrir l'édition d'instrument depuis la partition (menu Édition → Instruments... ou touche I)
5. Cliquer sur la portée dans la colonne de droite et changer le "Type de portée" selon l'option

souhaitée.
6. Cliquer OK pour quitter l'édition d'instrument et retourner à la partition.

Note: Si vous avez besoin ensuite de faire des ajustements supplémentaires à la portée (par exemple,
l'accord, le nombre de lignes/cordes etc.), faire clic-droit sur la portée et sélectionner Propriétés de
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la portée.

Version alternative (en utilisant simplement la boîte de dialogue "Propriétés de la portée"):

1. Clic-droit sur la portée et sélectionner Propriétés de la portée .
2. Si l'instrument affiché est dans la catégorie "Cordes pincées", aller à l'étape 4.
3. Si l'instrument affiché n'est pas dans la catégorie "Cordes pincées", cliquer sur Changer

instrument et sélectionner un instrument approprié dans les "Cordes pincées". Cliquer sur OK.
4. Cliquer Propriétés avancées de style, changer "Modèle" pour l'option souhaitée et appuyer <

Restaurer par rapport au modèle.
5. Cliquer OK deux fois pour fermer la boîte de dialogue des Propriétés de la portée.

Note : D'autres ajustements sur la portée (par exemple, l'accord, le nombre de lignes/cordes etc.)
peuvent également être faits dans la boîte de dialogue Propriétés de la portée

Éditer les paramètres des cordes

Dans MuseScore, les portées (standard et tablature) des instruments à cordes pincées sont définies
par défaut selon l'accordage le plus commun. Vous pouvez afficher l'accord en cliquant droit sur une
portée, en sélectionnant Propriétés de la portée , et en appuyant sur Modifier les paramètres des
cordes.

Pour modifier l'accord depuis une portée:

1. Faire clic-droit sur un endroit vide dans une mesure d'une portée dont vous voulez changer
l'accord.

2. Sélectionner Propriétés de la portée

3. Appuyer sur Éditer les paramètres des cordes, en bas de la boîte de dialogue (montré
seulement si l'instrument est défini comme "cordes pincées". Le dialogue Paramètres des
cordes s'ouvre: examiner les paramètres en cours et apporter les modifications nécessaires à
l'aide des boutons Nouvelle corde, Éditer la corde, ou Supprimer la corde.
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Notes : Les cases à cocher dans la colonne Ouvert sont utilisées pour marquer les cordes
individuelles comme toujours ouvertes (non frettées) - comme pour le luth.

Si l'accord est modifié lorsque la tablature pour cet instrument contient déjà quelques notes, les
repères seront ajustés pour produire les mêmes notes avec le nouvel accord (si possible).

Le nombre de frettes (soit les frettes physiques soit les positions "virtuelles") détermine le nombre de
frettes maximum qu'une corde peut recevoir.

Toute modification apportée à l'accord des cordes n'affectera que cet instrument particulier pour cette
partition particulière, et ne modifiera pas les réglages par défaut du programme.

1. Régler le Nombre de frettes si nécessaire.
2. Cliquer OK pour fermer la boîte de dialogue "Editer les paramètres des cordes"
3. Dans le cas d'une portée tablature, cliquer sur Propriétés avancées de style et vérifier que le

nombre de "Lignes" est égal au nombre de cordes. Ajuster si nécessaire. CliquerOK
4. Cliquer OK pour fermer la boîte de dialogue "Editer les Propriétés de la portée/partie"

Combiner les portées standard et tablature

Avec certains instruments - par exemple la guitare, ou autres instruments à cordes -, il est fréquent de
montrer à la fois une portée standard et une portée tablature (TAB). La portée standard affiche la
notation musicale conventionnelle tandis que la tablature associée montre les cordes et les numéros
de frettes correspondant aux notes. Les portées appariées peuvent être soit Liées soit Non liées:

1. Portées liées: Les portées associées sont dites liées si les changements dans une portée sont
immédiatement appliqués à l'autre portée.

2. Portées non liées: Les portées sont dites non liées si elles peuvent être modifiées
indépendamment l'une de l'autre. Utiliser Sélection, puis copier et coller, pour transférer la
musique sur les portées dans les deux sens.

Remarque : Parfois, vous pouvez trouver les repères marqués en rouge dans la tablature. Cela
signifie qu'un repère ne peut pas être affiché car il se heurte à un autre repère existant. Vous pouvez
résoudre ceci en déplaçant et en ajustant les numéros de frettes existants. (voir Édition des notes
existantes).

Créer un système standard/tablature avec l'Assistant "Créer une nouvelle partition"

Si vous voulez créer un nouveau système standard/tablature (lié ou non lié):

1. Sélectionner Fichier → Nouveau ou utiliser le raccourciCtrl+N (Mac: Cmd+N) pour ouvrir l'assistant
Créer une nouvelle partition.

2. Entrer les détails de la partition (optionnel). Cliquer Suivant.
3. Dans la page Sélectionner le fichier modèle, cliquer sur Choisir Instruments.
4. Dans la page Instruments, sélectionner une portée standard dans la section "Cordes pincées"

de la colonne de gauche. Puis cliquer Ajouter.
5. Sélectionner la portée nouvellement créée dans la colonne de droite et choisir l'une des deux
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options:
Cliquer Ajouter une portée liée pour créer un système standard/tablature lié
Cliquer Ajouter une portée pour créer un système standard/tablature non lié

6. Changer le Type de portée tout à droite, si nécessaire (voir aussi "Note 2" ci-dessous).
7. Compléter le reste de l'Assistant de création, ou cliquer Terminer

Note 1: Pour créer des portées non liées avec des canaux de mélangeur séparés, au lieu de "l'Étape
5" (ci-dessus), sélectionner une portée tablature dans la colonne de gauche et cliquer Ajouter.
Ensuite, continuer avec les étapes 6 et 7.

Note 2: Des options d'affichage plus détaillées sont disponibles par un clic-droit sur la portée tablature
et en sélectionnant Propriétés de la portée → Propriétés avancées de style.

Créer un système standard/tablature à partir d'une portée existante

Pour ajouter une tablature à une portée d'un instrument à cordes pincées (ou vice versa):

1. Ouvrir l'éditeur d'instrument (menu → Instruments ou touche I)
2. Sélectionner la portée, que vous souhaitez ajouter, dans la colonne de droite.
3. Choisir l'une des deux options:

Cliquer Ajouter une portée liée pour créer un système standard/tablature lié
Cliquer Ajouter une portée pour créer un système standard/tablature non lié

4. Changer Type de portée tout à droite, si nécessaire (voir aussi "Note 2" ci-dessous).
5. Utiliser Haut pour modifier la position de la portée, si nécessaire.
6. Cliquer OK.

Note 1: Pour créer des portées non liées avec des canaux de mélangeur séparés, au lieu de "l'étape
3" (ci-dessus), sélectionner une portée appropriée dans la colonne de gauche, et cliquer Ajouter.
Puis, continuer avec les étapes 4 et 5.

Note 2: Des options d'affichage plus détaillées sont disponibles en double-cliquant sur la portée
tablature et en sélectionnant Propriétés de la portée → Propriétés avancées de style.

Modifier un système standard/tablature de lié à non lié (ou vice-versa)

(a) Si vous voulez changer dans une partition un système standard/tablature de lié à non lié:

1. Ouvrir l'éditeur d'instrument à partir de la page de la partition (menu Éditer → Instruments ou I
key)

2. Cliquer sur la portée standard dans la colonne de droite, et cliquer Ajouter une portée.
3. Changer le Type de portée (tout à droite) de la portée tablature nouvellement créée pour

l'option correcte. Si le système précédent standard/tablature était vide, passer à l'étape 5. S'il y a
une notation musicale existante dans la partition, passez à l'étape 4.

4. Cliquer OK pour revenir à la partition. Copier et coller toute notation depuis la portée tablature
liée à la portée tablature non liée. Retour à l'éditeur d'instrument.

5. Cliquer sur la portée tablature liée à droite, cliquer sur Retirer puis OK.

(b) Si vous voulez changer un système standard/tablature de non lié à lié:

1. Ouvrir l'éditeur d'instrument depuis la partition (menu Éditer → Instruments ou touche I)
2. Cliquer sur la portée standard dans la colonne de droite, et cliquer Ajouter une portée liée.
3. Modifier le Type de portée (tout à droite) de la portée tablature nouvellement créée pour l'option

correcte.
4. Sélectionner la portée tablature non liée et cliquer Retirer, puis OK.

Saisie de nouvelles notes

Clavier:

Passer en mode de saisie des notes (N): un petit "rectangle bleu" apparaît autour d'une ligne de
la tablature: c'est la corde actuelle
Sélectionner la durée d'une note/d'un silence (voir ci-dessous)
Appuyer ↑ ou ↓ pour sélectionner la corde nécessaire.
Appuyer de 0 à 9 pour saisir un numéro de frette entre 0 et 9 sur la corde actuelle ; pour saisir
des numéros à plusieurs chiffres, appuyer sur chaque chiffre dans l'ordre (le programme de
toute façon refusera d'entrer un nombre plus élevé que la frette maximale définie pour
l'instrument). Les touchesA à L (en sautant le I) peuvent également être utilisées lorsque vous
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travaillez sur une tablature française.
Il est également possible de corriger le numéro de frette avec Maj+Alt+↑ ou Maj+Alt+↓

Souris:

Entrer dans le mode de saisie des notes et sélectionner la valeur de la note (voir ci-dessous)
Cliquer sur une corde pour créer une note à cet endroit
Les notes sont initialement créées sur la frette 0 (ou pour la tablature française): appuyer Maj+↑
plusieurs fois jusqu'à ce que la bonne frette soit atteinte.

MuseScore refuse de placer une seconde note sur une corde qui en contient déjà une; pour cette
raison, il est généralement préférable de remplir les accords de la plus haute corde à la plus basse.

Sélection de la valeur de note en mode de saisie
Lorsque vous êtes en mode d'entrée TAB, les raccourcis par défaut pour la sélection des valeurs de
note de (0 à 9) sont réutilisés pour entrer les numéros de frette. Pour sélectionner la valeur pour les
prochaines notes saisies, quatre méthodes peuvent être utilisées:

Maj+1 à Maj+9 (la disponibilité de ces raccourcis peut dépendre des plate-formes et/ou de la
disposition du clavier)
PavéNum 1 à PavéNum 9 (si un pavé numérique existe et si VerrNum est activé)
la barre d'outils pour la saisie en haut de l'écran
Q pour diminuer la valeur sélectionnée et W pour l'augmenter.

Modification des notes existantes

Hors du mode d'entrée, trois combinaisons de touches peuvent être utilisées pour modifier un repère:

Maj+↑ / ↓ modifie la hauteur de la note. MuseScore sélectionne la corde et la frette: la corde la
plus élevée possible est toujours sélectionnée.
↑ / ↓ modifie la frette haut/bas sans changer la corde (allant de 0 jusqu'au nombre de frettes
défini dans la boîte de dialogue"Éditer les paramètres des cordes" ).
Ctrl+↑ / ↓ déplace la note sélectionnée vers la corde plus haute/plus basse (si la corde est libre
et peut produire cette note).
Maj+X bascule la "dead note" on/off.

Résumé des touches

Mode de saisie des notes

Taper: pour obtenir:

↑ Sélectionne la corde au-dessus de l'actuelle.

↓ Sélectionne la corde en-dessous de
l'actuelle.

Maj+1 to Maj+9 Sélectionne une durée
PavéNum 1 àPavéNum 9 Sélectionne une durée.
Q Diminue la durée d'entrée en vigueur.
W Augmente la durée d'entrée en vigueur.
0 to 9 Saisir un numéro de frette/lettre.
A to K Saisir un numéro de frette/lettre. (I exclu).
Maj+Alt+↑ Augmente le numéro de frette actuel.
Maj+Alt+↓ Diminue le numéro de frette actuel.

Mode normal

Taper: pour obtenir:

Maj+Alt+↑ Augmente la hauteur de la note sélectionnée (MuseScore choisit la
corde).

↑ Augmente la hauteur de la note sans changer de corde.
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Maj+Alt+↓ Abaisse la hauteur de la note sélectionnée (MuseScore choisit la corde).
↓ Abaisse la hauteur de la note sans changer de corde.
Ctrl+↑ Déplace la note à la corde supérieure, en conservant la hauteur.
Ctrl+↓ Déplace la note à la corde inférieure, en conservant la hauteur.
Maj+X Bascule la "dead note" on/off.

Taper: pour obtenir:

Liens externes

Video tutorial: MuseScore in Minutes: Lesson 7 - Tablature and Drum Notation

Une question sans réponse ? Postez la sur le forum.

Transposition
La transposition décale une sélection de notes : vers l'aigu, vers le grave dans une portée.
MuseScore supporte plusieurs types de transposition, incluant les instruments transpositeurs (Voir
plus bas).

Transposition chromatique, par "tonalité"

La transposition chromatique décale les notes vers l'aigu ou le grave par pas d'un demi-ton. Depuis le
menu principal, choisir Notes → Transposer..., sélectionner la tonalité vers laquelle aller, et le chemin
(le plus court, vers le haut ou vers le bas).

Transposition chromatique, par intervalle

La transposition chromatique décale les notes vers l'aigu ou le grave par pas d'un demi-ton. Depuis le
menu principal, choisir Notes → Transposer.... Cocher "par Intervalle", sélectionner l'intervalle à partir
de la fenêtre apparue et si la transposition se fait vers l'aigu ou le grave.
Il est aussi possible de transposer une sélection de notes en utilisant les flèches de déplacement (↑ ou
↓).

Transposition diatonique
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La transposition diatonique décale les notes vers l'aigu ou le grave suivant la tonalité utilisée à partir
de l'armure. Il est possible de décaler une simple note en la faisant glisser vers le haut ou le bas. Il est
aussi possible d'utiliser une sélection de plusieurs notes avec Ctrl + glisser-déposer.

Instruments transpositeurs

Certains instruments comme la trompette en sib ou le saxophone alto sont connus pour être des
instruments transpositeurs. Ces derniers sonnent au-dessus ou en dessous de leurs notes écrites.
MuseScore dispose d'une prise en charge intégrée de ces instruments transpositeurs.

Le bouton de "Tonalité de concert" et Notes → Tonalité de concert depuis le menu principal permet
de passer de la tonalité de concert (sons entendus) à la tonalité transposée (sons écrits et lus par les
instrumentistes).
La tonalité de concert aide les compositeurs et arrangeurs. Elle affiche pour chaque instrument la
même tonalité, et donc les notes écrites correspondent aux notes entendues. Quand le bouton de la
tonalité de concert est désactivé, les notes sur les même portées ne correspondront plus à celles
entendues, mais la partition sera prête pour l'instrumentiste qui doit la jouer. Il ne faudra juste pas
oublier de désactiver le bouton avant l'impression des parties pour les instrumentistes.

Les transpositions instrumentales sont déjà programmées dans MuseScore. Cependant, il existe de
rares instruments dont la transposition n'est pas disponible. Dans ce cas, il suffit d'éditer la
transposition de l'instrument manuellement. Cliquer avec le bouton droit sur une partie vide d'une
portée instrumentale et choisir Propriétés de la portée... .
Sur le bouton de la fenêtre de propriétés de la portée, il faut sélectionner l'intervalle de transposition,
les éventuels changements d'octave, et si l'intervalle se décale vers l'aigu ou le grave.

Voir aussi{#see-also}

How to transpose (non traduit et non traduisible actuellement

Une question sans réponse ? Postez la sur le forum.

Trémolo
Le trémolo est une répétition rapide d'une note, ou une alternance rapide entre deux notes ou plus. Il
est représenté par des traits en travers des hampes des notes. Si le trémolo est entre deux notes ou
plus, les traits sont dessinés entre ces notes. Les symboles de trémolo sont également utilisés pour
noter les roulements de percussions.

La palette "Trémolo" contient des symboles séparés pour des trémolos sur une note (indiqués avec
les hampes) et pour des trémolos sur deux notes (indiqués sans hampes).

Pour ajouter un trémolo sur la hampe d'une seule note, sélectionnez la tête de la note et double-
cliquez sur le symbole souhaité dans la palette "Trémolo".

Pour un trémolo sur deux notes, chaque note a la valeur de la durée totale du trémolo. Pour entrer un
trémolo avec une durée d'une blanche, entrez deux noires, et ensuite ajoutez le symbole de trémolo
sur la première note, les valeurs des deux notes seront automatiquement doublées en blanche.

Une question sans réponse ? Postez la sur le forum.

Voix
L'utilisation des Voix permet de noter sur une seule portée des notes qui commencent en même
temps mais ont une durée différente. Dans d'autres logiciels de notation musicale, cette fonctionnalité
s'appelle "Layers" ou "Couches".

Dans une mesure polyphonique, les notes de la voix 1 ont habituellement les hampes vers le haut et
les notes de la voix 2 ont les hampes vers le bas.
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Quand utiliser des voix?

Si vous souhaitez avoir les hampes dans des directions différentes dans un accord, sur une
même portée.
Si vous devez noter des notes de durée différentes et jouées en même temps sur la même
portée.

Instructions

Commencez par saisir les notes de la voix du haut (hampe(s) vers le haut dans l'image ci-dessous). À
la saisie, certaines notes pourraient apparaître avec les hampes vers le bas, mais elles seront
automatiquement dirigées vers le haut quand la seconde voix sera ajoutée.

Si vous utilisez un clavier (d'ordinateur ou MIDI) pour entrer les notes, utilisez la touche ← pour revenir
au début de la portée ou de la mesure. Si vous utilisez la souris, ce n'est pas nécessaire.

Cliquez sur le bouton "Voix 2"  (sur la droite de la barre d'outils).

Entrez toutes les notes de la voix du bas (hampes vers le bas). Quand vous avez fini, cela devrait
ressembler à :

A noter: Vous devez être en mode saisie de note pour sélectionner une autre voix pour la saisie.

Cacher les silences

Seuls les silences des voix 2, 3 et 4 peuvent être effacés, tandis que ceux de la voix 1 peuvent
seulement être rendus invisibles

Pour cacher un silence, sélectionnez-le et appuyez sur V (pour visible) ou décochez la case "Visible"
dans l'inspecteur, qui peut être activé dans le menu Affichage ou via le raccourci F8 (Mac: fn+F8).

Si vous avez l'option Afficher les éléments invisibles activée dans le menu Affichage, le silence
sera affiché en gris à l'écran mais il n'apparaîtra pas à l'impression ou lors d'un export en PDF, PNG,
SVG, etc.

Intervertir les voix

1. Sélectionnez une ou plusieurs mesures
2. Édition → Voix
3. Intervertir les 2 voix souhaitées

Note: La sélection peut contenir plus de deux voix mais seulement deux des voix seront considérées
par cette commande

Changer une note de voix (without swapping)

Vous pouvez passer les notes d'une voix vers une autre (without note-swapping):
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1. Échap pour être sûr de ne pas être en mode de saisie
2. Sélectionnez une ou plusieurs notes (dans n'importe quelle voix).
3. Cliquez sur l'icône de la voix désirée dans la barre d'outil Saisie de notes, ou utilisez les

raccourcis Ctrl+Alt+1–4.

Note : Pour que le changement de voix soit cohérent, deux conditions :

1. L'accord (ou les accords) dans la voix de destination doit avoir la même durée que la note(s) qui
doit changer de voix.

2. Il doit y avoir suffisamment d'espace de silence (temps) libre dans la voix de destination, pour
insérer la note.

Voir aussi

Têtes de notes partagées

Comment fusionner/combiner deux portées en une seule avec deux voix, en anglais.

Comment faire se chevaucher deux notes à l'unisson

Liens externes

Tutoriel vidéo : Comment écrire deux parties sur une seule portée : Voix

Une question sans réponse ? Postez la sur le forum.

Son et lecture
MuseScore comporte nativement des fonctionnalités de "son et lecture". Ce chapitre aborde les
contrôles de lecture et la manière d'étendre les sonorités d'instruments.

Banques de sons (SoundFonts)

Généralités

Un fichier SoundFont contient les échantillons de nombreux instruments exécutant diverses notes,
permettant ainsi à Musescore de jouer chaque son instrumental.
Certaines SoundFonts sont destinées à la musique classique, d'autres au jazz, à la pop, etc.
Beaucoup de SoundFonts sont disponibles sur le web. Cherchez-en une qui couvre les 128 sons de la
norme Général MIDI (GM).
Si vous utilisez une SoundFont qui ne se conforme pas à la norme Général MIDI, d'autres utilisateurs
de Musescore ne pourront entendre les bons instruments quand vous partagerez la partition. Le
problème sera le même lors de l'exportation d'un fichier MIDI).
MuseScore 0.9.6 à 1.3 utilisaient une SoundFont très simple nommée TimGM6mb.sf2.
MuseScore 2.x embarque FluidR3Mono_GM.sf3, beaucoup plus réaliste.

La taille des fichiers et la qualité des SoundFonts disponibles sur le web sont variables. Le son des
SoundFonts les plus volumineuses est souvent meilleur, mais elles occupent beaucoup de mémoire et
donc ne pas convenir à votre ordinateur. Si après l'installation d'une SoundFont volumineuse,
Musescore tourne trop lentement, ou que votre ordinateur est instable pendant la lecture d'une
partition, installez une SoundFont plus légère.

Une fois une SoundFont installée, (voir installer), vous pouvez l'utiliser pour la lecture d'une partition
par Musescore en contrôlant divers aspects de la sortie son avec le Synthésiseur. Pour afficher le
Synthétiseur, aller au menu Affichage → Synthétiseur.

Installer une SoundFont

Après téléchargement et décompression d'une SoundFont (voir→ci-dessous), double-cliquez sur le
fichier pour l'ouvrir. Dans la majorité des cas, le type de fichier SoundFont sera déjà associé à
MuseScore qui démarrera; une boîte de dialogue apparaîtra demandant si vous voulez installer la
SounFont.
Parfois un programme autre que MuseScore est associé au type de fichier SoundFont; dans ce cas,
faites un double-clic ou control-clic sur le fichier, pour afficher un menu dans lequel vous pourrez
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choisir d'ouvrir le fichier dans Musescore. Quand la boîte de dialogue vous demande si vous voulez
installer la SoundFont, cliquez "Oui" pour placer une copie du fichier SoundFont dans le dossier
SoundFonts de MuseScore.
Ce dossier peut être vu et modifié dans les Préférences de MuseScore, mais sa localisation par
défaut est :

Windows : %HOMEPATH%\Documents\MuseScore2\Soundfonts

Mac OS X and Linux : ~/Documents/MuseScore2/Soundfonts

Contrairement aux SoudFonts ajoutées par l'utilisateur, la SoundFont installée par défaut avec
MuseScore est placée dans un dossier système, destiné uniquement à cet usage et qui ne doit pas
être modifié.
Localisation du dossier par défaut de la SoudFont :

Windows (32-bit) : %ProgramFiles%\MuseScore 2\sound\FluidR3Mono_GM.sf3

Windows (64-bit) : %ProgramFiles(x86)%\MuseScore 2\sound\FluidR3Mono_GM.sf3

Mac OS X : /Applications/MuseScore 2.app/Contents/Resources/sound/FluidR3Mono_GM.sf3

Linux (Ubuntu) : usr/share/sounds/sf2/FluidR3Mono_GM.sf3

Désinstaller une SoundFont

Pour désinstaller une SoudFont, il suffit d'ouvrir le dossier où elle se trouve puis effacer le fichier.

Synthétiseur

Le Synthétiseur est le panneau principal de Musescore pour le contrôle de la sortie son. Une fois une
SoundFont installée voir au-dessus, elle doit être chargée dans le Synthétiseur afin que MuseScore
l'utilise pour la lecture.
Pour qu'une autre SoudFont soit chargée par défaut au démarrage de MuseScore, il faut la charger
dans le Synthétiseur et cliquez Définir comme valeur par défaut .
La procédure de chargement est détaillée dans l'onglet Zerberus.

Pour afficher le Synthétiseur, aller au menu . Affichage → Synthétiseur.

Listes de SoundFonts

Quelques SoundFonts GM de tailles variées :

Fluid R3 GM (141 MB décompressée)
Licence : sous licence MIT (inclue dans l'archive).
La SoundFont par défaut de MuseScore est basée sur Fluid R3.
GeneralUser GS (29.8 MB décompressée)
Avec l'autorisation de S. Christian Collins
Magic Sound Font, version 2.0 (67.8 MB décompressée)
Arachno SoundFont, version 1.0 (148MB décompressée)
Avec l'autorisation de Maxime Abbey
MuseScore 1 came with TimGM6mb (5.7 MB décompressée)
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Licence : GNU GPL, version 2
Avec l'autorisation de Tim Brechbill
MuseScore 2 contient FluidR3Mono_GM.sf3 (12.6 MB).
Licence : Licence MIT
Timbres of Heaven, version 3.2 (369 MB décompressée)
Avec l'autorisation de Don Allen

En plus des fichiers SoundFont, MuseScore supporte le format SFZ , grâce au nouveau synthétiseur
Zerberus (voir détails), dont suivent quelques banques :

Sonatina Symphonic Orchestra (503 MB décompressée)
Téléchargements : SoundFont | SFZ format
Licence : Creative Commons Sampling Plus 1.0
Salamander Grand Piano, version 3 (between 80 MB and 1.9 GB décompressée)
Licence : Creative Commons Attribution 3.0
Salamander Grand Piano, version 2 (between 80 MB and 1.9 GB décompressée)
Licence : Creative Commons Attribution 3.0
Piano désaccordé (244 MB décompressée)
Licence : Creative Commons Attribution-ShareAlike 3.0
Cordes de piano pincées (168 MB décompressée)
Licence : Creative Commons Attribution-ShareAlike 3.0

SoundFonts spécialisées

Acoustic grand piano, release 2008-09-10 (132 MB décompressée)
Description : Yamaha Disklavier Pro piano, sf2 format, 116 samples, 44100Hz, 16bit
Plus d'informations : http://zenvoid.org/audio/
Licence : Creative Commons Attribution 3.0
Avec l'autorisation de Roberto Gordo Saez
Acoustic grand piano, old version (37.5 MB décompressée)
Description : Steinway & Sons, sf2 format, 13 samples, stereo, 44100Hz, 16bit (based on the
University of Iowa Musical Instrument Samples)
Plus d'informations : http://zenvoid.org/audio/
Licence : Domaine public
Avec l'autorisation de Roberto Gordo Saez

Note : En raison de la taille croissante des SoundFonts, celles-ci sont souvent compressées dans
différents formats : .zip, .sfArk, et .tar.gz. Il faut donc décompresser ces fichiers avant de pouvoir les
utiliser.

ZIP est un format standard de compression supporté par de nombreux systèmes d'exploitation.
sfArk est un format de compression destiné spécialement à la compression des fichiers
SoundFont. Il faut utiliser le programme spécial sfArk software.
tar.gz est un format populaire de compression pour Linux. Les utilisateurs de Windows peuvent
se servir de 7-Zip ; les utilisateurs de Mac utiliseront Unarchiver, ou l'utilitaire d'archives intégré
sur Mac OS X.
Noter qu'en utilisant 7-Zip, il faudra appliquer la décompression deux fois—une fois pour GZip
une fois pour TAR.

Résolution des problèmes

Si le panneau d’outils de lecture est grisé ou invisible, suivre les instructions ci-dessous pour obtenir le
fonctionnement de la reproduction.

Faire un clic droit sur la barre de menu et vérifiez que la case Outils du lecteur  dans le menu
est cochée.
Si cette action ne résoud pas le problème voir ci-dessous.
Si l'outil du lecteur disparaît à la suite d'un changement de SoundFont aller dans Édition →
Préférences... → onglet I/O et cliquer OK sans rien changer.
Après un redémarrage de MuseScore, l'outil du lecteur doit réapparaître.

Si vous configurez une SoundFont pour la 1ère fois, choisissez de préférence une des SoundFonts
recommandées ci-dessus.

Si la lecture bégaie, c'est que votre ordinateur ne peut supporter la SoundFont utilisée ; deux solutions
:
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1. Utiliser une SoundFont plus légère, moins gourmande en RAM. Voir plus bas la liste des
suggestions.

2. Fermer des applications non nécessaires, pour augmenter la quantité de RAM disponible pour
MuseScore. Si le problème persiste et qu'une SoundFont importante est primordiale pour vous,
envisagez d'installer plus de RAM dans votre ordinateur.

Voir aussi

Synthétiseur
Changer et ajuster le son (Mélangeur)

Liens externes

Comment changer de SoundFont ou en ajouter une autre

Synthé-fr.png
Une question sans réponse ? Postez la sur le forum.

Changement d'instrument en cours de portée
Le texte de changement d'instrument (visible en tant que "Instrument" dans la palette texte) peut être
utilisé pour indiquer un changement d'instrument qui joue sur une portée spécifique, et ce changement
sera aussi audible dans la lecture. Seule limitation actuelle : la transposition n'est pas prise en
compte.

Insérer un changement d'instrument en cours de portée

1. Sélectionner le point de départ du changement

2. Appliquer "Instrument" depuis la palette de texte

3. Double-cliquer sur le texte nouvellement ajouté pour l'éditer

Remarquez que le texte est aussi éditable.

ou éditer les propriétés du texte via un clic droit après avoir quitté le mode d'édition du texte (le texte
doit apparaitre en noir et non en bleu foncé), ou appliquer un style de texte (qui sera valable pour
l'ensemble des textes de changement d'instrument)

1. Clic droit sur le texte et choisir "Changement d'instrument..."
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2. Choisir l'instrument et cliquer sur ok

Voir aussi

Changement d'instrument (Mélangeur)
Changement de son au cours de la portée (Mélangeur)

Une question sans réponse ? Postez la sur le forum.

Importation MIDI
Le panneau d'importation MIDI apparait chaque fois qu'un fichier .mid ou .midi ou .kar est ouvert dans
MuseScore. Dans ce panneau, l'utilisateur peut avoir un meilleur contrôle de l'importation MIDI en
sélectionnant les portées et en leur appliquant des réglages (quantification, usage de notes pointées
ou liées, etc.). Le bouton "Appliquer" en haut du panneau applique les changements immédiatement.
Le bouton "Annuler" annule tous les changements qui n'ont pas été sauvegardés.
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Utilisez Maj+molette ou Ctrl+molette pour faire défiler horizontalement ou verticalement les options
sans les modifier.

Ce qui donnera ainsi un résultat proche de la partition attendue.

Le panneau d'importation MIDI montre une liste de portées (seules les portées qui contiennent des
notes sont affichées) et les opération possibles sur chaque portée.

S'il y a plusieurs portées, une ligne supplémentaire en haut de la liste permet de sélectionner toutes
les portées en même temps.

Dans le panneau, il est possible de choisir les portées à importer et de changer leur ordre d'apparition.
Plusieurs indications sont indiquées (Nom de la portée, son, paroles - s'il y en a). La présence d'une
colonne paroles indique que le fichier comporte une piste de paroles, assignable aux différentes
portées.

Les opérations sont présentées en colonnes. En haut, le nom de l'opération et en face de chaque
portée une valeur. Chaque valeur est modifiable. Elle peut prendre la forme d'un choix dans une liste
ou d'une case à cocher. Les opérations peuvent avoir des valeurs différentes suivant les portées, en
particulier entre portées de notes et portées de rythmes.

Le panneau d'importation MIDI est utilisable sur n'importe quel fichier midi affiché, si vous en avez
plusieurs ouverts en même temps. Pour le fermer, cliquez sur le bouton de fermeture en haut à
gauche du tableau. Une boite de dialogue "Afficher le panneau d'importation MIDI" apparait alors et
vous permet de le faire réapparaitre si besoin.

Opérations possibles

Instrument MuseScore
Assigne un instrument MuseScore (listé dans instruments.xml ou dans un fichier xml spécifique
dans Préférences) Cela détermine le nom de la portée, la clé, la transposition, l'articulation, etc.

Quantification
Quantifie les notes MIDI à l'aide d'une grille régulière. La résolution maximum de la grille peut
être choisie via le menu.
* Valeur par défaut - La valeur par défaut de la quantification se fixe dans le menu
MuseScore>Préférences, onglet import.
* Valeurs possibles : noire, croche, double croche, triple croche, quadruple croche et quintuple
croche. La grille de quantification est adaptable et se réduit quand la longueur des notes
diminue.

Nombre de voix maximum
Défini le nombre maximum de voix autorisées.

Divisions irrégulières
Cette option permet de détecter les divisions irrégulières (n-olets) et applique la grille de
qualification correspondante.

Est joué par un être humain
Cette option réduit la précision de la conversion Midi - Partition pour plus de lisibilité. Elle est
utile pour les fichiers MIDI incohérents, quand aucune grille de quantification n'est utilisable.
Pour ces fichiers, l'algorithme de recherche de pulsation est utilisé pour tenter de détecter la
position des barres de mesure.

Compter deux fois moins de mesures
Cette option est active pour les fichiers MIDI incohérents (quand "Est joué par un être humain"
est coché par défaut). Il réduit de moitié le décompte de mesures obtenu par la détection de
pulsation. Elle peut être utile quand on obtient deux fois plus de barres de mesure que prévu.

Indication de mesure
Cette option est active pour les fichiers MIDI incohérents. Vous pouvez choisir l'indication de
mesure appropriée si celle détectée par défaut est erronée. L'importation des divisions
irrégulières (n-olets) se fera correctement, ce qui ne sera pas le cas en modifiant l'indication
depuis la palette.

Scinder la portée
Cette option concerne principalement les portées de piano, pour affecter les notes à la main
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droite ou à la main gauche. Elle utilise soit une note fixe de partage que vous pouvez choisir
dans un sous-menu, soit une note flottante (celle ci dépend de la taille de la main - elle est
estimée par le programme)
Pour les portées de percussion (son de Percussion dans la liste des voix), l'option scinde en
autant de portées que d'instruments différents. Il existe une sous-option pour autoriser/interdire
l'application de parenthèses pour les ensembles de percussions ainsi créés.

Changement de clé
Des changements de clé peuvent être insérés pour garder les notes proches de la portée. Les
changements de clé dépendent de la hauteur moyenne des notes. Les clés insérées ne cassent
pas les ligatures de croches (si cela arrive, merci de déclarer le bug avec importmidi_clef.cpp).
Cette option n'est pas valable pour les portées de rythme.

Simplifier les durées
Regroupe les mesures de silence pour simplifier la partition. Pour les portées rythmiques, cette
option affecte les silences, mais également les notes tenues.

Afficher les staccatos
Pour montrer/cacher les indications de staccatos.

Notes pointées
Contrôle si MuseScore utilise des notes pointées ou liées.

Afficher le texte de tempo
Montre/cache l'indication de tempo de la partition.

Afficher le texte des accords
Montre/cache le nom des accords dans la partition (concerne les fichiers XF MIDI).

Reconnaitre l'anacrouse
Cette option permet de faire comprendre à MuseScore que si la première mesure est plus
courte, elle a tout de même la même indication de mesure que le reste de la partition. Cette
option n'est valable que pour l'ensemble des portées.

Détecter le swing
MuseScore essaye de détecter le swing pour remplacer le triolet [noire croche] par deux croches
simples pour le swing simple et [croche pointée - double croche ] par deux croches simples
également pour le swing shuffle. L'indication "Swing" ou "Shuffle" est alors indiquée au début de
la portée modifiée.

Une question sans réponse ? Postez la sur le forum.

Modes de lecture
MuseScore dispose d'un séquenceur intégré et d'un synthétiseur pour jouer votre partition. Les
fonctions basiques de lecture sont accessibles à partir de la barre d'outils (au-dessus de la fenêtre
principale) :

En appuyant sur le bouton Lecture  (ou Espace), vous activez la lecture. Dans ce Mode de
lecture les commandes suivantes sont disponibles :

Revient à l'accord précédent ←
Avance à l'accord suivant →
Revient au début de la mesure précédente Ctrl+← (Mac : Cmd+←)
Avance au début de la mesure suivante Ctrl+→ (Mac : Cmd+→)
Revient au début de la partition Home (Mac : ⌘+Home)
Afficher/masquer la Fenêtre de lecture F11 (Mac : ⌥+⌘+P)

Pressez une nouvelle fois le bouton de lecture (ou Espace) pour arrêter et sortir du Mode de lecture.

Musescore démarre l'interprétation depuis l'endroit où il s'est arrêté. Pour lancer la lecture depuis une
note (ou une mesure) spécifique, cliquez sur cette note (ou cette mesure) avant d'activer le mode de
lecture. Par ailleurs, si l'interprétation est déjà lancée, vous pouvez passer à une note spécifique en
cliquant dessus. La barre d'outils comporte un bouton de retour au début pour revenir rapidement au
début de la partition.

Pour inclure l'interprétation des reprises, activez le bouton Jouer les reprises .

Fenêtre de lecture
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F11 ouvre la fenêtre de lecture ou Affichage → Fenêtre de lecture .

La fenêtre de lecture offre la possibilité de contrôler temporairement l'interprétation, avec la vitesse de
lecture (appelée 'tempo'), les fonctions de boucles de lecture (avec des positions spécifiques de début
et de fin) et le volume général de la session.

A noter : Les changements apportés à ces paramètres dans la Fenêtre de lecture ne sont pas
enregistrés dans le fichier de la partition, même si vous cliquez sur Enregistrer. Ces changements
n'affectent que le comportement de la lecture durant la session courante. Si vous souhaitez modifier le
tempo de la pièce, vous devez utiliser le paramètre de texte de tempo dans l'Inspecteur (F8) ou via
une Indication de Tempo. Si vous souhaitez réinitialiser le volume par défaut de la lecture, vous
pouvez le faire à partir du menu Affichage → .Synthétiseur.

Décompte

Vous avez la possibilité d'activer un décompte qui sera joué à chaque fois que l'interprétation
démarrera. Le décompte fait entendre les temps d'une mesure complète (en fonction de l'indication de
mesure au point de départ de la lecture). Si le point de départ se situe au milieu d'une mesure ou sur
une mesure 'incomplète' (anacrouse), le décompte joue autant de temps qu'il faut pour compléter
cette mesure. L'icône du chef d'orchestre dans la Fenêtre de lecture active ou désactive ce décompte.

Métronome

Vous pouvez également activer ou non le métronome durant l'interprétation de la partition (voir l'icône
métronome dans la Fenêtre de lecture).

Boucle

Il est possible de jouer en boucle un passage sélectionné de la partition en utilisant soit la barre
d'outils soit la Fenêtre de lecture.

Définir une boucle à partir de la barre d'outils :

Stoppez la lecture et activez le bouton "Lecture en boucle".
Sélectionnez le passage que vous souhaitez jouer en boucle.
Pressez le bouton de lecture.

L'interprétation jouera en boucle le passage indiqué par les repères bleus gauche et droit.

Utilisez le bouton "Lecture en boucle" pour activer ou désactiver la boucle.

Définir une boucle à partir de la Fenêtre de lecture :

Sélectionnez la note à partir de laquelle commencera la boucle et cliquez sur le bouton "Définir
la position initiale de la boucle". Le bouton "Lecture en boucle" devient actif.
Sélectionnez la dernière note qui doit être incluse dans la boucle et cliquez sur le bouton "Définir
la position finale de la boucle".
Pressez le bouton de lecture.

108



L'interprétation jouera en boucle le passage indiqué par les repères bleus gauche et droit.

Utilisez le bouton "Lecture en boucle" pour activer ou désactiver la boucle.

Une question sans réponse ? Postez la sur le forum.

Mélangeur
Le Mélangeur permet pour chaque portée de changer le son d'instrument, et d'ajuster volume,
panoramique réverbération et chorus. Dans le menu de Musescore, pour afficher le mélangeur,
choisissez
Affichage → Mélangeur ou tapez F10 (Mac: fn+F10)

Muet et Solo

Utiliser la case à cocher Muet pour rendre muettes certaines portées. A l'inverse, utiliser la case à
cocher Solo pour réduire au silence toutes les portées, à l'exception de la portée cochée "solo".

Contrôleurs

Pour faire tourner un contrôleur dans le sens horaire, cliquer dessus, maintenir le clic enfoncé, et
mouvoir la souris vers le haut.
Vous pouvez aussi placer le pointeur de la souris sur le contrôleur et bouger la roulette de la souris.

Un double-clic sur un contrôleur restaure sa valeur par défaut.

Sons - Instruments

La liste déroulante des sons affiche chaque instrument proposé par la SoundFont chargée dans le
Synthétiseur. Si vous avez chargé plusieurs SoundFonts, tous les sons de chaque SoundFont
apparaissent dans une seule longue liste— les sons proposés par la seconde SoundFont se trouvant
après ceux de la première SoundFont, et ainsi de suite.

Changement de son en cours de portée (pizz., con sordino, etc.)
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Certains instruments proposent, dans le Mélangeur, plusieurs canaux qui peuvent être utilisés pour
modifier le son au cours d'une partition. Par exemple, les cordes peuvent utiliser pizzicato ou tremolo,
et la trompette peut basculer vers la trompette avec sourdine.

Les instructions suivantes valent pour le pizzicato des cordes, mais le même principe s'applique au
tremolo des cordes ou la sourdine de la trompette.

1. Sélectionner la 1ère note de la section qui doit être jouée en pizzicato
2. dans le menu principal, choisissez Ajouter → Texte → Texte de portée; vous pouvez aussi

sélectionner la note et taper 'Ctrl+T'
3. Taper pizz. A ce moment, ce texte n'est qu'une indication visuelle et n'est pas appliqué durant

la lecture.
4. Cliquez-droit sur ce texte de portée et sélectionnez Propriétés du texte de portée
5. A la gauche de la boîte de dialogue Propriétés du texte de portée  , sélectionnez une ou

plusieurs voix (dans l'onglet 'Changer de canal')

6. Dans la liste déroulante, sélectionnez pizzicato.

7. Cliquer OK pour revenir à la partition.

Toutes les notes suivant ce texte de portée seront jouées pizzicato. Pour revenir au son de cordes
normal, plus tard dans la pièce, suivez de nouveau les instructions ci-dessus en tapant Arco dans
l'étape 3 et sélectionnez Normal à l'étape 6.

Voir aussi

SoundFont
Synthétiseur
Changer d'instrument
How to change instrument sound (e.g. pizz., con sordino) midway through score

Mélangeur1-fr.png
TextePorteeProprietes-1.png

Une question sans réponse ? Postez la sur le forum.

Swing
MuseScore est capable de jouer la partition en utilisant des croches ou des doubles croches
"swinguées".

Mettre en place le swing

Pour informer MuseScore (et les humains qui liront la partition) que la musique notée doit swinguer, il
est préférable de créer un texte de système Swing.

110

https://musescore.org/en/node/50196
https://musescore.org/sites/musescore.org/files/M�langeur1-fr_3.png
https://musescore.org/sites/musescore.org/files/TextePorteeProprietes-1.png
https://musescore.org/fr/forum


1. Cliquez sur une note

2. Double cliquez Swing dans la palette Texte

Le texte Swing peut être édité, comme tous les autres textes d'une partition, en double cliquant
dessus (Voir Édition d'un texte), et on peut aussi le rendre invisible en utilisant l'Inspecteur.

Retour à un rythme binaire{#swing-off}

Si votre partition contient des sections swing et des sections "binaires" ou "straight", et vous souhaitez
que MuseScore joue ceci correctement:

1. Insérez un texte Swing comme expliqué précédemment, attaché à la première note ou silence
de la section binaire.

2. Changez le texte comme vous le souhaitez — double cliquez sur le texte que vous venez
d'insérer et changer le par exemple pour "Straight" (Voir Édition d'un texte).

3. Pour supprimer l'effet de swing, faites un clic droit → Propriétés du texte de système… →
Paramètres du Swing → décocher la case

Paramètres du Swing

Paramètres du texte de Swing

Les paramètres du swing pour chaque texte Swing sont disponibles via clic droit → Propriétés du
texte de système… → Paramètres du Swing. On peut définir la "force du balancement", c'est-à-dire le
ratio entre les deux croches (50% pour du binaire, 75% pour du "shuffle") et choisir si ce sont les
croches ou les doubles croches qui sont swinguées. Si on choisit "doubles croches", il est préférable
de l'indiquer aussi dans le texte pour un éventuel lecteur humain de la partition.

Réglage global du swing

Par défaut, en l'absence d'un texte Swing dans la partition, la lecture est binaire. On peut toutefois
avoir une lecture en swing sans ajouter un texte en utilisant le style général de la partition dans Style
→ Général... → Partition.

Une question sans réponse ? Postez la sur le forum.

Synthétiseur

Généralités

Le Synthétiseur est le panneau principal de contrôle de la sortie son dans MuseScore . Entre autres
choses, il permet de charger des SoundFonts contenant différents instruments utilisés pour la lecture,
de contrôler les niveaux de l'égalisation et du volume, et de changer d'autres aspects de la sortie du
son.

Pour afficher le Synthétiseur, allez au menu Affichage → Synthétiseur.

Un seul jeu de paramètres du Synthétiseur peut être actif à la fois —par exemple, si plusieurs
partitions sont ouvertes en même temps, il est impossible de faire des modifications dans le
Synthétiseur pour une partition en conservant les paramètres des autres partitions inchangés.
De plus, les modifications des paramètres du Synthétiseur s'appliquent seulement à la session
en cours —à l'ouverture suivante de MuseScore, le Synthétiseur reprendra les paramètres par
défaut. Ces valeurs par défaut peuvent cependant être modifiées à tout moment.
Pour cela, cliquez sur le bouton Définir comme valeur par défaut  du Synthétiseur pour que les
paramètres actifs dans la session en cours deviennent les valeurs par défaut pour les sessions
suivantes.
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Il est aussi possible d'enregistrer ces paramètres dans une partition précise et de rappeler ces valeurs
plus tard. Pour ce faire, utilisez les boutons Enregistrer dans la partition et Charger depuis la
partition.
Les paramètres du Synthétiseur enregistrés dans une partition ne sont pas rappelés
automatiquement à la réouverture de cette partition ;
il est nécessaire d'indiquer manuellement avec le bouton Charger depuis la partition  que les
valeurs doivent être rechargées

Les modifications effectuées dans le Synthétiseur ne seront audibles dans les fichiers audio
que si les paramètres du Synthétiseur ont été sauvegardés dans la partition avec le bouton
Enregistrer dans la partition .

Ces options seront détaillées plus précisément dans l'exemple de Réglage du diapason (ci-dessous).

Banque de sons (SoundFont)

Une SoundFont est un fichier contenant un ensemble de sons que MuseScore peut utiliser pour la
lecture. MuseScore embarque une SoundFont nommée FluidR3Mono_GM.sf3; d'autres SoundFonts
peuvent être téléchargées depuis internet (voir listes de SoundFonts). Une fois qu'une SoundFont a
été installée, vous pouvez la sélectionner et l’utiliser pour la lecture et contrôler avec le Synthétiseur
différents paramètres de la sortie son.

Onglet Fluid

La SoundFont FluidR3Mono_GM.sf3 est chargée par défaut dans le Synthétiseur:

Charger une soundfont

Pour utiliser une SoundFont lors de la lecture, elle doit d'abord avoir été installée (à faire une
seule fois) puis chargée dans le Synthétiseur (ce qui peut être fait au cas par cas, ou de manière
permanente).

Cliquer sur le bouton Ajouter pour charger une autre SoundFont installée dans le dossier
SoundFonts.
Voir l'image d'exemple dans l'onglet Zerberus (ci-dessous).

Une SoundFont peut être effacée de la liste du Synthétiseur en la sélectionnant dans la liste et en
cliquant sur le bouton Supprimer. Notez bien qu'elle ne sera pas désinstallée, et restera disponible
dans le dossier SoudFonts de Musescore.

Si plusieurs SoundFonts ont été chargées, leurs places dans la liste peuvent être modifiées en
cliquant sur les boutons avec flèche Monter et Descendre. Cet ordre dans la liste détermina l'ordre dans
lequel les instruments apparaîtront dans les listes de choix d'instruments du Mélangeur

Si vous n'avez changé aucun son dans le Mélangeur, c'est la SoundFont du début de la liste qui sera
utilisée lors de la lecture.
Si, dans une partition que vous ré-ouvrez, vous avez réglé le Mélangeur pour affecter aux différents
instruments des sons issus de SoudFonts différentes, la lecture ne se fera correctement que si les
mêmes SoundFonts se trouvent dans le même ordre dans le Synthétiseur.
Donc si vous utilisez plusieurs SoundFonts, il est indiqué de cliquer sur le bouton Enregistrer dans la
partition du Synthétiseur; ainsi, à la prochaine ouverture de la partition vous pourrez rappeler la liste
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des SoundFonts chargées (ainsi que d'autres paramètres du Synthétiseur) en cliquant sur Charger
depuis la partition .

Vous avez aussi la possibilité d'utiliser le bouton Définir comme valeur par défaut  pour modifier les
paramètres par défaut du Synthétiseur ; ainsi, la prochaine fois, vous n'aurez pas à charger les
paramètres depuis la partition . Faute de profiter de cette possibilité le Synthétiseur reviendra à ses
réglages d'origine lors de la prochaine session de MuseScore.

Onglet Zerberus

Les SoundFonts de type SFZ peuvent être indifféremment installées dans les dossiers Soundfonts ou
SFZ du dossier Musescore 2 dans Documents.
Par contre elles seront chargées spécifiquement dans l'onglet Zerberus du synthétiseur.
Allez au menu Affichage → Synthétiseur, pour afficher le Synthétiseur.
Cliquez sur l'onglet Zerberus puis cliquez sur le bouton Ajouter
Dans la fenêtre qui apparaît alors, vous pouvez choisir les SoundFonts à charger.

Attention :
1) l'onglet Zerberus ne dispose pas des boutons permettant de modifier la place d'une SoundFont
dans la liste. Il faut donc prévoir au départ l'ordre dans lequel les instruments apparaîtront dans les
listes de choix d'instruments du Mélangeur.
2) au chargement, l'affichage se fait dans l'ordre chronologique inverse; la dernière chargée en tête de
liste. Mais à la réouverture du Synthétiseur, l'ordre chronologique est rétabli, et sera celui des listes du
Mélangeur
3) dans le Mélangeur les SoundFonts de type SFZ seront toujours placées après celles de type sf2
ou3
4) une Soudfont Sfz est constituée d'une liste d'instrument et d'un dossier contenant les
échantillons (samples). Ces 2 éléments doivent donc se trouver dans le dossier choisi pour
l'installation. Le plus simple est de placer le fichier téléchargé et à décompresser dans le dossier Sfz
de Musescore2 dans Documents et de décompresser.

Volume

Deux curseurs se trouvent dans la partie droite de la fenêtre du Synthétiseur. L'un contrôle le volume
lors de la lecture, l’autre le volume du son du métronome intégré. Vous pouvez activer ou arrêter ce
métronome en cliquant sur le bouton situé sous son curseur de volume.
Comme pour tous les autres paramètres du Synthétiseur, toute modification faite ici est temporaire,
sauf si elle est enregistré dans la partition ou sauvée comme valeur par défaut.
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Onglet Effets Principaux

L'onglet Effets principaux héberge l'unité de réverbération stéréo Zita 1 et le compresseur stéréo
SC4. Deux zones sont à disposition, "Effet A" et "Effet B," , toutes deux avec une liste déroulante
d'effets disponibles – incluant l'option de régler l'un ou l'autre canal sur "No Effect."

Pour stocker une configuration des effets comme option par défaut pour le Synthétiseur, cliquer sur le
boutonDéfinir comme valeur par défaut . Si par la suite, vous modifiez les paramètres des effets,
vous pourrez restaurer ces valeurs par défaut en cliquant sur le bouton Charger les valeurs par
défaut.

Vous pouvez stocker une configuration particulières des effets dans une partition en cliquant sur le
bouton Enregistrer dans la partition , et plus tard charger ces paramètres depuis la partition en
cliquant sur le bouton

Charger depuis la partition .

Onglet Zita 1

Le module de réverb. stréo Zita 1 permet de simuler l'ambiance d'une salle quelconque, depuis le petit
studio jusqu'au grand hall. Pré-délai, durée et tonalité de la réverb. peuvent être finement ajustés au
moyen des contrôleurs fournis :

Delay: règle le pré-delai de la réverb. de 20 à 100 ms.
Low RT60 (Durée de la réverb. pour les fréquences graves): Avec le contrôleur gris, ajuster la
fréquence centrale pour la bande des fréquences graves (50–1000 Hz) à laquelle appliquer la réverb.:
le contrôleur vert permet d'ajuster la durée de la réverb. (1–8 secs) de cette bande de fréquence.
Mid règle la durée de la réverb. (1–8 secs) de la bande des frèquences moyennes.
HF Damping: ajuste la composante hautes fréquences de la réverb. Augmenter cette valeur
augmente la fréquence du point de coupure et rend la réverb. plus brillante et plus longue.
EQ1: permet de couper ou renforcer (-15 to +15) une bande de fréquence (de 40 Hz à 2 KHz) dans la
partie basse du spectre.
EQ2: permet de couper ou renforcer (-15 to +15) une bande de fréquence (de 160 Hz à 10 KHz) dans
la partie haute du spectre.
Output: Contrôle la quantité de réverb. appliquée à la sortie. "Dry" = pas de réverb. (son direct). "Wet"
indique100% de réverb. "Mix" = son de sortie composé à parts égales du son direct et du son
réverbéré.

Note. EQ1 et EQ2 affectent seulement la réverb., pas le signal non traité.

Pour configurer rapidement un effet, réglez "Output" sur "Mix" et ajustez la durée de la réverb avec le
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contrôleur "Mid RT60". Puis affiner les réglages comme indiqué ci-dessus.

Onglet Réglage du diapason

Pour les instruments "accordés" , MuseScore utilise par défaut le LA = 440 Hz. Pour changer cette
valeur, entrez-en simplement une nouvelle dans l'onglet Réglage du diapason.

Comme tous les autres paramètres du Synthétiseur, ce réglage affecte la lecture d'une partition, mais
il n'a pas d'effet sur les fichiers audio exportés (WAV, OGG, MP3), sauf si l'option Enregistrer
dans la partition a été sélectionnée.

Changer la fréquence du diapason

Note: agit sur toutes les partitions en cours, et seulement pendant la session en cours (ce réglage
revient à la valeur par défaut à la fermeture de MuseScore).
Affecte la lecture d'une partition, mais n'a pas d'effet sur les fichiers audio exportés (WAV, OGG,
MP3)

1. Affichage → Synthétiseur.
2. Cliquer l'onglet Réglage du diapason
3. Entrer une nouvelle valeur de la Fréquence du diapason (Minimum = 300 Hz; Maximum = 600.0

Hz; par défaut = 440 Hz).
4. Cliquer sur le bouton Changer la fréquence du diapason .

Régler la fréquence par défaut

Note: agit sur toutes les partitions en cours, pendant la session en cours et les sessions suivantes
(jusqu'à une nouvelle modification). Affecte la lecture d'une partition, mais n'a pas d'effet sur les
fichiers audio exportés (WAV, OGG, MP3 et MIDI).

1. Changer la Fréquence du diapason comme montré ci-dessus pour la version en cours.
2. Cliquer sur le bouton Définir comme valeur par défaut .

Changer la Fréquence du diapason pour une seule partition

Note: agit sur la partition et que dans la session en cours; utilise le bouton Enregistrer dans la
partition; le réglage sera rechargés lors de la nouvelle ouverture de la partition, dans une session
suivante, au moyen du bouton Charger depuis la partition .
Affecte la lecture et les fichiers audio exportés (WAV, OGG, MP3).

1. Changer la Fréquence du diapason comme montré ci-dessus pour la session en cours.
2. Cliquer Enregistrer dans la partition.
3. Cette fréquence sera utilisée lors de l'exportation en fichiers audio de la partition en cours, mais

les autres partitions seront exportées comme prévu avec la fréquence par défaut. Cependant, en
raison d'une limitation de MuseScore, vous devrez cliquer sur le bouton Charger depuis la
partition pour avoir la bonne fréquence à la lecture.
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Voir aussi

Banque de sons
Mélangeur

Synthé-fr.png
Zerberus-fr.png
EffetsPrincipaux-fr.png
Diapason-fr.png

Une question sans réponse ? Postez la sur le forum.

Tempo
Pour indiquer le tempo, on utilise des indications de tempo dans la partition. La vitesse d'exécution
peut aussi être réglée de manière temporaire dans la Fenêtre de lecture.

Indication de tempo

Les indications de tempo sont utilisées pour indiquer la vitesse d'exécution de la partition à la
personne qui joue. Elles sont interprétées par l'outil de lecture de MuseScore. On peut avoir
différentes indications de tempo tout au long de la partition.

Pour ajouter une indication de tempo:

1. Sélectionnez la note ou le silence où vous souhaitez indiquer un nouveau tempo.
2. Dans la palette Tempo, double-cliquez sur l'indication de tempo à ajouter. Vous pouvez aussi

faire glisser, puis déposer le tempo directement sur le note ou le silence en question, ou utiliser
le menu principal Ajouter → Texte → Indication de tempo, mais dans ce cas, MuseScore
choisira automatiquement la valeur de note dans l'indication.
Vous pouvez aussi utiliser le raccourci Alt+T, dans ce cas it automatically will derive the note
value to be used from the time signature.

Les indications existantes peuvent être éditées comme les autres textes avec un double clic pour
passer en mode Édition de texte.

L'effet sur la lecture d'une indication de tempo peut être modifié directement en éditant le texte si
l'option "Suivre l'indication du texte" est sélectionnée dans l'Inspecteur et que le texte est sous la
forme "figure de note = nombre", comme dans cet exemple qui contient "noire = 75":

Si une indication de tempo a été modifiée et ne contient plus cette information (par exemple,
seulement le mot "Andante"), cliquez sur l'indication pour la sélectionner, puis décochez "Suivre
l'indication du texte" dans l'inspecteur, et vous pouvez saisir le nombre de noires par minute affectée à
cette indication de tempo.
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Attention : La lecture de la partition par MuseScore peut être plus rapide ou plus lente si, dans la
fenêtre de lecture, le curseur tempo est réglée sur une valeur autre que 100%.

Ritardando et accelerando

Les variations de tempo comme ritardando ("rit.") ou accelerando ("accel.") peuvent être ajoutées à
la partition en tant que texte de système mais n'ont pour le moment aucun effet sur la lecture.

L'effet peut toutefois être obtenu en insérant de multiples indications de tempo décroissantes, rendus
invisibles.

Dans cet exemple, le tempo est de 110 BMP avant le ritardando, et décroit de 10 BMP au début de
chaque mesure suivante. Les indications de tempo sont rendus invisibles en décochant visible dans
l'Inspecteur et seul le ritardando reste visible.

Un plugin a été développé pour automatiser le processus : TempoChanges (lien externe)

Points d'orgue

Les points d'orgue, disponibles dans la palette Articulations et ornements, ont une propriété nommée
étirement du temps éditable dans l'Inspecteur. La valeur par défaut est de 1 ; mettez-la à 2 pour que
MuseScore interprète un point d'orgue d'une durée double.

Fenêtre de lecture

Affichez la fenêtre de lecture: Affichage → Fenêtre de lecture  ou F11 (Mac: fn+F11)

Le curseur "Tempo" varie sur une échelle de 10% à 300% des BMP correspondant aux
indications de tempo.

Ce réglage (%) n'est pas enregistré dans la partition et s'applique à toutes les indications de tempo de
la partition.
Par exemple, avec le curseur de la fenêtre de lecture à 120%, une indication de tempo de 80 BPM
sera interprétée à 96 BPM, et indiqué au-dessus du pourcentage.

Une question sans réponse ? Postez la sur le forum.

Nuances
Le volume de la lecture peut être modifié pour la partition entière avec la fenêtre de lecture, et
localement pour des indications de nuances dans la partition.
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Indications de nuances

Depuis la palette "Nuances", faites glisser une nuance sur une note de la partition.
(Alternativement, vous pouvez sélectionner la note dans la partition puis double-cliquer sur la
nuance.)

Pour entrer un crescendo ou un decrescendo, voir Crescendo

Des nuances additionnelles sont disponibles dans la "Palette principale" (MajF9). Vous pouvez
aussi les ajouter à la palette en les faisant glisser dedans ; voir aussi Palettes et Espaces de
travail

Ajuster le volume de lecture des nuances

1. Sélectionnez une nuance en cliquant dessus
2. Affichage → Inspecteur (ou appuyez sur F8)
3. Ajustez la valeur de la vélocité : augmenter la valeur pour jouer plus fort, diminuer la valeur pour

jouer plus doucement.

Fenêtre de lecture

Afficher la fenêtre de lecture : Affichage → fenêtre de lecture

Modifiez le volume en utilisant le curseur.

Liens externes

Tutoriel vidéo : Paroles, copie et nuances

Une question sans réponse ? Postez la sur le forum.

Texte
De nombreux types de texte sont disponibles dans MuseScore : Paroles, Symboles d'accord,
Nuances, Doigtés, Basse continue, Indication de tempo, Repères, et bien d'autres. Nombre d'entre eux
sont accessibles depuis le menu principal via Ajouter → Texte; les autres peuvent être trouvés dans
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les Palettes.

Tempo (→Son et lecture)
Nuances —p, mf, etc. (→Son et lecture)
Swing (→Son et lecture)
Changement d'instrument (→Son et lecture)
Reprises et sauts —DC, Fine, Coda, etc. (→Notation)
Basse continue (→Fonctionnalités avancées)
Cadres de texte vertical, horizontal ou Cadres de texte (→Formatage)
En-têtes et pieds de page les textes se traitent différemment (→Formatage)
Lignes (→Notation)

Voir aussi

Style de texte
Édition de texte
Cadres
Changement d'instrument en cours de portée
En-têtes et pieds de page

Style de Texte

Style et propriétés de texte

Chaque partie de texte a un style de base. Le texte du Titre, par exemple, est centré et utilise une
grande taille de police de caractère ; le texte du Compositeur est plus petit et aligné à droite en haut
du cadre vertical. Pour éditer les style de texte, il faut aller dans Style → Textes..., ou cliquer avec le
bouton droit sur un texte et sélectionner Style de texte...

Changer le style de texte se répercutera sur tout les textes utilisant le même style dans une
partition.

Il est aussi possible d'éditer, pour un texte donné, les mêmes paramètres que ceux disponibles dans
les styles de texte en sélectionnant via un clic droit sur un texte Propriétés du texte...

__Contrairement au changement de style de texte , un changement de propriétés s'appliquera
uniquement au seul texte spécifiquement sélectionné. Le style de texte pour le reste de la partition
restera inchangé , et les autres textes utilisant le même style ne seront pas modifiés. __

Au cours d'une édition de texte, vous pouvez appliquer des changements qui s'écartent du style de
base et qui peuvent également différer des propriétés de texte spécifiques à un bout de texte donné. Il
est possible de revenir sur les changements effectués à travers l'édition du texte (tel que la taille ou
italique) avec l'option réinitialiser le style du texte .
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Les options disponibles sont réparties en catégories :

Texte
Police: Nom de la police "Times New Roman" ou "Arial"
Taille: Taille de la police en point
Style: style de la police, italique, gras, souligné
Couleur : cliquer sur une couleur pour la changer
La taille correspond au paramètre "espace de portée" : Possibilité de suivre ou non la
taille de la distance entre deux lignes sur une portée standard à 5 lignes.
Texte de système : le texte s'applique à tous les systèmes de la partition.

Décalages
Horizontal
Vertical
Unité : en mm ou en unités d'espace de portée

Alignement
Horizontal : gauche, droite, centré,
Vertical : bord supérieur, centré, ligne du bas ou bord inférieur

Cadre

Cadre : Ajoute un cadre autour du texte
Type de cadre : Cercle ou Rectangle
Épaisseur de la bordure: Épaisseur du trait de la bordure, en espace de portée
Rayon de la bordure: Pour les bordures en rectangle , angle du rayon de la bordure
Marge du texte : Marge intérieure du cadre en espace de portée
Couleur du Cadre: Couleur de la bordure du cadre
Couleur de fond: à l’intérieur du cadre.

Note: La transparence est déterminée par le paramètre "Canal Alpha" dans la boite de dialogue
couleurs: une valeur comprise entre 0, transparent, et 255, "plein".

Type de texte

Titre, Sous-titre, Compositeur, Parolier: accroché à la page
Doigtés: accroché à la tête de note.
Paroles: accrochées à une position de temps (note/accord, mais pas silences).
Symbole d'accord: accroché à une position de temps.
Texte de Système: S'applique à toutes les portées d'un système et accroché à une position de
temps
Texte de portée: S'applique à une seule portée d'un système et accroché à une position de
temps
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La distinction entre texte de système et de portée importe pour l'extraction des parties séparées dans
une partitions d'orchestre/musique de chambre. Les textes de système seront exportés à toutes les
parties. Les textes de portées seront inclus uniquement dans la partie à laquelle ils sont accrochés.
Plus de détails dans Textes.

Créer un nouveau style de texte

1. Aller dans Style → Textes... ou cliquer droit sur un texte et sélectionner Style de Texte...
2. Cliquer sur Nouveau
3. Donner un nom
4. Modifier les propriétés

Le nouveau style créé sera sauvegardé dans la partition en cours. Il ne sera donc pas disponible dans
une autre partition, à moins d'enregistrer explicitement la feuille de style et de charger celle-ci dans
l'autre partition.

Options d'application

Il est possible d'appliquer les options pour la partition ou la partie visible, si le bouton Appliquer puis OK
sont sélectionnés.
Si une seule partie est visible, il est possible d'utiliser l'option Appliquer à l'ensemble des parties
avant le bouton OK. Cela évite de manipuler les parties séparées une à une.

Réinitialiser le style de texte

Si vous avez effectué des modifications sur un bout de texte et et que vous voulez revenir au style de
texte défini dans la partition, ou si le changement de style a été effectué avec une version plus
ancienne de MuseScore et qu'il doit correspondre au style de texte par défaut dans Musescore 2, il
est utile d'utiliser l'option Réinitialiser le style de texte option.

Il suffit de sélectionner le texte à réinitialiser le style à l'aide du bouton Réinitialiser le style de
texte dans l'Inspecteur. Pour réinitialiser l'ensemble des textes d'un style : cliquer avec le bouton droit
sur l'un d'eux et dans le menu contextuel, choisir
Sélectionner → Tous les éléments similaires avant de réinitialiser.

Voir aussi

Édition de texte
En-tête et pied de page

Text_Style-Properties_fr.png
Une question sans réponse ? Postez la sur le forum.

Édition de texte
Double-cliquez sur le texte pour entrer dans le Mode Édition :

Barre d'outils texte en bas de l'écran :

Dans le mode Édition d'un texte, les raccourcis clavier suivants sont disponibles :

Ctrl+B (Mac: ⌘+B) affiche en "gras"
Ctrl+I (Mac: ⌘+I) affiche en "italique"
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Ctrl+U (Mac: ⌘+U) affiche en "souligné"
Déplacer le curseur : Home Fin Gauche Droit
Espace arrière efface le caractère à gauche du curseur ;
Suppr efface le caractère à droite du curseur ;
Entrée retour à la ligne ;
F2 ouvre les caractères spéciaux (voir ci-dessous).

Symboles et caractères spéciaux

Vous pouvez utiliser la palette des caractères spéciaux pour insérer des caractères autres que ceux

du clavier, ou des symboles dans votre texte. Cliquez sur l'icône  de la barre d'outils texte en
bas de l'écran ou appuyez sur F2 pour l'ouvrir.

La palette des caractères spéciaux contient des boutons pour insérer les symboles dans le texte (ex :
noires, soupir, etc), ou des caractères spéciaux (ex : symbole de copyright, ©).

Note, vous conservez l'accès au champ de texte que vous êtes en train de taper, quand la palette des
caractères spéciaux est ouverte.

Double-clic sur un symbole dans la palette des caractères spéciaux, l'ajoute immédiatement à l'endroit
où se trouve le curseur dans le texte.

Notez qu'il est impossible d'afficher la palette des caractères spéciaux si le mode d'édition n'est pas
activé. À ne pas confondre avec le menu du même nom dans la version Mac OS X de MuseScore.

Voir aussi

Symboles d'accord
Paroles
Cadres
Mode Édition

Une question sans réponse ? Postez la sur le forum.

Doigtés
Les doigtés peuvent être ajoutés:

1. en sélectionnant une note (ou plusieurs, avec la touche Ctrl) et en double-cliquant sur une
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indication de doigté dans la palette "Doigtés".

2. en faisant glisser une indication de doigté depuis la palette "Doigtés" jusqu'à la tête d'une note
(elle doit passer en surbrillance) dans la partition.

3. en dupliquant les doigtés déjà présents dans la partition en appuyant de manière continue sur
les touches Ctrl + Maj et en faisant glisser l'indication de doigté jusqu'à la tête de note suivante
souhaitée.

4. en copiant-collant les doigtés déjà présents dans la partition

Les doigtés sont des textes normaux, qui peuvent être édités comme vous le souhaitez.

Voir aussi

Comment positionner le doigté

Une question sans réponse ? Postez la sur le forum.

Paroles
1. Entrer les notes
2. Sélectionner la note de la première syllabe,
3. Depuis le menu principal, choisir Ajouter → Texte → Paroles ou taper Ctrl+L (Mac: ⌘+L)
4. Pour entrer les paroles :

Écrire la première syllabe pour la première note.
Taper - (tiret) à la fin d'une syllabe pour aller à la note suivante. Les syllabes seront
connectées par un tiret
Taper Espace à la fin d'un mot pour aller à la note suivante
Maj+Espace revient à la syllabe précédente
Entrée va à la ligne même note (couplet suivant), (Note: ne pas utiliser la touche ↵ du
clavier numérique !)
Appuyer sur Haut pour remonter à la ligne supérieure

5. PresserÉchap sort de l'entrée des paroles.
6. Pour taper une seconde ligne (ou plus encore), répéter les étapes 2-3, ou double cliquer sur la

première syllabe et appuyer sur Entrée et insérer la syllabe de la première note et continuer à la
4ème étape.

Quelques exemples:
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La dernière syllabe d'un mot peut être étendue avec des tirets bas _ pour insérer un mélisme :

Entrer soul, Maj+___ puis Échap.

Pour développer les syllabes non finales, ajouter simplement autant de tirets que de notes sans
nouveau texte, dont seul le premier sera visible; la syllabe sera alignée à droite de la première note,
comme les dernières syllabes d'un mélisme (cf supra)

On peut joindre deux syllabes sous la même note par un des symboles d'élision, aussi connus comme
"lyric slur" ou "synalepha".

Pendant la saisie des paroles, dans la barre d'outil de texte, cliquer sur l'icône  (clavier) ou taper
F2 pour ouvrir la palette des caractères spéciaux. Les trois caractères d'élision sont après la clef d'UT.
Le caractère d'élision s'insère dans l'espace qu'il crée à l'emplacement du pointeur de sélection.

Voir l'exemple ci-dessus : "mi-te ͜A-gnel"-

Pour réaliser l'exemple ci-dessus : "mi-te ͜A-gnel"-

Taper "mit-" puis "te",
Puis F2, double-clic sur le symbole d'élision dans la palette des caractères spéciaux,
Taper Ctrl+espace (Mac: ⌥+espace), taper "A", etc.

Le caractère "élision" n'est pas présent dans toutes les polices. Pour savoir quelle police de votre
ordinateur la propose, regardez "la liste de vos polices", cherchez les polices qui proposent une
liaison entre le "e" et le "A" à la place d'un rectangle blanc (l'alignement du caractère variant selon la
police).

Caractères spéciaux

Les paroles peuvent être éditées comme un texte normal, à l'exception de quelques caractères. Si
vous voulez ajouter un "espace", "un tiret" ou un "tiret bas" à une syllabe, utilisez les raccourcis
suivants :

Ctrl+espace (Mac: ⌥+espace) entre un "espace" ( ) dans le texte de paroles.
Ctrl+- (Mac: ⌥+-) ou AltGr+- entre un "tiret" (-) dans le texte de paroles.
Ctrl+Maj+_ (Mac: ⌥+_) entre un tiret bas (_) dans le texte de paroles.
Ctrl+Entrée (Mac: ⌥+Return) ou ↵ (depuis le pavé numérique) entre un retour charriot dans le
texte.

Ajuster individuellement les lignes de parole

La marge supérieure/inférieure et la hauteur de ligne de toutes les paroles peuvent être ajustées
"globalement", dans le menu Style → Général... → Page.
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Cependant, les décalages verticaux et horizontaux des textes de paroles peuvent être ajustés
finement en sélectionnant un mot de la ligne, en utilisant les diverses options du menu contextuel pour
sélectionner les mots désirés et en utilisant l'inspecteur.

Par exemple, pour changer la hauteur des paroles d'une seule portée d'un système particulier :

Clic droit sur un mot de la ligne, puis Sélection → Plus...,
Cochez "même portée" + "même système",
Agissez sur le décalage horizontal de l'inspecteur.

Voir aussi

Texte
Symbole d'accord
Comment entrer les paroles
Comment déplacer les paroles
Comment ajouter un paragraphe de texte à une partition

Liens externes

Vidéo tutoriel : MuseScore en quelques minutes : Leçon 6 - Texte, Paroles et accords

Une question sans réponse ? Postez la sur le forum.

Repères
Les Repères sont de plus en plus souvent utilisés dans les partitions. Ils permettent aux musiciens de
pouvoir commencer au même endroit, sans avoir à compter les mesures (noter que, les repères
peuvent également correspondre à des numéros de mesure), et sont généralement plus visibles.
Typiquement ce sont des suites de lettres consécutives, ou de numéros : A, B, C, ou 1, 2, 3...

Note, une marque de repère n'est jamais cachée par une pause multi-mesures, MuseScore répartira
automatiquement la pause multi-mesures avant et après le repère (mesure support).

Comment créer des Repères

Création manuelle

1. Cliquer sur la première note ou silence, généralement sur la portée du haut, indiquant le début
de la section.

2. Ajouter → Texte → Repère, ou Ctrl+M, ou depuis la Palette → Texte → Repère.
3. Entrer le texte du Repère, cliquer en dehors ou Échapp.

Création automatique

Méthode alternative, sélectionnez une note, puis dans la palette Texte, double-clic sur la marque de
repère [B1], la lettre ou le nombre adéquat sera généré automatiquement, selon les règles suivantes :

1. La première marque de repère créée est "A", la seconde "B" et ainsi de suite. Si vous voulez
une série de repères autre que "lettre en majuscule", comme "en minuscules", "en nombres"
ou en "numéros de mesure", éditez le premier repère en conséquence dès qu'il est généré ; les
suivants suivront votre choix.

2. Si un repère est généré entre deux lettres consécutives (de repères existant), un "1" est ajouté
à la première lettre => "C1" est généré entre "C" et "D", et ainsi de suite.
De la même manière, si un repère est ajouté (depuis la palette) entre deux nombres
consécutifs, un "A" est ajouté au 1er nombre.

3. Pour créer une série (de marques de repères) basée sur les numéros de mesures, le premier
repère doit porter le numéro de sa mesure, éditez-le si besoin (si le numéro de mesure et celui
du repère ne correspondent pas, alors MuseScore considère qu'il s'agit d'une suite numérique).

Remettre les repères dans l'ordre

125

https://musescore.org/en/node/21522
https://musescore.org/en/node/23764
https://musescore.org/en/node/24475
https://www.youtube.com/watch?v=8nglDCxzfeA
https://musescore.org/fr/forum


MuseScore permet de rendre cohérente (ordonner) une suite de repères :

1. Avant de faire votre sélection, vous pouvez éditer (lettre maj/min, nombre, numéro de mesure) le
premier repère de la plage considérée, pour qu'il serve de modèle pour la série de repères.

2. Faites votre sélection, si aucune sélection n'est active la commande s'appliquera à toute la
partition.

3. Édition → Outils → Remettre les repères dans l'ordre,

MuseScore détecte automatiquement la séquence (lettre ou chiffre) sur laquelle est basée la
première marque de repère de la sélection, puis tous les repères sont renommés en conséquence.

Les séquences suivantes sont reconnues :

A, B, C, etc.
a, b, c, etc.
Numérique : 1, 2, 3, etc.
Numérique : suivant les numéros de mesures. Il est nécessaire que le numéro du premier
repère corresponde à la mesure à laquelle il se réfère.

Rechercher un Repère

Vous pouvez naviguer jusqu'à un Repère avec Ctrl+F en entrant le nom du Repère.

Note :

La lettre p/P est réservée pour la recherche des numéros de pages, Pxx renvoi page xx,
dynamiquement.
Si les caractères entrés dans le champ de recherche sont uniquement des chiffres, le
programme considère que vous recherchez une mesure.

Style de texte

Les Repères sont par défaut des textes de système, et apparaissent donc sur toutes les parties et sur
le conducteur.

Un style de texte spécifique est attribué par défaut aux Repères (style Repère), et le texte d'un
Repère est encadré par défaut.

Voir aussi

Propriétés de texte

Liens externes

Repères en lettre (Wikipedia en anglais)

Une question sans réponse ? Postez la sur le forum.

Symboles d'accord
Les symboles d'accord s'insèrent en sélectionnant au préalable une note et en appuyant sur Ctrl+K
(Mac: ⌘+K). Cela crée un symbole d'accord de type objet texte pour la note sélectionnée.

Espace déplace le curseur à la note, au silence ou au temps suivant
Maj+Espace déplace le curseur à la note, au silence ou au temps précédent
Ctrl+Espace (Mac: ⌘+Espace) ajoute un espace dans le nom de l'accord
; déplace le curseur au temps suivant
: déplace le curseur au temps précédent
Tab déplace le curseur à la mesure suivante
Maj+Tab déplace le curseur à la mesure précédente
Ctrl plus nombre (1 - 9) déplace le curseur de la durée correspondante au nombre (ex.; d'une
blanche pour le 6)
Échap sort du mode d'édition de texte

Les symboles d'accord peuvent être édités comme un texte normal. Pour ajouter un dièse entrez #.
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Pour ajouter un bémol entrez b. Pour ajouter un double-dièse entrez x ou ##, et pour ajouter un
double-bémol entrez bb. Ces caractères seront automatiquement affichés avec les signes dièse ou
bémol appropriés lorsque vous terminerez la saisie. N'utilisez pas les signes de dièse et bémol
habituels, MuseScore ne les interprètera pas correctement.

Syntaxe des symboles d'accord

MuseScore interprète la majorité des abréviations utilisées dans les symboles :

majeur : M, Ma, Maj, ma, maj, Δ (entrez t ou ˆ)
mineur : m, mi, min, -
diminué : dim, o (lettre minuscule)
demi-diminué : ø (entrez 0, zéro)
augmenté : aug, +

Notez que pour les accords demi-diminués, vous pouvez bien entendu entrer des abréviations telles
que mi7b5. Celles-ci seront interprétées de la sorte plutôt que d'utiliser le ø.

Vous pouvez également utiliser les extensions et altérations comme b9 ou #5, sus, all, et no3. Vous
pouvez indiquer les renversements et notes de basse avec les notations telles que C7/E. Les
parenthèses et les virgules sont également admises dans les symboles d'accord, et vous pouvez
enfin mettre un symbole d'accord entier entre parenthèses.

Style de symboles d'accord

Les symboles d'accord utilisent le style de texte Symboles d'accord. Vous pouvez donc changer la
police en utilisant les fonctions décrites dans Style de Texte. D'autres paramètres concernant les
styles de texte se trouvent dans Style → Général... → Symboles d'accord, Diagrammes d'accord.
Ces options sont détaillées dans cette section.

Apparence

MuseScore supporte deux styles principaux de symboles d'accord : Standard et Jazz. Vous pouvez
sélectionner l'un ou l'autre grâce aux boutons radio.

Dans le style Standard, les accords sont interprétés simplement, avec la police déterminée par votre
style de texte de symbole d'accord.

Avec le style Jazz, la police MuseJazz est utilisée pour obtenir un effet manuscrit. Les écritures avec
exposants et autres formatages sont aussi acceptés.

127

https://musescore.org/sites/musescore.org/files/chord-symbols.png
https://musescore.org/fr/manuel/style-de-texte
https://musescore.org/sites/musescore.org/files/standard.png


Le style Jazz est sélectionné par défaut si vous utilisez l'un des modèles Jazz.

Le troisième bouton radio est la plupart du temps destiné à la compatibilité avec les partitions
anciennes. Vous pouvez aussi utiliser des fichiers de descriptions d'accords personnalisés. Ceux-ci
peuvent être créés en copiant l'un des fichiers standard et en lisant la documentation incluse dans leur
structure. Cependant, cela concerne uniquement les utilisateurs avancés, et il n'y a aucune garantie
que ces fichiers soient supportés dans l'avenir.

Noms des notes

Par défaut, MuseScore utilise les lettres pour le nom des symboles d'accord. Pour les utilisateurs de
régions où d'autres noms de notes sont utilisés, MuseScore supporte les possibilités suivantes :

Standard: A, Bb, B, C, C#,...
Notation allemande: A, Bb, H, C, C#,...
Notation allemande complète: A, B, H, C, Cis,...
Solfège: Do, Do#, Reb, Re,...
Française: Do, Do#, Réb, Ré,...

De plus, des options sont disponibles pour contrôler les majuscules. Par défaut, MuseScore affiche en
majuscules tous les noms de notes comme montré ci-dessus, même si vous les avez entrés en lettres
minuscules. Cependant, vous pouvez opter pour l'une des options de majuscules automatiques
suivantes :

Accords mineurs en minuscule: c, cm, cm7,...
Casse en minuscule des notes de basse: C/e,...
Tous les noms de notes en majuscule: DO, RE, MI,...

Vous pouvez également désactiver complètement les majuscules automatiques, auquel cas les noms
de notes seront simplement rendus tels que vous les aurez saisis.

Position

L'information de position dans le style de texte est présente comme il se doit. Vous pouvez donc si
besoin définir un décalage horizontal/vertical de l'alignement du texte. Cependant, d'autres contrôles
de positionnement sont également disponibles dans cette boite de dialogue :

Position verticale par défaut : hauteur au-dessus de la portée (utilise des valeurs négatives)
Distance du diagramme d'accord : hauteur au-dessus du diagramme d'accord si celui-ci est
présent
Espace minimum entre les accords : espace entre les symboles d'accord
Distance maximale de la barre de mesure : espace à réserver avant la barre de mesure
Capo: spécifie le réglage du capodastre ; les accords correspondants sont automatiquement
affichés entre parenthèses.

Voir aussi

How to create stacked chord symbols

Une question sans réponse ? Postez la sur le forum.

Texte de portée - Texte de système
Pour un texte court générique, utilisez Texte de portée or Texte de système. La différence entre ces
deux types de textes est que l'un s'applique à une seule portée, l'autre au système entier. Cela a son
importance lorsque vous faites une extraction des parties séparées : le texte de portée apparaîtra
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seulement dans une partie qui contient l'instrument spécifique auquel le texte est attaché, alors que le
texte de système apparaîtra dans toutes les parties. De plus, si vous choisissez de masquer les
portées vides, tout texte de portée appartenant à une portée vide sera aussi masqué. Un texte de
système n'est jamais masqué par la fonctionnalité "masquer les portées vides".

Texte de portée

Un texte de portée est un texte général associé avec une portée particulière à un endroit précis de la
partition. Pour ce faire, choisissez un endroit en sélectionnant une note ou autre et utilisez l'option de
menu Ajouter → Texte → Texte de portée, ou utilisez le raccourci Ctrl+T (Mac: ⌘+T). Un petit cadre
de texte apparaît; vous pouvez immédiatement commencer à saisir le texte. Vous pouvez quitter ce
cadre à tout moment (même sans n'avoir rien saisi) en pressant Esc.

Le texte de portée peut par exemple être utilisé pour placer des indications "Solo" ou "Pizzicato" dans
une portée de la partition. Selon les instructions du texte de portée, la lecture MIDI de cette portée à
l'endroit du texte peut être altérée pour correspondre aux instructions. Pour cela, faites un clic droit sur
le texte de portée et sélectionnez "Propriétés du texte de portée". Voir How to change instrument
sound (e.g. pizz., con sordino) midway through score.

Texte de système

Le texte de système est utilisé lorsque vous souhaitez appliquer des indications textuelles à un
système entier plutôt qu'à une seule ligne de portée. Cela fait une différence lors d'une extraction des
parties séparées, ou si vous choisissez de masquer les portées vides. Pour ce faire, choisissez un
endroit en sélectionnant une note ou autre et utilisez l'option de menu Ajouter → Texte → Texte de
système,ou utilisez le raccourci Ctrl+Shift+T (Mac: ⌘+Shift+T). Un petit cadre de texte apparaît; vous
pouvez immédiatement commencer à saisir le texte. Vous pouvez quitter ce cadre à tout moment
(même sans n'avoir rien saisi) en pressant Esc.

Voir aussi

Style de texte
Édition de texte
Cadres
Changement d'instrument en cours de portée
Header/Footer

Une question sans réponse ? Postez la sur le forum.

Textes de base

Ajouter un texte

Pour ajouter un élément texte à une partition, utilisez une des méthodes suivantes :

Depuis le menu Ajouter → Texte → Titre (pour créer un titre, par exemple).

Sélectionnez un élément texte depuis la palette Swing, (pour créer un texte de swing, par
exemple).

Utilisez un raccourci clavier (Ctrl + L pour créer un texte de Paroles, par exemple).

Note: La méthode exacte dépend du type de texte que vous voulez ajouter ( pour plus de détails voir
Texte). Pour une utilisation générale des éléments textes ancrés aux portées, voir Texte de portée -
Texte de système.

Formater un texte

Chaque élément texte de la partition a trois niveaux de formatage :

Style de texte

Le style d'un élément texte sélectionné, apparait dans la barre de notification et dans l'inspecteur
(section Texte)
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C'est le niveau de formatage le plus élevé, il est affecté à toute une catégorie d'élément texte de la
partition. Tous les textes de portée par exemple, ont un style qui leur est propre ; les textes de
tempo, les textes de parole, les titres, etc, ont également le leur.

MuseScore propose de nombreux styles de texte prédéfinis, qui peuvent aussi être personnalisés,
vous pouvez bien sûr créer le vôtre.

Pour éditer le style d'un élément texte, menu Style → Texte…, ou clic droit sur un texte puis Style du
texte….

Tous les styles peuvent être appliqués à tous les types d'élément texte. Éditer un style de texte
affecte tous les éléments texte utilisant ce style dans la partition.

Pour plus de détails, voir Styles de Texte.

Propriétés d'un texte

Pour éditer les propriétés d'un objet texte et seulement cet objet, clic droit sur le texte Propriétés du
texte….

Pour plus de détails, voir Style et propriétés de texte.

Style de caractère d'un texte

En mode édition, vous pouvez appliquer un formatage spécifiquement à chaque caractère, en utilisant
les options de la barre de formatage en bas de la fenêtre principale : gras, Italique, type et taille de
police, indice et exposant :

Double clic sur le texte, ou
Clic droit sur le texte puis "Éditer l’élément," ou
Clic sur le texte puis Ctrl + E (Mac : Cmd + E).

Pour plus de détails, voir Édition de texte.

Positionnement d'un élément texte

Sélectionnez l'élément texte, puis au choix :

Cliquez/draguez l'objet pour un ajustement approximatif.
Ajustez le décalage horizontal ou vertical dans l'Inspecteur.

Utilisez les touches directionnelles du clavier, avec/sans modificateur :

← : Déplace le texte à gauche de 0.1 esp. (espace de portée, voir Paramètres de la page).
→ : Déplace le texte à droite de 0.1 esp.
↑ : Déplace le texte vers le haut de 0.1 esp.
↓ : Déplace le texte vers le bas de 0.1 esp.
Ctrl+← (Mac : ⌘+←) : Déplace le texte à gauche de 1 esp.
Ctrl+→ (Mac : ⌘+→) : Déplace le texte à droite de 1 esp.
Ctrl+↑ (Mac : ⌘+↑) : Déplace le texte vers le haut de 1 esp.
Ctrl+↓ (Mac : ⌘+↓) : Déplace le texte vers le bas de 1 esp.

Une question sans réponse ? Postez la sur le forum.

Formatage
Mise en page et formatage
Vous avez terminé votre partition et vous souhaitez l'imprimer. Ce chapitre décrit plusieurs façons
d'effectuer votre mise en page.

Agir sur la mise en page

Mise en page → Paramètres de la page  : Modifier les paramètres généraux tels que la taille de la
page, la valeur de l'"Espace de portée" (sous "Échelle") ainsi que les marges. L'espace de
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portée est utilisé dans d'autres réglages (par exemple : "5.0sp"), modifier cette valeur agira sur
ces autres réglages.
Mise en page → Étirer, Rétrécir : Étirer ou resserrer les mesures sélectionnées.
Style → Général... → Page : Modifier les paramètres généraux affectant la distance entre
portées et entre systèmes, la marge avec les paroles, etc.
Style → Général... → Système : Ajuster l'épaisseur et la distance entre le système et le crochet
ou l'accolade.
Édition → Outils → Ajouter/Supprimer les sauts de ligne  : Définir le nombre de mesures par
système.
Style → Général... → Partition : Modifie les détails de la partition, comme les pauses
multimesures ou la possibilité de masquer les portées vides.
Style → Général... → Mesure : Définir l'espacement de mesure, permettant de contrôler le
nombre de mesure par ligne.
Palette → Sauts & espacements: aller à la ligne à partir d'une certaine mesure, passer à la page
suivante à partir d'une certaine ligne ou ajouter de l'espace entre les mesures.
Style → Général... → Tailles : Définir la taille proportionnelle des petites notes et des
fioritures. Ces modifications restent cependant inhabituelles.

A noter : Ici, ces options s'appliqueront toujours à tous les objets de votre partition. Certains réglages
peuvent être effectués individuellement pour un objet ou une sélection d'objets avec l'inspecteur et
autres propriétés d'objet.

Mise en page → Paramètres de la page

Voir Paramètres de la page.

Mise en page → Étirer, Rétrécir

Pour augmenter ou diminuer l'espacement horizontal entre les notes d'une ou de plusieurs mesures,
sélectionnez les mesures souhaitées, puis faites au choix :

Mise en page → Étirer / Rétrécir

Raccourcis claviers :

Étirer, } (Mac : Ctrl+Alt+9) afin d'élargir l'espace entre les notes et ainsi en obtenir moins
dans la région sélectionnée, ou
Rétrécir { (Mac : Ctrl+Alt+8) pour diminuer l'espace entre les notes et donc afficher plus
de notes dans cette région.

Cette propriété est également accessible depuis les propriétés de la mesure. Dans cette boite de
dialogue vous pouvez définir précisément le pourcentage exact d'espace supplémentaire (ou en
moins via une valeur négative).

Pour réinitialiser l'étirement ou le rétrécissement d'une mesure à la valeur par défaut (1), utilisez le
menu :
Mise en page → Restaurer l'espacement.

Style → Général... → Partition
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Ici vous pouvez choisir de créer des pauses multimesures ou de masquer les portées vides. Ces
deux options permettent d'améliorer grandement la taille de la partition ; masquer les portées vides
est utilisé pour créer des partitions condensées. De plus, vous pouvez préciser la largeur et la durée
minimum des pauses multimesures.

"Ne pas afficher le nom s'il n'y a qu'un seul instrument" peut également être pratique pour gagner de
la place dans les parties séparées (ou dans une partition pour soliste), puisque le nom de l'instrument
ne sera pas ajouté en début de ligne.

Par ailleurs, vous pouvez changer la police musicale des textes et symboles. 3 polices sont
disponibles (pour les symboles utilisés dans les portées) : Emmentaler, Gonville et Bravura. 4 polices
d'écriture sont disponibles (pour les textes tels que les nuances, les indications de tempo, etc.) :
Emmentaler, Gonville, Bravura et MuseJazz. Emmentaler est la police par défaut et Bravura est la
police la plus complète pour les symboles.

(Pour modifier la police d'écriture et les propriétés des textes, consultez les Styles de texte).

Certaines options sont spécifiques à la musique ancienne et à l'interprétation avec swing.

Style → Général... → Page
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Sont disponibles ici de nombreuses options affectant la mise en page. Les cases à cocher qui influent
sur votre mise en page concernent l'affichage ou non des éléments de courtoisie (armures, indications
de mesures et clefs). Vous pouvez de plus gérer l'affichage de ces trois éléments dans chaque
système.

Interactions entre musique et marges des pages

Marge au-dessus de la musique / Marge au-dessous de la musique : marges entre la musique
et les marges correspondantes définies dans → Mise en Page → Paramètres de la page
(respectivement la ligne supérieure de la portée supérieure du système supérieur et la ligne
inférieure de la portée inférieure du système inférieur).

Distance entre les portées

Distance entre les portées : espace entre les portées d'un système
Note, vous pouvez ajuster la distance entre 2 portées, dans un système, pour toute la partition
:
Dans la partition, Maj+ cliquer/glisser la portée vers le bas ou vers le haut.
Distance dans l'accolade : espace entre les portées d'un instrument utilisant plusieurs portées
comme le piano ou l'orgue.

Distance entre les systèmes

Distances minimales/maximales entre deux systèmes : permet de définir la distance
minimale/maximale d'un système à l'autre. Si les deux distances sont similaires, la distance
entre système prendra cette valeur

Marges des paroles

Marges au-dessus/au-dessous des paroles : distance entre la portée et les paroles et entre les

133

https://musescore.org/sites/musescore.org/files/Style-General-Page_en_0.png


paroles et la portée suivante
hauteur de ligne des paroles : proportion du style de texte relatif aux paroles

Marges de cadre vertical

Marges supérieure/inférieure du cadre vertical : espace au-dessus et au-dessous d'un cadre
vertical

Seuil de remplissage du dernier système

Si le dernier système occupe plus que le pourcentage indiqué, il est alors étiré pour remplir la
ligne.

Style → Général... → En-tête, Pied de page, Nombres

Vous pouvez afficher le contenu des balises méta de la partition (voir Propriétés de la partition) ou
afficher le nombre de pages dans l'en-tête ou le pied de page de votre partition.
Pour créer un en-tête ou un pied de page dans une partition contenant des parties liées, assurez-vous
de bien visualiser le conducteur dans l'onglet actif de la fenêtre principale. Pour créer un en-tête ou un
pied de page dans une partie seule, cette partie devra être affichée dans l'onglet actif.

Si vous survolez avec le pointeur de votre souris la zone de saisie de texte de l'en-tête ou du pied de
page, une liste des macros apparaît, affichant leur signification, ainsi que les balises méta existantes
et leurs contenus.
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Vous pouvez créer différents en-têtes et pieds de page pour les pages paires et impaires, comme
pour insérer les numéros de page à droite pour une page impaire et à gauche pour une page paire.

Vous pouvez également éditer à quelle fréquence apparaissent les numéros de mesure.

Style → Général... → Système

Crochets système Voir Crochets

Distances : Vous pouvez définir la distance entre le système et le crochet ou l'accolade.
Largeur : Vous pouvez définir la largeur du crochet ou de l'accolade.

Style → Général... → Mesure

Définissez autant l'espacement d'une mesure que les distances et marges. La largeur minimale de la
mesure et l'espacement sont les points clés pour contrôler le nombre de mesures par ligne. Il est
inhabituel de modifier les autres paramètres.

Voir Style général : Mesure.

Style → Général... → Barres de mesure
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Contrôle l'affichage des barres de mesure au début d'une portée ou de portées multiples.
Ajuster la taille des barres de mesure à la taille de la portée affecte les "petites" portées
seulement. Voir Possibilités d'ajustement des barres de mesure (lien externe) pour en savoir
plus.
Contrôle l'épaisseur et la distance des double barres, incluant les barres de reprise.

Palette → Sauts & espacements

Grâce à cette palette, vous pouvez choisir où placer un saut de page, de ligne ou un saut de section ;
augmenter la distance entre deux portées ou deux systèmes avec des espacements. Certains font ces
réglages dès le début, d'autres préfèrent le faire avant de sauvegarder, une fois que les paramètres
globaux ont été définis.

Pour insérer un saut de page, glissez/déposez le symbole dans la mesure. Pour insérer un saut de
ligne, glissez/déposez le symbole dans la mesure qui sera la dernière de la ligne. Si vous souhaitez
obtenir le même nombre de mesures sur plusieurs systèmes, sélectionnez ces systèmes et utilisez
Édition → Outils → ajouter/supprimer les sauts de ligne . Si certaines mesures se retrouvent
seules sur une ligne ou une page, réduisez l'espacement, ou utilisez Mise en page → Étirer/Rétrécir.

Voir aussi Sauts et espacements.

Style → Général... → Notes
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Distance et épaisseur des objets relatifs à une note (hampe, lignes supplémentaires, point). Ces
modifications sont rarement nécessaires.

Style → Général... → Clefs
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Pour votre tablature, vous pouvez choisir entre une clef par défaut ou une clef Serif.

Style → Général... → Arpèges
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Ici se trouvent la distance jusqu'à la note, l'épaisseur de la ligne et la longueur du crochet. Modifier ces
paramètres est rarement nécessaire.

Style → Général... → Ligatures
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Style → Général... → Liaisons
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Style → Général... → Tailles
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Définissez ici la taille des "petites" notes et fioritures ; et celle des portées et des clefs. Il est rare de
devoir modifier ces paramètres.

Style → Général... → Lignes
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Le bouton  restaure les paramètres à leur valeur d'origine.

Style → Général... → Pédales et trilles
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Style → Général... → Symboles d'accord, diagrammes d'accord
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Vous permet de modifier l'apparence et d'autres fonctionnalités.
Voir aussi Diagrammes d'accord.

Style → Général... → Basse continue
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Retrouvez ici les options pour la police de la basse continue, le style et l'alignement.
Voir aussi Basse continue.

Style → Général... → Articulations, Ornements
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Position des articulations par rapport aux notes et aux portées.

Style → Général... → Altérations
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Options concernant les bécarres dans les armures.

Style → Général... → Divisions irrégulières
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Boutons [Appliquer] et [Ok]

Avec le bouton [Appliquer] vous pouvez constater ce que seront les changements effectués sans
devoir fermer la fenêtre. Le bouton [Ok] sauvegarde les modifications dans votre partition et ferme la
fenêtre.

Appliquer à toutes les parties en une seule fois

Lorsque que vous êtes dans un onglet d'une partie et que vous modifiez la mise en page et le
formatage, vous pouvez utiliser le bouton Appliquer à l'ensemble des parties pour appliquer tous
les changements (ceux dans Mise en page → Paramètres de la page...  ou Style → Général...) pour
appliquer les nouveaux paramètres à toutes les parties en un seul clic.

Enregistrer et charger un style

Vous pouvez enregistrer un style personnalisé, pour l'appliquer facilement à toutes vos partitions.

1. Allez dans Style / Enregistrer un style
2. Sélectionnez un dossier et entrez un nom pour votre style (le dossier par défaut sera celui défini

dans les préférences)
Les styles sont enregistrés au format *.mss

A noter : Vous pouvez également définir un style préféré pour les partitions et les parties dans la
section Préférences.

Voir aussi

Éditer l'espacement entre les notes

Mettre à jour depuis MuseScore 1.x, local relayout
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Liens externes

Tutoriel – How to create large-print stave notation (MSN), en anglais
MuseScore, facile en 10 leçons : Partie 10A - Mise en page et formatage (vidéo en anglais)
MuseScore, facile en 10 leçons : Partie 10B - Mise en page et formatage (vidéo en anglais)

Style général : Mesure

This translation is outdated, see the English version for a reference: General style: Measure

Style → Général... → Mesure  ouvre une fenêtre vous permettant d'ajuster la distance (l'espace) entre
divers éléments dans une mesure.

Note : Lorsque vous étirez ou réduisez une mesure ou un groupe de mesures (contiguës),
MuseScore optimise toujours l'apparence pour organiser les symboles en cohérence avec "les
bonnes pratiques de la typographie musicale".

In other words, you may specify a certain amount of space between notes, but MuseScore will not
apply your change in such a way as to make all notes perfectly equidistant—there will always be less
space to the right of shorter notes than longer notes. In addition, elements attached to notes or rests
such as fingerings, dynamics, lines, and so forth, will be moved along with the notes or rests they are
anchored to when you make changes, so you need not worry about readjusting them separately.

Toutes les valeurs relatives à la largeur de la mesure et à l'espacement entre les notes sont des
valeurs minimums. Les mesures sont automatiquement recalibrées pour, le cas échéant, intégrer les
valeurs des deux marges.

Options

Tous les paramètres dans cette fenêtre sont indexés à l'unité Espace de portée (abréviation esp.),
voir menu Mise en page → Paramètres de la page... → Échelle → Espace de portée

The staff space is the vertical distance from one individual line in a staff to another (so a five-line staff
is four staff spaces tall).
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Measuring using the staff space unit enables proportional scaling of everything in the score if you
change the size of the staff. See Page settings: Staff space/scaling for more details.

Largeur minimale de la mesure : Sets the minimum horizontal length of measures. In
measures containing very little content (e.g., a single whole note or whole measure rest), the
measure will only shrink as far as this minimum.

Espacement (1 = étroit) : Condenses or expands the space after notes or rests. This setting
thus affects not only space between notes but also between the last note and the ending barline.
For the space between the beginning of the measure and the first note or rest, see Barline to
note distance (below).
Note: Changes to an individual measure's Stretch (under Layout → Increase Stretch,
Decrease Stretch) are calculated after, and proportional to, the global Spacing setting.

Distance entre la barre de mesure et la note : Sets the distance between the barline which
begins a measure and the first note or rest in that measure. For the initial measures of systems,
which start with clefs instead of barlines, use Clef/key right margin (below).
The following two options set the distance between barlines and specific elements that may
come between a barline and the first note in a measure, independent of the Barline to note
distance setting.

Distance entre la fioriture et la barre de mesure : Sets the distance between a barline and a
grace note that occurs before the first actual note in a measure.

Distance entre la barre de mesure et l'altération accidentelle : Sets the distance between a
barline and an accidental placed before the first note in a measure.

Distance entre la note et la barre de mesure :

Distance minimum entre les notes : Specifies the smallest amount of space MuseScore will
allow after each note (depending on other factors, more space may be allowed).

Marge à gauche de la Clef
Sets the distance between the very beginning of each line and the clef. (This option is rarely
needed.)

Marge à gauche de l'armure : Sets the distance between the key signature and the clef
preceding it.

Marge à gauche de l'indication de mesure : Sets the distance between the time signature and
the key signature or clef preceding it.

Marge à droite de la Clef ou de l'Armure : Sets the distance between the material at the
beginning of each line (such as the clef and key signature) and the first note or rest of the first
measure on the line. (Note that, although not named in the option, if a time signature is present,
it is the element from which the spacing begins.)

Distance entre la Clef et la barre de mesure : Sets the distance between a barline and a clef
change preceding it.

Marge des pauses multi-mesures : Distance entre le symbole de pause multi-mesures et les
barres de mesure de chaque coté.

Épaisseur des lignes de portées : Sets the thickness of the lines of the staff, which allows you
to make the staff thicker and darker, if you need greater visibility on your printouts.

Une question sans réponse ? Postez la sur le forum.

Cadres
Les cadres créent des espaces vides en dehors des mesures. Il peuvent contenir du texte ou des
images. MuseScore dispose de deux sortes de cadres :

Cadre horizontal
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Les cadres horizontaux créent un espace au début, au milieu (où vous voulez) ou à la fin d'un système
(ou d'une portée s'il n'y en a qu'une).
La largeur est ajustable, et la hauteur est celle de la portée ou du système. Ces cadres peuvent servir
à séparer une coda.

Cadre vertical

Les cadres verticaux fournissent un espace entre les portées, ou avant les systèmes. La hauteur est
ajustable et la largeur est celle du système.

Vous pouvez utiliser un cadre vertical pour :

Créer une zone de texte pour placer titre, sous-titre, noms de l'auteur, du compositeur, etc
Ajouter les paroles d'une chanson, y compris en plusieurs colonnes.

Si vous créez un titre, par le menu contextuel ou par le menu principal Ajouter →, un cadre vertical est
automatiquement placé avant la première mesure, si il n'y est pas déjà.

Cadre de texte

A text frame looks like a vertical frame – and shares some of its features – but is specifically designed
to allow the user to enter text quickly and easily: as soon as the frame is created the user can start
typing. Unlike the vertical frame, only one text object is allowed per frame, the height automatically
expands to fit the content and there is no height adjustment handle.

Pour ajouter un cadre de texte, voir Créer un cadre.

Selectionner un cadre (pas l'objet texte), vous permet d'éditer certains paramètres dans l'inspecteur:

Marge supérieure : Distance entre le cadre et l'élément le précédant (valeur négative non
supportée pour le moment).
Marge inférieure : Distance entre le cadre et l'élément suivant (valeur négative supportée).
Hauteur : N/A aux cadres de texte.
Marge de gauche :
Marge de droite :
Marge du haut :
Marge du bas :

Vous pouvez aussi cliquer sur un objet texte pour ajuster la couleur, la visibilité, les décalages
verticaux/horizontaux dans l'Inspecteur.

Créer un cadre

Sélectionnez une mesure. La commande pour insérer un cadre se trouve dans le menu Ajouter →
Cadres. Le cadre est inséré avant la mesure sélectionnée.
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Un cadre peut également être ajouté à un texte, voir Style de texte.

Supprimer un cadre

Sélectionnez le cadre et appuyez sur Suppr.

Éditer un cadre

Double-cliquez sur le cadre pour entrer dans le Mode Édition. Une poignée apparaît, faites-la glisser
pour redimensionner le cadre, ou utilisez les touches directionnelles (→, ←, ↑ ou ↓).

Cadre de texte en Mode Édition :

Sélectionner un cadre horizontal, permet d'en éditer divers paramètres dans l'inspecteur :

Marge supérieure : Distance entre le cadre et l'élément le précédant (valeur négative non
supportée pour le moment).
Marge inférieure : Distance entre le cadre et l'élément suivant (valeur négative non supportée
pour le moment).
Hauteur :
Marge de gauche :
Marge de droite :
Marge du haut : (voir aussi Style → Général... → Page).
Marge du bas : (voir aussi Style → Général... → Page).

Note : Les options des cadres horizontaux dans l'Inspecteur, sont limitées à :

Marge de droite ;
Marge de gauche ;
Largeur.

Le menu contextuel d'un cadre vertical permet d'y Ajouter → : Texte, Titre, Cadre horizontal, Image,
etc.

Le menu contextuel d'un cadre horizontal ne permet d'y Ajouter → que : Texte et image.

Vous pouvez créer dans un cadre autant d'objets que vous désirez.
Chaque objet peut recevoir son propre style (couleur, police...) et être repositionné y compris au-delà
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du cadre, par l'Inspecteur, ou par le clic droit → Style du texte ou → propriétés du texte.

Chaque objet texte créé dans un cadre peut être déplacé par cliquer/glisser (utilisez Ctrl ou Maj pour
contraindre un mouvement horizontal ou vertical).

Appliquer un saut à un cadre

Les sauts de portées, de pages ou de sections peuvent être appliqués aux cadres de deux façons :

Sélectionnez un cadre et double-cliquez un symbole de saut dans la Palette "Sauts et
espacements".
Cliquez/glissez un symbole depuis la même palette dans un cadre.

Voir aussi

Comment ajouter un bloc de texte à une partition

Liens externes

Formater une page avec MuseScore 1.1 - 1. Cadres, textes & sauts (en) [vidéo]

Une question sans réponse ? Postez la sur le forum.

Capture d'image
La capture d'image vous permet de créer des extraits d'images de vos partitions. Elle peut être

activée/désactivée avec le bouton "Capture d'image" .

Dans le mode "Capture d'image", un rectangle de sélection peut être défini avec Maj + déplacement
de la souris.

Le rectangle de sélection peut être déplacé avec la souris, ou redimensionné en déplaçant l'une des
huit poignées.

Une fois votre sélection pour la capture d'image effectuée, cliquez droit dans le rectangle pour ouvrir
le menu contextuel :

154

https://musescore.org/en/node/24475
http://www.youtube.com/watch?v=ITkD5EHPz3Y
https://musescore.org/fr/forum


Enregistrez le résultat dans un fichier PNG :

Si vous enregistrez votre capture en "mode impression", l'image comprendra la zone capturée de la
partition telle qu'elle serait imprimée. Avec le "mode capture écran", l'image ressemblera à votre
partition telle qu'affichée sur votre écran (incluant les marqueurs de sauts, etc..., qui eux ne sont pas
imprimés) (exemple en 100dpi) :

Voir aussi

Image
Créer un ossia avec une capture d'image

Une question sans réponse ? Postez la sur le forum.

Image
Vous pouvez utiliser des images pour illustrer vos partitions, ou ajouter des symboles qui ne sont pas
inclus dans les palettes.
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Pour ajouter une image, faites-la glisser depuis un dossier de votre ordinateur jusqu'à une note ou un
silence de la partition. Alternativement, cliquez droit sur un cadre, puis sur Ajouter → Image, et
choisissez une image dans le sélecteur de fichiers.
Par un double clic sur l'image vous faites apparaître les poignées permettant un ajustement de la
taille.
Dans l'inspecteur, vous pouvez débloquer le rapport largeur/hauteur

MuseScore supporte les formats d'image suivants :

PNG (*.png)
JPEG (*.jpg and *.jpeg)
SVG (*.svg) (MuseScore ne supporte pas les fichiers SVG ombrés, floutés, multicouches
masquées ou non.)

Voir aussi

Capture d'image
Créer un ossia avec une capture d'image

Une question sans réponse ? Postez la sur le forum.

Paramètres de la page
Mise en page → Paramètres de la page...  (comme Style → Général...) vous permet de formater la
mise en page de la partition, avec les options générales telles que Taille de la page, Marges
d'impression, Échelle (Espace de portée) et Unité utilisée.
Paramètres de la page est le premier endroit où aller pour calibrer votre partition.

Taille de la page

Formats de papiers standards (ex. Lettre, A3, A4, B4...), ou personnalisé en mm ou en pouces.
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Orientation Paysage ou Portrait, option Recto/verso pour les marges en miroir (ex. format livre,
brochure).

Marges

Si Recto/verso est coché, vous avez la possibilité de régler indépendamment les marges des
pages impaires et des pages paires (pour avoir une symétrie), sinon, une seule option de
réglage des marges est présente, et pour toutes les pages.

Pour matérialiser à l'écran les marges de votre partition (ni imprimées, ni exportées en pdf),
faites Affichage → Afficher les Marges.

Échelle - Espace de portée

L'Espace de portée (esp.) est la distance entre deux lignes de portée. De nombreuses autres
dimensions de la partition sont exprimées en esp. (têtes de notes/silences, taille des hampes,
des altérations, des clefs, des textes, etc).

Note: Changer l'Espace de portée ne change pas toujours le nombre de systèmes par page car
la distance entre systèmes est encadrée par des valeurs min/max (voir Style → Général... →
Page).

Divers

Numéro de la première page, cette option accepte une valeur négative, les pages ayant un
numéro inférieur à 1 n'étant pas imprimées, paramétrer à -1 la première page, exclura les pages
(-1) et (0) lors de l'impression.

Appliquer à l'ensemble des parties permet d'appliquer tous les paramètres de la partie active
à toutes les autres parties (voir Extraction des parties séparées).

Une question sans réponse ? Postez la sur le forum.

Sauts et espacements
Les sauts de page, sauts de ligne (sauts de système) ou les sauts de section sont ajoutés en
faisant glisser le symbole correspondant depuis la palette "Sauts et espacements" jusqu'à un espace
vide d'une mesure ou d'un cadre horizontal dans la partition. Le saut intervient après la mesure ou le
cadre ainsi marqués. Les symboles bleus de sauts sont visibles à l'écran, mais n'apparaissent pas à
l'impression.

Les sauts de système en milieu de mesure sont parfois nécessaires (particulièrement pour les
hymnes strophiques ou les lieder). par exemple, si vous souhaitez trois temps dans un système et un
temps en levée dans le système suivant, vous avez donc besoin de créer deux mesures d'une durée
raccourcie. Pour plus de détails, voir Opérations sur les mesures : Séparer et joindre.

Les espacements sont utilisés pour augmenter l'espace entre deux portées ou entre deux systèmes.

Si vous souhaitez ajuster l'espace entre toutes les portées d'une partition, utilisez plutôt les réglages
de style. Les espacements sont conçus pour des ajustements locaux.

Ajouter un saut ou un espacement

1. Utilisez la palette "Sauts et espacements" (voir ci-dessus).
2. Depuis la palette, faites glisser le symbole souhaité.
3. Déposez le symbole dans la mesure qui précède le saut ou qui surmonte l'espacement.

Éditer un espacement
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Double-cliquez sur l'espacement et cliquez/tirez la poignée ou utilisez les touches directionnelles ou
utilisez l'Inspecteur pour ajuster sa hauteur.

Supprimer un saut ou un espacement

Cliquez sur le saut ou l'espacement (il s'affichera en bleu foncé pour indiquer qu'il est sélectionné),
puis Suppr (Mac: Fn+Delete).

Saut de section

Le saut de section peut être utilisé pour séparer les mouvements d'un concerto par exemple.
Il peut être utilisé soit à un saut de ligne, soit à un saut de page.
La numérotation des mesures de la nouvelle section sera réinitialisée à 1 et le numéro de la
première mesure ne sera pas affiché.
À la lecture de la partition, une pause de 3 secondes (défaut) sera insérée.
La première barre de Fin de répétition d'une section, renvoie à la mesure n°1 de cette même
section.

Si vous modifiez l'indication de mesure ou l'armture au début d'une nouvelle section, il n'y aura
par défaut aucune indication de précaution à la fin de la section précédente. Voir l'exemple ci-
dessous :

Propriétés d'un saut de section

Clic droit sur un saut de section puis Propriétés du saut de section,

Longueur de la pause en secondes ;
Choisir pour la section suivante d'afficher ou pas le(s) nom(s) long(s) d'instrument(s) ;
Choisir si le compteur de mesures doit être réinitialisé à 1 (défaut), ou pas, au début de la
section suivante.

Voir aussi

Édition → Outils→ Ajouter/supprimer des sauts de ligne

Une question sans réponse ? Postez la sur le forum.

Aligner des éléments
Pendant que vous cliquez/glissez un élément, pressez :

Ctrl pour contraindre un mouvement horizontal.
Maj pour contraindre un mouvement vertical.

Aligner sur la grille

Aligner sur la grille est une fonction qui vous permet de faire glisser un élément selon un pas précis
pour obtenir un positionnement exact.

Pour activer l'alignement sur la grille, sélectionnez un élément et cliquez sur l'un des boutons (ou les
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deux) d'alignement sur la grille, situés à droite des champs de décalage horizontal et vertical dans
l'Inspecteur. Vous pouvez alors faire glisser l'élément pas à pas selon l'espacement de la grille. La
valeur par défaut de l'espacement est de 0.5 esp.

Modifier l' espacement de la grille:

Faites un clic droit sur l'un ou l'autre des boutons d'alignement sur la grille dans l'Inspecteur et
sélectionnez Configurer la grille.
Définissez les valeurs des espacements "horizontal" et "vertical".
À noter que ceci est un paramètre proportionnel.

Une question sans réponse ? Postez la sur le forum.

Fonctionnalités avancées
Changer les hauteurs des notes sans changer le rythme
Si, dans un passage, vous voulez modifier les notes sans changer le rythme, mais que cela est plus
compliqué qu'une simple transposition, re-pitch mode est recommandé (en français "remplacer les
hauteurs sans changer les rythmes"). En résumé, dans le "re-pitch mode", les nouvelles hauteurs
remplacent les anciennes en respectant le rythme original.

A ne pas confondre avec Notes: recalculer les altérations

Pour reproduire le rythme d'un passage avec des notes différentes, copiez-le et collez-le là où vous le
désirez. (S'il s'agit simplement de corriger des erreurs de notes, cette manœuvre n'est pas
nécessaire).
Cliquez sur la première note dont vous voulez modifier la hauteur, passez en mode édition en cliquant

sur le bouton de saisie des notes , (ou en pressant la touche N du clavier).

Cliquez ensuite sur le bouton "re-pitch", , situé près du bouton , ou utilisez le raccourci-
clavierMaj+Ctrl+I (Mac: Shift+Cmd+I).
Commencez à taper au clavier les nouvelles notes. Les rythmes seront respectés.
Pour naviguer vers l'avant dans le texte, en conservant des notes, en passant des silences, ou revenir
en arrière, utilisez les flèches droite et gauche du clavier. Ctrl+ flèche (droite ou gauche) permet
d'aller directement au 1er temps de la mesure suivante (ou précédente)

Voir aussi {#see-also} :

Saisie des notes
Copier/coller
Transposition
Introduction au nouveau 'Repitch Mode' (en anglais)

Une question sans réponse ? Postez la sur le forum.

Diagrammes d'accord
Un diagramme d'accord par défaut est fourni dans la palette des Diagrammes d'accord, dans l'espace
de travail "Avancé"

Vous pouvez l'ajouter à une partition, le personnaliser à votre goût, et éventuellement l'ajouter à une
palette personnalisée pour une utilisation future.

Créer un diagramme d'accord

1. Ouvrir une palette contenant un diagramme d'accord (cela pourrait être celui par défaut dans la
palette des Diagrammes d'accord dans l'espace de travail "Avancé", ou dans une palette
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personnalisée), et ensuite:
Sélectionner une note en Voix 1, et double-cliquer sur le diagramme d'accord.
Ou
Glisser et déposer le diagramme d'accord à l'endroit souhaité sur la partition.

2. Clic-droit sur le diagramme et sélection Propriétés du diagramme d'accord.
3. Régler le nombre de "Cordes" de l'instrument, en utilisant la boîte de contrôle +/- , en bas à

gauche de la fenêtre.
4. Ajuster la position la plus basse de frette visible en utilisant la barre de défilement sur le côté

droit.
5. Ajuster le nombre des frettes affichées en utilisant la boîte de contrôle des "Frettes" en bas à

droite de la fenêtre.
6. Pour placer un point sur la case d'une corde, cliquer sur cette case. Pour le supprimer, cliquer à

nouveau.
7. Cliquer au-dessus de la case la plus basse pour basculer une corde entre:

Corde ouverte (o),
Corde muette/non jouée (x)
Off (vide)

8. Pour créer un barré ou barré partiel, vérifier d'abord que la position de frette souhaitée est vide
de points. Puis cliquer sur une frette en tenant appuyé Maj (voir "étape 2 ci-dessous). Supprimer
le barré en cliquant n'importe où sur la même position.
Note: Un seul barré peut être appliqué par diagramme.

Par exemple, pour appliquer un accord de Fa :

1. Après avoir placé le diagramme d'accord par défaut, cliquer sur les positions de frettes
pertinentes pour établir les points du doigté.

2. Créer le barré en utilisant Maj et clic sur la première case de la 6ème corde, comme ceci:

Résultat:
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Notez que le principe est identique si vous voulez un barré de quatre cordes (ou autre). Dans le
cas d'un accord de La7: Appuyer Maj, puis cliquer sur la quatrième corde, deuxième frette. Il en
résulte:

Éditer les propriétés

La taille ("l'échelle"), la couleur et la position du diagramme d'accord peuvent être modifiées en
cliquant dessus et en modifiant les valeurs adaptées dans l'Inspecteur.

La position peut également être ajustée plus directement en mode édition:

1. Double-cliquer sur le diagramme ou cliquer et faire Ctrl+E (Mac: Cmd+E) , ou faire clic-droit sur le
symbole et sélectionner "Éditer l’élément".

2. Appuyer sur les touches fléchées pour un positionnement le plus fin (0.1 esp à la fois); ou
appuyer sur Ctrl+Flèche (Mac: Cmd+Flèche) pour des ajustements plus importants (1 esp à la
fois).

Certaines propriétés par défaut des diagrammes d'accord (épaisseur de la ligne du barré, position
verticale, taille etc.) peuvent être ajustées via Style → General… → Symboles d'accord, Diagrammes
d'accord…. Toutes les modifications apportées ici affectent tous les diagrammes existants, ainsi que
ceux qui sont appliqués par la suite.

Une question sans réponse ? Postez la sur le forum.

Extraction des parties séparées
Si vous avez écrit une partition pour ensemble, ou un conducteur, MuseScore peut créer
automatiquement les partitions de chaque musicien de l'ensemble, appelées parties.

Définir les parties

Vous pouvez définir les parties n'importe quand après la création de la partition. La création des
parties ne se fait qu'une seule fois par partition, mais vous pouvez les modifier à n'importe quel
moment. Les instructions qui suivent utilisent un quatuor à cordes comme exemple, mais le même
principe peut être appliqué pour n'importe quel autre ensemble.

1. Dans le menu principal, Fichier → Parties...
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2. Dans la boite de dialogue Parties, cliquer sur Nouvelle pour créer une "définition de partie"

3. Sur la droite, taper le titre de la partie (il sera utilisé comme nom de fichier quand la partie sera
exportée)

4. Choisir l'instrument souhaité dans la partie en cochant les cases à gauche. Souvent, un seul
instrument par partie est utilisé mais on peut aussi souhaiter une partie avec plusieurs
instruments (par exemple pour des percussions). MuseScore permet d'inclure autant
d'instruments qu'on le souhaite par partie.

5. Répéter les étapes 2 à 4 ci-dessus autant que nécessaire.
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6. Une fois que toutes les parties sont définies, appuyer sur OK pour fermer la boite de dialogue
Parties.

Vous avez maintenant défini les parties. Pas besoin de le faire de nouveau pour cette partition, sauf si
vous souhaitez ajouter ou supprimer un instrument de votre conducteur. Dans la version courante de
MuseScore, il n'est pas possible de séparer une portée (qui contiendrait deux voix ou plus) en
différentes parties. Donc, les instruments que vous souhaitez imprimer séparément doivent avoir leur
propre portée dans le conducteur.

Définir toutes les parties en une fois

Si vous avez une partition pour orchestre et que chaque instrument doit avoir une partie, vous pouvez
créer les parties plus facilement :

1. Dans le menu principal, Fichier → Parties...

2. Appuyer sur le bouton Nouvelle pour chacun (Les parties prennent le nom de l'instrument, en
ajoutant "-<numéro>" si nécessaire)

3. Appuyer sur OK

Vous devriez voir une partie par instrument avec votre conducteur.

Exporter les parties

1. Dans le menu principal, Fichier → Exporter les parties...

2. Naviguer jusqu'au répertoire souhaité et choisir le format (PDF par défaut)

3. Pour le nom du fichier, entrer le préfixe pour toutes les parties ou garder le nom par défaut (le
nom de fichier du conducteur)

4. Appuyer sur OK

Les parties seront exportées dans le répertoire donné avec des noms "<prefixe>" + "-" + "<nom de la
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partie>.<extension>". En exportant en PDF, un fichier "<prefix>" + "-Conducteur_et_Parties.pdf" sera
aussi créé.

Enregistrer une partie

Les parties et le conducteur sont "liés", ce qui signifie que n'importe quel changement dans le contenu
de l'un affecte l'autre. Les changements de mise en page ne sont eux pas liés. Une fois les parties
définies, elles sont enregistrées avec le conducteur (si vous ouvrez le conducteur, il y a des onglets
pour le conducteur et pour chaque partie que vous avez créée).
Vous pouvez toutefois enregistrer chaque partie individuellement en sélectionnant son onglet et en
utilisant Fichier → Enregistrer sous...

Une question sans réponse ? Postez la sur le forum.

Formats de fichier
MuseScore prend en charge une grande variété de formats de fichiers, qui vous permettent de
partager et publier vos partitions dans le format qui répond le mieux à vos besoins.

Vous pouvez importer des fichiers via le menu Fichier → Ouvrir et exporter via le menu Fichier →
Exporter.
En complément des formats décrits ci-dessous, vous pouvez enregistrer et partager vos partitions sur
internet sur MuseScore.com Fichier → Enregistrer en ligne. Voir Partager les partitions en ligne.

À propos des polices : MuseScore n'intègre pas de polices de caractères dans le fichier, à
l'exception des familles de police FreeSerif, FreeSerifBold, FreeSerifItalic, FreeSerifBoldItalic et
FreeSans. Si vous souhaitez partager un fichier, choisissez soit une de ces polices pour vos textes,
soit une police que les autres parties ont sur leur système ; sinon MuseScore utilisera une police de
substitution (sans garanties pour l'apparence de votre partition).

Formats natifs de MuseScore

Ce sont les formats de fichier proposés dans les menus Fichier → Enregistrer, Fichier →

Enregistrer sous, le bouton , et le Raccourci Ctrl+S quand le fichier n'est pas encore enregistré
sur votre disque.

Format MuseScore (*.mscz)

MSCZ est le format standard de fichier créé par MuseScore. Il est recommandé pour la plupart des
utilisations.

Une partition enregistrée dans ce format occupe très peu d'espace sur le disque, mais conserve
toutes les informations nécessaires ; c'est la version compressée (zippée) du format .mscx mais avec
toutes les images.

Format MuseScore non compressé (*.mscx)

MSCX est le format de fichier non compressée de MuseScore.

Une partition enregistrée dans ce format comporte toutes les informations, exceptées les images. Il
n'est recommandé que pour l'édition manuelle de fichier avec un éditeur de texte.

Les précédentes versions de MuseScore utilisaient l'extension de fichier *.msc, mais cette extension
entrait en conflit avec une extension de fichier utilisée par Microsoft Windows et était bloquée par
certains fournisseurs de messagerie. Elle a donc été remplacée par l'extension de fichier MSCX, plus
récente.

Les formats MSCZ et MSCX de MuseScore 2.0 ne peuvent être lu par MuseScore version 1.3 ou
antérieure. Utiliser le format → XML ou → MXL vous permet de contourner cette limitation.

Fichiers de sauvegarde MuseScore

Fichier de sauvegarde MuseScore (*.mscz, ou *.mscx,)
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Quand vous ouvrez un fichier dans MuseScore, une sauvegarde est créés automatiquement dans le
même dossier, sur la base du même nom, mais précédé d'un point (.) et suivi d'une virgule (,). Le
fichier "ma-chanson.mscz" a pour sauvegarde ".ma-chanson.mscz," .

Le fichier de sauvegarde est l'exacte copie du fichier source ouvert dans MuseScore, et peut donc
être vital si votre fichier subit une corruption, en cas de crash logiciel ou si vous recherchez une
ancienne version de votre partition.

Les fichiers de sauvegarde de MuseScore sont des fichiers cachés
(voir Afficher les fichiers cachés de Windows et/ou Masquer les extensions des fichiers dont le type
est connu, dans Windows).
Voir aussi : Récupérer une sauvegarde de partition (MuseScore 2.x) (en anglais).

MuseScore ne connait pas l’extension "mscz," , la virgule doit être retirée du nom pour ouvrir le fichier
dans le logiciel ; l'enregistrer sous un nouveau nom dès l'ouverture est souhaitable (pour enlever le
point au début et pour éviter les conflits de noms).

Visualiser et imprimer (export seulement)

PDF (*.pdf)

Le format PDF (Portable Document Format ) est idéal pour partager votre partition avec d'autres qui
n'ont besoin ni d'éditer, ni d'écouter son contenu. La plupart des utilisateurs ont un lecteur PDF sur
leur ordinateur, ainsi un logiciel externe ne sera pas nécessaire.

PNG (*.png)

Le format PNG (Portable Network Graphics) est un format d'image bitmap largement soutenu par les
logiciels sur Windows, Mac OS et Linux.

Ce format d'image est particulièrement populaire sur internet. Un export d'une partition de plusieurs
pages produit un fichier PNG par page. MuseScore créé des images de la partition telle qu'elle serait
sur une page imprimée. Dans l'onglet Exporter du menu Édition → Préférences... (Mac: MuseScore →
Préférences...),
vous pouvez définir la résolution et éventuellement utiliser un arrière-plan transparent.

Si vous souhaitez créer des images comportant seulement des parties de la partition, avec ou sans
des éléments visibles seulement à l'écran, tels que cadres, notes invisibles, et notes extrêmes
colorées, utilisez la Capture d'image.

SVG (*.svg)

Le format SVG (Scalable Vector Graphics) peut être ouvert par la plupart des navigateurs internet (à
l'exception d'Internet Explorer antérieur à la version 9) et la plupart des logiciels de graphisme
vectoriel. Cependant, la plupart des logiciels de SVG ne supporte pas les polices intégrées, de sorte
que les polices de MuseScore appropriées doivent être installées pour afficher correctement ces
fichiers.

Écouter (export seulement)

WAV audio (*.wav)

WAV (Waveform Audio Format) est un format audio non compressé.

Ce format a été développé par Microsoft et IBM, et est largement supporté par les logiciels sur
Windows, Mac OS et Linux. C'est un format idéal pour la création de CD puisque la qualité sonore est
préservée. Cependant les fichiers sont de grandes tailles, il est difficile de les partager via email ou
sur internet.

FLAC audio (*.flac)

FLAC (Free Lossless Audio Codec) est un format audio compressé sans perte.

Les fichiers FLAC ont une taille d'environ la moitié de celle de l'audio non compressé et sont
exactement de la même qualité. Windows et Mac OS n'ont pas de support intégré pour FLAC, mais
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des logiciels tels que "VLC" ou "Media Player" peuvent les lire sur tous les systèmes d'exploitation.

Ogg Vorbis (*.ogg)

Ogg Vorbis est conçu comme un remplaçant sans brevet du populaire format audio MP3.

Tout comme les MP3, les fichiers Ogg Vorbis sont relativement petits (souvent un dixième d'un fichier
audio non compressé), mais il y a une perte de qualité sonore. Windows et Mac OS n'ont pas de
support intégré pour le Ogg Vorbis. cependant, des logiciels tels que "VLC" ou "Media Player" peuvent
les lire sur tous les systèmes d'exploitation.

MP3 (*.mp3)

Les fichiers MP3 sont relativement petits (souvent un dixième d'un fichier audio non compressé), mais
il y a une perte de qualité sonore.

Pour pouvoir créer des fichiers MP3, une librairie additionnelle, lame_en.dll (Windows) ou
libmp3lame.dylib (Mac) doit être installée. À la prochaine tentative d'exportation en MP3, MuseScore
vous invitera à préciser la localisation de cette librairie. Vous pouvez l'obtenir ici :
http://lame.buanzo.org/.

Certains utilisateurs Mac peuvent rencontrer avec MuseScore une erreur de chargement de la librairie
MP3. Le problème peut être dû au fait que cette librairie est une librairie 32-bits. Une version 64-bits
qui fonctionnera avec MuseScore est disponible à partir de:
http://www.thalictrum.com/en/products/lame.html (notez qu'il est nécessaire de renommer le fichier
dans libmp3lame.dylib afin que MuseScore le reconnaisse).

Partager avec d'autres logiciels de notation musicale

MusicXML (*.xml)

MusicXML est la norme universelle pour les partitions.

C'est le format recommandé pour partager les partitions entre les différents logiciels de notation
musicale, tels que Sibelius, Finale, et plus de 100 autres.

MusicXML compressé (*.mxl)

Le format MXL (MusicXML compressé) créé des fichiers plus petits que le format MusicXML habituel.

Ce format est plus récent et n'est pas largement supporté par les autres logiciels de notation
actuellement.

MIDI (*.mid, *.midi, *.kar)

MIDI (Musical Instrument Digital Interface) est un format largement supporté par les séquenceurs et
autres logiciels musicaux.

Les fichiers MIDI sont conçus à des fins de lecture et ne contiennent pas d'informations de mise en
page telles que le formatage, ornements, articulations, les répétitions, ou les armures, entre autres.
Pour partager des fichiers entre différents logiciels de notation musicale, MusicXML est plus
approprié. Si vous êtes uniquement intéressé par la lecture, préférez le format MIDI.

MuseData (*.md) (import seulement)

MuseData est un format développé par Walter B. Hewlett depuis 1983 comme un moyen de partager
la notation musicale entre logiciels.

Il a depuis été éclipsé par le format MusicXML, mais plusieurs milliers de partitions dans ce format,
sont encore disponibles en ligne.

Capella (*.cap, *.capx) (Import seulement)

Les fichiers CAP et CAPX sont créés par le logiciel de notation "Capella".
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MuseScore importe les fichiers depuis les versions 2000 (3.0) ou ultérieures de façon assez précise
(2.x ne fonctionne pas, tandis que le format *.all des versions 1.x versions n'est pas supporté du
tout).

Bagpipe Music Writer (*.bww) (import seulement)

Les fichiers BWW sont créés par le logiciel de notation, "Bagpipe Music Writer".

BB (*.mgu, *.sgu) (import seulement)

Les fichiers BB sont créés par le logiciel d'arrangement musical, "Band-in-a-Box".

Le support de MuseScore est encore expérimental.

Overture (*.ove) (import seulement)

Les fichiers OVE sont créés par le logiciel de notation "Overture".

Ce format est surtout populaire dans les environnements en langue chinoise, en Chine continentale, à
Hong Kong et à Taiwan.

Le support de MuseScore est encore expérimental.

Guitar Pro (*.GTP, *.GP3, *.GP4, *.GP5, *.GPX) (Import seulement)

Les fichiers GP sont créés par le logiciel de notation Guitar Pro.

Voir aussi

Enregistrer/exporter/imprimer

Une question sans réponse ? Postez la sur le forum.

Inspecteur et propriétés d'objet
Beaucoup d'éléments de la partition peuvent être édités de deux façons :

Sélectionnez n'importe quel élément, et la plupart de ses propriétés pourront être vues et
changées dans l'inspecteur sur le côté droit de l'écran.

Clic droit sur n'importe quel élément, et choisissez une option avec le mot propriétés pour ouvrir
une boite de dialogue avec des propriétés avancées.

L'inspecteur
L'inspecteur est affiché par défaut à droite de l'écran. Pour le voir/cacher, cochez/décochez Affichage
> Inspecteur, ou utilisez le raccourci F8 (Mac: fn+F8).

Dans l'inspecteur, les propriétés de n'importe quel élément peuvent être vues et éditées.
Plusieurs éléments peuvent être sélectionnés et édités en même temps s'ils sont du même type ; s'ils
sont de types différents, l'inspecteur ne vous permettra d'en éditer que la visibilité et la couleur.

Le panneau de l'inspecteur peut être décroché et devenir une fenêtre flottante en cliquant le double
chevron (<>), ou en double-cliquant en haut du panneau de l'inspecteur.

Pour le raccrocher faites la même manœuvre. Voir aussi Modes d'affichage.

Les catégories dans l'inspecteur

Quand vous sélectionnez un élément de la partition, les propriétés disponibles pour édition sont
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regroupées en catégories, qui sont identifiables dans l'inspecteur par leur nom centré et écrit en gras.

Par exemple, si vous sélectionnez une "barre de mesure", vous pouvez voir en haut de l'inspecteur la
catégorie "Élément" :

Pour voir plus précisément comment ajuster les propriétés de divers éléments, veuillez vous référer
aux sections dédiées du manuel.

Voici ce que nous propose l'inspecteur :

Élément

Tous les éléments de la partition exceptés les cadres, affichent cette catégorie dans l'inspecteur.
Vous pouvez y ajuster la visibilité, la couleur, le positionnement (décalage vertical/horizontal) et
l'alignement sur la grille.

Les options sont :

Visibilité : Vous pouvez agir sur la visibilité de l’élément sélectionné en cochant ou décochant la
case "visible", pour qu'ils n'apparaissent pas à l'impression ni à l'importation en PDF. Les
éléments invisibles sont "grisés" à l'écran, mais si vous voulez ne plus les voir, décochez
Affichage → Affichez les éléments invisibles.
Vous pouvez aussi utiliser la touche V pour rendre la sélection visible/invisible.

Couleur : Cliquez dans le rectangle noir (couleur par défaut) pour ouvrir la boîte "sélection de la
couleur", où vous pourrez également ajuster la transparence des éléments de la sélection.

Décalage horizontal / vertical : permet d'ajuster finement le positionnement de(s) l'élément(s)
sélectionné(s), en agissant sur les décalages par rapport à la position par défaut.

Groupe d’éléments

Cette catégorie est affichée seulement pour la sélection d'éléments de différents types, et ne permet
d'éditer que la couleur, la transparence et la visibilité.

Segment

Cette catégorie est utilisée pour augmenter ou réduire l'espace avant ou après l'élément sélectionné
(clef, indication de mesure, note, silence, etc) sur la portée. Notez que tous les éléments indexés à la
sélection (texte de portée, paroles,etc) seront impactés.

Accord

Cette catégorie est affichée seulement pour la sélection de note. Les ajustements sur la sélection
seront répercutés sur toutes les notes (même voix) de l'accord.
Si vous voulez agir sur une seule note, utilisez la catégorie Élément (voir plus haut).
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Note

Cette catégorie permet de faire des changements sur une sélection de notes (pour la position des
notes—voir Élément). Les propriétés sont :

Petite: Diminue la taille de tête de note (paramètres des petites notes : Style → Général… →
Tailles…).
Groupe de tête : Voir Groupe de tête.
Type de tête : Voir Type de tête.
Tête de note en miroir,
Position du point : Automatique, haut ou bas.
Réglage du diapason :
Lecture : Décoché, rend la note muette.
Type de vélocité : Décalage ou personnalisé

Décalage : Détermine la "vélocité" en valeur relative par rapport à la valeur par défaut
(80).
Personnalisé : Détermine la "vélocité" en valeur absolue (0 à 127).

Vélocité : Ajuste la vélocité MIDI en fonction des paramètres précédents.
Fixer à la ligne : Si coché, la note est collée sur la 5ème ligne de la portée (ligne du haut).
Ligne : Réglage de hauteur de la note.

Sélection

Cette catégorie n'est affichée que pour la sélection de note. Elle permet de sélectionner précisément
la ou les parties voulues (point 1, point 2, point 3, crochet, hampe, ligature et division irrégulière).

Propriétés dans le menu contextuel
Les propriétés de certains éléments, disponibles par le menu contextuel (clic droit), viennent
compléter celles de l'inspecteur.

Note : Les propriétés du menu contextuel agissent uniquement sur la sélection, alors que les
styles agissent sur toute la partition.

Propriétés des articulations

Clic droit sur une articulation > propriétés des articulations... voir Articulations et ornements.

Propriétés du diagramme d'accord

Clic droit sur un diagramme d'accord> Propriétés du diagramme d'accord... (voir diagramme
d'accord ).

Propriétés des lignes

Clic droit sur une ligne > Propriétés de la ligne... Il y a les réglages sur le début / prolongement /
fin de la ligne, la taille et l'angle des crochets (réglages individuels), l’édition du texte de la ligne,
positionnement.
Clic sur ... pour accéder aux Propriétés du texte de ligne.
Voir Lignes spéciales et propriétés de ligne.

Propriétés de la mesure

Clic droit sur la partie vide d'une mesure Propriétés de la mesure...  Visibilité des portées, durée de
la mesure, répétition, numérotation et espacement.
Voir Propriétés de la mesure.

Propriétés de la portée
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Clic droit sur le nom de l'instrument ou sur la partie vide d'une mesure Propriétés de la portée...
permet d'ajuster les propriétés de la portée, mais aussi de l'instrument.
Plus de détails : Propriétés de la portée.

Propriétés du texte

Clic droit sur un élément "textes" Propriétés du texte....
Voir Style et propriétés de texte.
Note : Pour les éléments "textes" indexés aux lignes, voir plus haut.

Propriétés de l'indication de mesure

Clic droit sur l'indication de mesure Propriétés de l'indication de mesure...  Pour ajuster la valeur
réelle/affichée et l'apparence de l'indication de mesure, et des propriétés des groupes de notes.
Voir Indication de mesure.

Voir aussi

Opérations sur les mesures
Saisie des notes
Mise en page et formatage
Propriétés de la portée
Extraction des parties séparées

Une question sans réponse ? Postez la sur le forum.

Les plugins

Généralités

Les plugins sont des bouts de code qui ajoutent des fonctionnalités particulières à MuseScore. Les
plugins activés (utilisables) apparaissent dans le menu plugins, et peuvent être appliqués à la partition
ou à une (des) partie(s).

Le développement de plugin est un moyen abordable pour les utilisateurs ayant peu de
connaissances en programmation, pour ajouter de nouvelles fonctionnalités à MuseScore (voir la
documentation).

MuseScore contient des plugins pré-installés par défaut, vous pouvez en trouver beaucoup d'autres
sur le site de MuseScore : https://musescore.org/plugins , pour votre version de MuseScore.

Installation

Le format natif des plugins est .qml pour les versions 2.0 et + (ou .js pour les versions antérieures),
ils sont souvent disponibles en format ZIP, téléchargez et/ou décompressez les dans l'un des
répertoires mentionnés plus bas.

Notez que certains plugins peuvent nécessiter l'installation d'autres composants (police ou autre),
vérifiez dans la documentation.

Une fois installé, un plugin doit être activé dans le menu général Plugins > Gestionnaire de plugins,
pour être utilisable, voir plus bas, Activer / désactiver les plugins.

Sur Windows

Les répertoires d'installation par défaut des plugins de MuseScore sont :

%ProgramFiles%\MuseScore 2\Plugins (ou %ProgramFiles(x86)%\MuseScore 2\Plugins pour la version
64) et
%LOCALAPPDATA%\MuseScore\MuseScore 2\plugins sur Vista, Seven et 10 ou
C:\Documents and Settings\USERNAME\Local Settings\Application Data\MuseScore\MuseScore
2\plugins (adjusted to your language version) sur XP.

Pour installer de nouveaux plugins, les répertoires cités au-dessus ne doivent pas être utilisés ou
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modifiés. Utilisez plutôt %HOMEPATH%\Documents\MuseScore2\Plugins, ou spécifiez un autre répertoire
dans les Préférences.

Sur macOS

Sur macOS, le répertoire d'installation par défaut des plugins de MuseScore est :
/Applications/MuseScore 2.app/Contents/Resources/plugins (pour faire apparaître les fichiers dans
le bundle des applications, cliquez droit sur MuseScore 2.app et choisissez "montrer le contenu des
packets") et
~/Library/Application Support/MuseScore/MuseScore 2/plugins.

Pour installer de nouveaux plugins, les répertoires cités au-dessus ne doivent pas être utilisés ou
modifiés. Utilisez plutôt ~/Documents/MuseScore2/Plugins, ou spécifiez un autre répertoire dans les
Préférences.

Sur Linux

Sur Linux, le répertoire d'installation par défaut des plugins de MuseScore est :
/usr/share/mscore-2.0/plugins et
~/.local/share/data/MuseScore/MuseScore 2/plugins.

Pour installer de nouveaux plugins, les répertoires cités au-dessus ne doivent pas être utilisés ou
modifiés. Utilisez plutôt ~/Documents/MuseScore2/Plugins, ou spécifiez un autre répertoire dans les
Préférences.

Activer / désactiver des plugins

Pour utiliser des plugins, vous devez d'abord les activer dans le menu Plugins > Gestionnaire de
plugins .

Créer / Éditer / Lancer des plugins

Il est possible de créer de nouveaux plugins ou de modifier un plugin existant via le menu Plugins >
Créateur de plugins :
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Là aussi, vous trouverez de la documentation (F1).

Plugins pré-installés par défaut

Certains plugins sont pré-installés dans MuseScore, mais ne sont pas activés par défaut. Voir plus
haut → Activer / désactiver des plugins pour les activer.

ABC Import

Ce plugin pré-installé, exporte du texte au format ABC depuis un fichier ou depuis le presse papier
(connexion internet requise) vers un service web externe pour la conversion abc en xml et obtenir par
retour, le code en MusicXML pour l'importer dans MuseScore.

Break Every X Measures

Retour à la ligne toutes les X mesures : Ce plugin (présent jusqu'à la V2.0 bêta) n'est plus présent en
temps que plugin dans les versions récentes de MuseScore. Il a été intégré à MuseScore V2.0 et +,
dans le menu Édition → Outils → Ajouter / Supprimer les sauts de lignes.

Il générait des sauts de systèmes (retour de charriot) à intervalle choisi, sur une plage de mesures, ou
à défaut de sélection, sur toute la partition.

Notes → Color Notes

Ce plugin pré-installé, colore les notes d'une plage sélectionnée (ou de toute la partition), en fonction
de leur hauteur, selon la convention Boomwhackers, dans toutes les portées et toutes les voix.
Chaque demi-ton a une couleur différenciée (Do♯ et Ré♭, même combat).
Pour remettre toutes les notes en noir, appliquez le plugin à nouveau sur la même sélection. Vous
pouvez aussi utiliser un autre plugin fait pour cela : Remove Notes Color.

Create Score
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Ce plugin pré-installé, crée une nouvelle partition pour piano avec 4 quarters C D E F. C'est un bon
début pour apprendre à créer une partition et ajouter des notes depuis un plugin.

helloQml

Ce plugin pré-installé, montre quelques tâches basiques.

Notes → Note Names

Ce plugin pré-installé, nomme les notes d'une plage sélectionnée (ou de toute la partition). Le texte
est de style texte de portée selon la régionalisation de MuseScore Paramètres linguistiques, au-
dessus la portée pour les voix 1 et 3, au-dessous la portée pour les voix 2 et 4, et pour les accords en
liste csv la note du haut en premier.

Panel

Ce plugin pré-installé, crée un panel graphique.

random

Crée une partition aléatoire.

random2

Crée aussi une partition aléatoire.

run

Ce plugin exécute une commande externe. Probablement seulement pour Linux.

scorelist

Ce plugin pré-installé, permet de iterates through the score list.

ScoreView

Ce plugin pré-installé, démontre l'utilisation d'un visualiseur de partition.

Walk

Ce plugin pré-installé, permet de cheminer à travers tous les éléments de la partition.

Voir aussi

Outils

Fichier attaché Taille
Plugin_Creator_en.png 37.56 Ko
Plugin_Manager_en.png 45.1 Ko
Une question sans réponse ? Postez la sur le forum.

Ligatures sur deux portées
Dans les partitions pour claviers, on utilise les deux portées pour écrire une seule phrase musicale.

Dans MuseScore Il suffit de procéder ainsi :

Entrer toutes les notes sur une seule portées:
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Ctrl+Maj+↓ déplace les notes (ou l'accord) sélectionné(es) dans la portée du dessous.(Mac: ⌘+Maj+↓.)

Il est possible de déplacer la ligature. Il suffit de double cliquer sur la ligature pour afficher les
poignées et ensuite de les déplacer pour ajuster la mise en page.

Note : Avec cette méthode, les notes descendues sur la portée du bas restent attachées à la portée
d'origine ; si des notes existent sur la portée cible elles ne bougent pas et l'écriture est rythmiquement
incohérente.

Voir aussi

Barres de mesure
Mode Édition

Une question sans réponse ? Postez la sur le forum.

Modes de saisie
Depuis MuseScore 2.1, en plus de Une à une et Changer les hauteurs, plusieurs nouveaux modes
de saisie de notes sont proposés ; ils sont maintenant tous regroupés dans un menu déroulant,
accessibles en cliquant sur la petite flèche, dans la barre d'outils principale (tout à gauche)

Une à une (défaut)
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C'est la méthode de base de saisie des notes dans MuseScore depuis l'origine. (Voir Saisie des
notes).

Entrez en mode Une à une en choisissant une durée par le clavier ou la souris, puis choisissez une
hauteur avec la souris, le clavier, le clavier MIDI ou le clavier du piano virtuel.

Changer les hauteurs

Le mode "Changer les hauteurs" vous permet de changer la hauteur des notes, sans affecter leur
valeur rythmique (durée).

Sélectionnez simplement une note de départ et entrez en mode Changer les hauteurs (avec la petite
flèche dans la barre d'outils principale). Maintenant, entrez les hauteurs en utilisant le clavier, le
clavier MIDI ou le clavier du piano virtuel.

Rythme

Le mode Rythme vous permet d'entrer les durées avec une seule touche. L'utilisation combinée des
modes Rythme et Changer les hauteurs est une méthode de saisie très efficace.

1. Sélectionnez votre point de départ et entrez en mode Rythme.
2. Sélectionnez une durée par le clavier 1/9 ou en cliquant sur un symbole de note dans la barre

d'outils principale. une note de la durée est ajoutée. Contrairement au mode basic note entry,
entrer un point bascule toutes les durées en valeur pointée, jusqu'à ce que vous entriez un autre
point pour rebasculer
. A note will be added to the score with the selected duration. In contrast to basic note entry,
pressing the dot will toggle dotting or not dotting all subsequent rhythms. All following rhythms
will be dotted until the dot is pressed again. Unlike basic note entry, the dot is to be pressed prior
to entering the duration.

3. Continue pressing duration keys to enter notes with the chosen durations.
4. Maintenant utilisez le mode Changer les hauteurs pour régler la hauteur des notes que vous

venez d'ajouter.

Temps réel (automatique)

En mode Temps réel, vous exécutez simplement votre morceau sur un clavier MIDI (ou avec le
clavier du piano virtuel) et MuseScore se charge d'écrire la partition pour vous. Cependant, gardez à
l'esprit ces quelques limitations :

Il n'est pas possible d'utiliser le clavier de l'ordinateur dans le mode Temps réel
Vous ne pouvez entrer des triolets ni des notes plus courtes que la durée sélectionnée
Vous ne pouvez entrer qu'une voix à la fois.

However, these restrictions mean that MuseScore has very little guessing to do when working out how
your input should be notated, which helps to keep the modes Temps réel accurate.

In the automatic version of entrée Temps réel input, you play at a fixed tempo indicated by a
metronome click. You can adjust the tempo by changing the delay between clicks via Edit →
Preferences...→ Note Input (Mac: MuseScore → Preferences...→ Note Input).

1. Select your starting position in the score and enter Temps réel (automatique) mode.
2. Select a duration from the note input toolbar.
3. Pressez et maintenez une touche MIDI ou du piano virtuel (a note will be added to the score).
4. Listen for the metronome clicks. With each click the note grows by the selected duration.
5. Release the key when the note has reached the desired length.

The score stops advancing as soon as you release the key. If you want the score to continue
advancing (e.g. to allow you to enter rests) then you can use le raccourci Temps réel avancé to start
the metronome.

Temps réel (manuel)

In the manual version of entrée Temps réel, you have to indicate your input tempo by tapping on a key
or pedal, but you can play at any speed you like and it doesn't have to be constant. The default key for
setting the tempo (called "Temps réel avancé") is Enter du pavé numéruque (Mac: fn+Entrée, but it is
highly recommended that you change this to a MIDI key or MIDI pedal (see below).
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1. Select your starting position in the score and enter Temps réel (automatique) mode.
2. Select a duration from the note input toolbar.
3. Pressez et maintenez une touche MIDI ou du piano virtuel (a note will be added to the score).
4. Pressez la touche Temps réel avancée. With each press the note grows by the selected

duration.
5. Release the note when it has reached the desired length.

Raccourci Temps réel avancé

Le raccourci Temps réel avancé is used to tap beats in manual mode Temps réel, or to start the
metronome clicks in automatic mode Temps réel. It is called "Temps réel avancé" because it causes
the input position to more forwards, or "advance", through the score.

The default key for Temps réel avancé is Entrée du pavé numéruque (Mac: fn+Entrée, but it is highly
recommended that you assign this to a MIDI key or MIDI pedal via MuseScore's MIDI remote control.
The MIDI remote control is available via Preferences > Note Input.

Alternatively, if you have a USB footswitch or computer pedal which can simulate keyboard keys, you
could set it to simulate Entrée du pavé numéruque.

Voir aussi

Saisie des notes
Copier / coller

Liens externes

Démarrer avec le nouveau mode "Changer les hauteurs" (YouTube)

Une question sans réponse ? Postez la sur le forum.

Notation pour musique ancienne

This translation is outdated, see the English version for a reference: Early music features

MuseScore, depuis la version 2.xx, propose des fonctions spécialisées d'édition pour les partitions de
styles anciens (médiéval et renaissance notamment) dans la veine des éditions commerciales du
XXème siècle.

Notation sans barre

Du fait que la plupart des partitions de la renaissance soit sans barre (non divisée en mesures), la
division des notes longues sur plusieurs mesures, remplacées par des liaisons de prolongation
traversant les barres, change radicalement l'apparence de la partition, rendant moins intuitive (voire
difficile) la perception des longues lignes mélodiques et des motifs répétés.

Cependant, MuseScore propose une méthode d'affichage expérimentale qui conserve les longueurs
de notes en l'état. Cette méthode peut être activée dans le menu Style → Général..., section
Partition en cochant l'option afficher les valeurs de note dépassant la mesure.
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Exemple pour Notation originale (De Profundis Clamavi pour 4 voix par Nicolas Champion) :

Avant le changement de style :

Clic Appliquer, et le style est immédiatement changé :

Note, la fonctionnalité est expérimentale et pourrait contenir des bugs. La note la plus longue
supportée est la longue (dès qu'elle est pointée, elle est divisée et les notes en résultant sont liées à
travers les mesures)
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Pour ne plus voir les barres, clic droit Propriétés de la portée, puis décochez "voir les barres".

Mensurstrich

Comme l'absence totale de barres de mesures compliquaient l'interprétation, les éditeurs
contemporains ont adopté le Mensurstrich, un compromis où les barres sont dessinées entre les
portées, et non sur les portées.

MuseScore le permet : double-clic sur une barre, maintenez Maj pendant que vous faites glisser la
poignée inférieure jusqu'au haut de la portée en-dessous, puis, toujours avec Maj, faites glisser la
poignée supérieure jusqu'au bas de la portée de départ, puis désélectionnez la barre pour appliquer à
toute la partition.

Note, c'est un exercice de précision, zoomez votre partition.

Pour que les barres reprennent leur position initiale (une par une), double-clic sur la barre puis :

Pour les barres de fin de ligne, maintenez Ctrl pendant que vous glissez une des poignées
vers sa position d'origine (nul besoin d'aller au bout), puis désélectionnez.
Pour les barres ordinaires, maintenez Maj pendant que vous glissez la poignée du haut
jusqu'au haut de la portée supérieure, puis Ctrl pendant que vous glissez la poignée du bas
jusqu'au bas de la portée supérieure.

Ambitus

Before there was the concept of an absolute pitch, performers were required to transpose vocal music
to a singable range for their ensemble on the fly. To aid them, an ambitus was sometimes included,
marking the entire range of a voice at the beginning of the piece. The ambitus is located in the palette
at the bottom of the Lines section, from there drag it onto a clef. It will automatically detect the range.

The ambitus will consider all measures of music up until the next section break, beyond which a new
ambitus may be applied. It can be adjusted manually or automatically in the Inspector. First select the
ambitus to adjust. For manual adjustments edit the top and bottom note values. For automatic
adjustment click the Update Range button in the inspector.

Mensural time signatures

In the mensural notation system, time signatures did not define the length of a measure, but the length
of breves and semibreves. MuseScore supports mensural time symbols as a display method in the
Time signature properties dialog rather than as symbols, but they are just for show, as the proportion
of e.g. half notes per whole notes cannot be modified.
One way to make use of these symbols is to replicate when composers of the renaissance had
multiple voices in different time signatures simultaneously without using tuplets. Edit the time
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signature on a per-staff basis, as long as the beginning and end of a measure in all staves match up. If
they do not, then consider increasing the size of the measures to the lowest common denominator.

De Profundis Clamavi pour 5 voix par Josquin Des Prez

Voir aussi

Opérations sur les mesures : Scinder et joindre

Une question sans réponse ? Postez la sur le forum.

Outils
Un certain nombre de commandes utiles peuvent être trouvées dans le sous-menu Édition → Outils.

Ajouter/Supprimer les sauts de ligne

Cet outil ajoute ou supprime les sauts de ligne de la sélection ou à défaut, de toute la partition.

1. Sélectionnez un groupe de mesures (si aucune sélection n'est active, la commande s'appliquera
à toute la partition).

2. Choisir Édition → Outils → Ajouter/Supprimer les sauts de ligne… . Le dialogue suivant
apparait :

3. Choisissez une des options suivantes :

Sauts de ligne toutes les X mesures (sélectionner un nombre).
Ajouter un saut de ligne à la fin de chaque système.
Retirez les sauts de lignes.

4. Pressez OK.

Éclater

La commande Éclater permet, sur un passage sélectionné sur une portée et sur la voix 1, de
répartir les notes des accords sur les portées inférieures. La plus haute note de chaque accord est
laissée sur la portée d'origine, et les notes suivantes (en descendant) sont réparties chacune sur une
portée inférieure (en créer si besoin : toucheI, puis choisir "Ajouter" (au milieu). Voir --> Ajuster la
partition après sa créations).

Pour éclater une portée (ou seulement une plage de mesures) :

1. Assurez-vous que toutes les notes soient en voix 1 (rien ne se passe si plusieurs voix existent) ;
2. Assurez-vous également qu'il y a suffisamment de portées vides juste en dessous (dans le
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même système), pour recevoir les notes ;

3. Choisir une des deux options :

Sélectionner une plage de mesures de la portée "source", permet d'éclater les notes, si il y
a suffisamment de portées disponibles.
Sélection d'une plage de mesures sur l'ensemble des portées (source et destination) :
Cela limite le nombre de notes éclatées au nombre de portées sélectionnées.

4. Choisir Édition → Outils → Éclater.

Notes:

Cette commande fonctionne au niveau de la mesure entière (même si la la mesure entière n'est
pas sélectionnée), et seulement sur des portées ne comportant qu'une voix.

Attention, si un accord a plus de notes qu'il n'y a de portées de destination, la ou les note(s) les
plus basses sont supprimées (sans avertissement) ; Ctrl+Z pour revenir en arrière.

Si un accord a moins de notes qu'il n'y a de portées de destination, la note la plus basse est
dupliquée autant de fois qu'il y a de portées supplémentaires dans la sélection.

La commande Éclater écrase les mesures recevant des notes.
Si le passage contient plusieurs voix, utilisez le Filtre de sélection pour couper/coller
(Ctrl+X/Ctrl+V) chaque voix sur une autre portée (d'un autre instrument du même système).

Rassembler

La commande Rassembler fait le contraire de Éclater :

Si plusieurs portées sont sélectionnées, toutes les notes des voix 1 sont copiées sur la
portée du haut.
Si seulement une portée est sélectionnée, toutes les notes (insensible aux voix), sont
combinées en voix 1

Note : Pour que 'Rassembler' fonctionne de manière optimale, la source et la cible doivent avoir le
même modèle rythmique

Rassembler depuis plusieurs portées

1. Sélectionner une plage de mesures dans une portée et étendre la sélection vers le bas, pour
inclure les autres portées devant être Rassemblées.

2. Choisir Édition → Outils → Rassembler.

Les notes des voix 1 sont copiées sur la portée supérieure de la sélection.

Rassembler depuis une seule portée

1. Sélectionner une plage de mesures de la portée désirée.
2. Choisir Édition → Outils → Rassembler

Toutes les notes sélectionnées dans la portée passent en voix 1.

Remplir avec des slashs

Cette commande remplit la sélection avec des slashs, un à chaque battement. Pour les mesures
normales (vides), les slashs sont ajoutés en voix 1.
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Si la sélection contient des notes, la commande mettra les slashs dans la première voix vide
disponible.
Si toutes les 4 voix sont utilisées, la voix 1 sera écrasée avec des slashs.
Les slashs des voix 1 et 2 sont centrés sur la portée tandis que les slashs des voix 3 et 4
apparaissent en petite taille au-dessus et au-dessous de la portée.
Les slashs ne sont pas joués par l'outil lecteur et ne sont pas transposables.

Activer la notation rythmique avec des slashs

Cette commande bascule les notes sélectionnées en notation rythmique : des notes avec des têtes en
forme de slash. Pour les notes en voix 1 ou 2, elles sont fixées à la ligne centrale de la portée.

Pour les notes des voix 3 ou 4, elles sont transformées en petites notes avec des têtes en slash et
positionnées au-dessus ou au-dessous de la portée (aka "accent" notation).

Le Filtre de sélection peut vous aider à exclure les voix 1 et 2 de la sélection avant d’exécuter la
commande, pour que seules les notes des voix 3 et 4 soient affectées.

Dans les portées pour percussions, les notes en voix 3 et 4 ne sont pas converties en petits slashs
mais en petites notes, respectivement au-dessus et au-dessous de la portée.
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Remettre les repères dans l'ordre

Les repères ajoutés via la palette sont automatiquement nommés selon la séquence (lettres ou
chiffres) choisie pour le repère précédent.

La commande du menu Édition → Outils → Remettre les repères dans l'ordre , vous permet de
changer tous les noms des repères en une fois, pour qu'ils soient ordonnés ; tous en lettres ou tous
en nombres, et/ou pour corriger des incohérences apparues après des changements.

Qu'elle soit sur une plage de mesures ou sur toute la partition, une sélection est nécessaire pour
activer la commande.

MuseScore détecte automatiquement la séquence du premier repère de la sélection, et met tous les
repères en conformité ; la séquence pouvant être :

a, b, c,
A, B, C,
Séquence numérique simple - 1, 2, 3,
Numérique, correspondant aux numéros des mesures.

Copier les paroles dans le presse-papier

Cette commande copie toutes les paroles de la partition, vous pouvez ensuite les réutiliser dans un
autre document.

Voir aussi

Sauts et espacements
Repères

Une question sans réponse ? Postez la sur le forum.

Palette Principale
La Palette Principale permet d’accéder à de vastes ressources pour alimenter vos partitions, vos
palettes personnalisées, et pour créer vos propres "indications de mesure" et "armures".

Allez à affichage → Palette Principale ou le raccourcis Maj+F9 (Mac: fn+Shift+F9).
Au survol des symboles avec la souris, apparaissent de courtes définitions sur fond jaune.
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Symboles

La section Symboles de la Palette Principale contient des centaines de symboles.
Vous pouvez l'ouvrir directement en pressant la touche Z.

Trouver un symbole

Les symboles sont listés dans leurs polices musicales respectives : utilisez le menu des polices en
bas à droite puis specifiez Emmentaler, Gonville ou Bravura.
Vous pouvez utiliser la boîte de recherche en haut de la fenêtre, en entrant un mot-clé.
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Utiliser un symbole

Par glisser/déposer, ou en sélectionnant une ou un groupe de notes ou de silences et en double
cliquant sur le symbole.
L'ajustement peut se faire par Inspecteur (F8).

Note : Les éléments de la section "symboles" n'ont pas de règle de positionnement (contrairement à
beaucoup d'éléments des autres sections de la palette principale).

Fusion de symboles

Les éléments de la section symboles peuvent être fusionnés dans la partition et ainsi être manipulés
comme un nouveau symbole et même être importés dans une Palettes personnalisées :

1. Déposez un premier symbole, ajustez la position, couleur...
2. Déposez un deuxième symbole au même endroit, ajustez la position...
3. Glissez/déposez le premier symbole, le deuxième symbole suit.

Voir aussi

Palettes
Palettes personnalisées

Une question sans réponse ? Postez la sur le forum.

Propriétés de la Partition
Plusieurs balises méta sont générées lors de la création d'une partition, d'autres peuvent être créées
plus tard.
Les balises peuvent être utilisées dans les en-têtes et pieds de page.

Fichier → Propriétés de la Partition...  (Fichier → Info... pour les versions avant la 2.0.3),
affiche les valeurs des balises méta existantes.

Balises méta préexistantes

Chaque partition possède ces champs dans ses propriétés. Certains d'entre eux sont
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automatiquement renseignés lors de la création de la partition, alors que les autres demeurent vierges
jusqu'à leur édition manuelle.

Les 4 premiers champs de la fenêtre ne sont pas modifiables, ils ne peuvent pas non plus être utilisés
dans les en-têtes et pieds de page (ce ne sont pas à proprement parler des balises méta).

File Path : Adresse du fichier sur l'ordinateur.
MuseScore Version : Version de MuseScore avec laquelle la partition a été enregistrée.
Revision : La révision de la version de MuseScore avec laquelle la partition a été enregistrée.

API-Level : Format du fichier.

arranger : Arrangeur

composer : Compositeur, entré dans l' Assistant Nouvelle Partition et affiché dans le coin
inférieur droit du Cadre vertical de titre. Notez que, changer le nom du compositeur dans le
cadre de titre, ne sera pas répercuté ici.
copyright : Entré dans l'Assistant Nouvelle Partition. Le copyright apparaît comme un texte,
apparemment non éditable, dans le pied de page de la partition, mais il peut être édité ou
supprimé ici.
creationDate : Date de création, vide pour une partition enregistrée en mode test (voir Options
de la ligne de Commande).
lyricist : Parolier, entré dans l'Assistant Nouvelle Partition. (affiché dans le coin inférieur droit du
Cadre vertical de titre (Notez que, changer le nom du parolier dans le cadre de titre, ne sera
pas répercuté ici).
movementNumber : Vide
movementTitle : Vide

originalFormat : Indique si la partition est issue d'un autre format (voir Formats de fichier)

platform : Système d'exploitation utilisé : "Microsoft Windows", "Apple Macintosh", "Unix" ou
"Inconnu". vide dans le cas d'une partition enregistrée en mode test.

poet : (empty)
source: Peut contenir une URL si la partition provient de MuseScore.com.
translator : Traducteur
workNumber : vide
workTitle : Entré dans l'Assistant Nouvelle Partition et affiché comme "titre", dans le cadre de
titre (Notez que, changer le titre dans le cadre de titre, ne sera pas répercuté ici).

Chaque partie possède en plus la balise méta suivante, générée et renseignée lors de la création de
partie(s) :

partName : Renseignée avec le nom entré lors de la création de la partie. Le texte est affiché
comme "partie" dans le cadre de titre, (Notez que, changer le nom de la "partie" dans le
cadre de titre, ne sera pas répercuté ici).

Modifier une balise méta

Note : Pour éditer les balises d'une partition avec des parties liées, assurez-vous que la
partition/partie voulue a le focus (onglet actif).

Faites Fichier → Propriétés de la partition...  et vous pouvez éditer les champs.

Ajouter une nouvelle balise méta

Note : Pour éditer les balises d'une partition avec des parties liées, assurez-vous que la
partition/partie voulue a le focus (onglet actif).

Faites Fichier → Propriétés de la partition...  (Fichier → Info... pour les versions avant la
2.0.3) et cliquer Nouveau :
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Entrez le nom de la nouvelle balise puis OK. La balise sera ajoutée à la liste et vous pourrez la
renseigner.

En-têtes et pieds de page

Note : Pour créer un en-tête ou un pied de page dans une partition avec des parties liées, assurez-
vous que la partition (et pas une partie) a le focus (onglet actif).

Vous pouvez afficher le contenu des balises dans l'en-tête ou le pied de page de votre partition.

Faîtes Style → Général... pour ouvrir la fenêtre d'édition des styles, choisissez En-tête, Pied de
page, Nombres dans la liste de gauche.

Si vous survolez avec la souris une zone d'en-tête ou de pied de page, une liste de sigles spéciaux
apparait avec leurs significations ainsi que les balises méta existantes et leur description.

186



Vous pouvez utiliser ces balises (ex : $:workTitle:) et ces sigles spéciaux (ex : $M) dans les zones
appropriées pour ajouter l'information correspondante à l'en-tête ou au pied de page.

Cliquez OK pour valider, vous venez d'ajouter la "date de la dernière modification".

Appliquer, permet de voir, si l'en-tête ou le pied de page est visible derrière la fenêtre de style, le
résultat avant de valider.

Appliquer à l'ensemble des parties est accessible si une partie liée a le focus, et permet en un clic
d'appliquer les changements à toutes les parties.

Annuler permet de sortir sans appliquer les changements.

Voir aussi

Mise en page et formatage : En-têtes et pieds de page
Options de la ligne de commande : Mode test

Une question sans réponse ? Postez la sur le forum.

Propriétés de la portée

This translation is outdated, see the English version for a reference: Staff properties

Pour accéder à la boîte de dialogue Éditer les propriétés de la portée ou de la partie , clic droit sur
une ligne de la portée et sélectionner Propriétés de la portée... . Là, vous pouvez modifier
l'apparence de la portée, ajuster son accord et sa transposition, changer d'instrument, etc.
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En pratique, il existe quatre types de portée :

1a. Portée standard I. Pour tous les instruments (sauf les cordes frettées : pas de conversion
possible sans d'abord changer de type d'instrument).
1b. Portée standard II. Pour tous les instruments à cordes frettées ; avec choix du nombre de cordes
et accord. Possibilité de conversion en tablature ou ajout de tablature liée.
2. Tablature. Pour tous les instruments à cordes frettées.
3. Percussion. Pour tous les instruments à percussion.

Il est possible de changer le type de portée en ouvrant la fenêtre Instruments (I), les choix se
limiteront à ceux compatibles avec l'instrument renseigné.
Note, pour changer une portée standard en tablature, la portée doit être du type standard II.
De la même manière, pour changer une portée standard en portée pour percussions la portée doit
d'abord être définie pour un instrument à percussion.

La plupart des options sont communes à toutes les portées, mais chaque type de portée a une ou
plusieurs options spécifiques.

Propriétés de la portée (ou de la partie) - Options

Options communes de la boîte de dialogue Éditer les propriétés de la portée pour tous les types de
portées :

Lignes : Nombres de lignes.

Interligne : Distance entre deux lignes de portée, en Espace(s) de portée (abr. esp.). Il n'est pas
recommandé de changer cette valeur (1 par défaut) pour le groupe de style standard, changez
plutôt la valeur "espace de portée" de référence ; les autres groupes de styles peuvent avoir
d'autres valeurs (ex : Le groupe de style "Tablature" a une valeur de 1,5 esp. Voir Paramètres de
la page.

Distance supplémentaire au-dessus de la portée : Pour augmenter l'espace avec la portée
du dessus (dans tous les systèmes).
Dans la partition et dans un système, vous pouvez ajuster la distance entre 2 portées, pour
toute la partition : dans un espace vide de la portée Maj + cliquez/glissez vers le bas ou vers le
haut.
Pour modifier l'espace localement entre deux systèmes, voir Sauts et espacements).

Échelle : Change la taille de toute la partition en %.
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Ne jamais masquer :

Afficher la clef

Afficher l'indication de mesure

Afficher les barres de mesure

Masquer la barre de mesure du système : Cacher / voir la barre de mesure qui relie tous les
systèmes, à gauche.

Ne pas masquer si le système est vide:

Petite portée : Affiche de petites portées. Vous pouvez définir la taille par défaut : Style →
Général... → Tailles.

Lignes de portée invisibles

Couleur des lignes de portée

Groupe de style : "Standard" par défaut.

Nom de la partie : Également affiché dans le Mélangeur et dans la fenêtre Instruments (I).

Instrument : Instrument renseigné dans la portée. Le son associé peut être changé dans le
Mélangeur.

Nom long de l'instrument : Nom affiché avant le premier système de la partition.

Nom abrégé de l'instrument : Nom affiché avant les systèmes, sauf le premier.

Tessiture utilisable : Les notes en dehors de cette zone s'afficheront en rouge, si Mettre en
couleur les : notes extrêmes de l'étendu de l'instrument est coché (défaut ) dans Édition >
Préférences > saisie de notes.

Transposition à la lecture : Cette option permet de transposer la portée, à la lecture
seulement.
La transposition se fait en choisissant un intervalle, de l'unisson à l'octave, par 1/2 ton (+ octave
si besoin), en montant ou en descendant. Pour les instruments à cordes pincées cette option
permet de simuler un capodastre.

Propriétés de la portée : Options spécifiques aux instruments à cordes pincées

Nombre de cordes ... de l’instrument.

Éditer les paramètres des cordes… : Ouvre une boîte de dialogue Éditer les paramètres des
cordes.

Propriétés avancées de style

Propriétés avancées de style... ouvre la boîte de dialogue associée.

Illustrations suivant les différents types de portées :

Portée standard:
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Tablature onglet "Frettes" :
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Tablature onglet "figures de rythme" :

Modèles : Liste des modèles pouvant être appliqués à la portée courante.

Note: Each score is initially created with 17 pre-defined staff "templates" (not to be confused
with Templates): one standard, three percussion and 13 tablature templates. Each template
addresses a specific need, common enough or standardized enough to deserve a specific
template; each template can be modified (independently for each score staff) and new templates
can be created to accommodate specialized needs.

Restaurer par rapport au modèle , restaure toutes les propriétés par rapport au modèle.

Ajouter comme modèle, en cours d'implémentation.

OK, ferme la boîte de dialogue en validant les changements.

Annuler, ferme la boîte de dialogue sans tenir compte des changements.

Portée Standard pour Percussion - Options spécifiques
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Afficher l'indication de mesure

Afficher les lignes supplémentaires

Sans hampe (et sans crochet)

Tablature - Options spécifiques

Inverser Le sens des cordes de la tablature (décoché par défaut).

Indications de frette

les Indications de frette sont des nombres ou des lettres inscrits sur les lignes de la tablature.
Les nombres indiquent les numéros de frette où les doigts sont pressés pour obtenir les notes (0
à 19 pour les manches classiques, + pour les manches folks).
Les lettres de "a" à "r", "a" = 0, "b" = 1, et ainsi de suite sauf à "i" = 8 puis on saute "j", "k" =9,
etc.

Propriétés définissant l'apparence de la tablature :

Police : Pour le moment, 4 polices contenant tous les symboles nécessaires sont proposées :
MuseScore Tab Sans, MuseScore Tab Serif, MuseScore Tab Renaissance et MuseScore Tab
Late Renaissance, et dans les 3 styles (plus de choix dans le futur ou la possibilité d'utiliser des
polices custom).

Taille de la police en pts. Celles intégrées ont un bon rendu de 9 à 10 pts.

Décalage vertical : MuseScore essaie de positionner les symboles in a sensible way and this
value is usually not needed (set to 0) for built-in fonts. If the font has symbols not aligned on the
base line (or in some other way MuseScore does not expect), this value allows to move mark
symbols up (negative offsets) or down (positive offsets) for better vertical positioning. Values are
in sp.

Nombres / Lettres (Les repères sont des) : Quand des lettres sont utilisées, le "j" est sauté et

192



c'est le "k" pour la 9ème frette.

Sur les lignes / Au-dessus des lignes (Les repères sont représentés) :

Continues / Discontinues (Les lignes sont) : voir exemple dessous :

Exemple de chiffres sur lignes discontinues :

Exemple de lettres sur lignes continues :

Exemple de tablature inversée (même contenu que l'exemple avec chiffres au dessus):

Afficher les repères liés : If unticked, only the first note in a series of tied notes is displayed. If
ticked, all notes in the tied series are displayed.

Figures rythmiques

Ce groupe de propriétés définit l’apparence des symboles de figures rythmiques

Police : The font used to draw the value symbols. Currently 3 fonts are provided supporting all
the necessary symbols in 3 different styles (modern, Italian tablature, French tablature). More
fonts (or the possibility to use custom fonts) may be available in the future. Used only with the
Note symbols option.

Taille : The font size to use, in typographic points. Built-in fonts look usually good at a size of
15pt. Used only with the Note symbols option.

Décalage vertical : As for Fret Marks above, but referring to value symbols instead. Used only
with the Note symbols option.

Shown as : None : No note value will be drawn (as in the examples above)

Shown as : Note symbols : Symbols in the shape of notes will be drawn above the staff. When
this option is selected, symbols are drawn only when the note value changes, without being
repeated (by default) for a sequence of notes all of the same value.

Example of values indicated by note symbols :
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Shown as: Stems and beams : Note stems and beams (or hooks) will be drawn. Values are
indicated for each note, using the same typographic devices as for a regular staff; all commands
of the standard Beam Palette can be applied to these beams too.

Example of values indicated by note stems:

Repeat: Never / At new system / At new measure / Always
Whether and when to repeat the same note symbol, if several notes in sequence have the
same value (only available with the Note symbols option).

Beside staff / Through staff : Whether stems are drawn as fixed height lines above/below the
staff or run through the staff to reach the fret marks each refers to (only available with the Stems
and Beams option).

Above / Below staff : Whether stems and beams are drawn above or below the staff (only
available with the Stems and Beams option / Beside staff sub-option).

None / As short stems / As slashed stems : To select three different styles to draw stems for
half notes (only available with the Stems and Beams option / Beside staff sub-option).

Show rests : Whether note symbols should be used to indicate also the rests; when used for
rests, note symbols are drawn at a slightly lower position. Used only with the Note symbols
option.

Prévisualisation

Affiche un bout de tablature formaté en temps réel avec les paramètres choisis.

Changer d'instrument

Vous pouvez changer d'instrument dans une partition à n'importe quel moment.

La méthode suivante permet de changer en une seule fois, le son, le nom de la portée et la
transposition d'une portée.

1. Clic droit dans une partie vide de n'importe quelle mesure ou sur le nom de l'instrument et
choisir propriétés de la portée...

2. Clic sur Changer d'instrument... (bouton à droite)
3. Choisissez votre nouvel instrument puis OK pour retourner dans les propriétés de la portée.
4. Clic OK à nouveau pour retourner dans la partition.

Ne pas confondre avec Changement d'instrument en cours de portée.

voir aussi

How to turn a staff into an ossia.

Une question sans réponse ? Postez la sur le forum.

Préférences
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Vous voulez peut-être avoir un style général ou des dossiers présélectionnés quand vous utilisez
MuseScore.
Vous pouvez définir cela via Édition → Préférences... (Mac: MuseScore → Préférences...):

La fenêtre de "préférences" apparaîtra, avec ses onglets :

Certains changements nécessitent le redémarrage de MuseScore pour prendre effet (quittez et
relancez le programme). Une boite de dialogue vous l'indiquera lorsque vous cliquerez sur
[Appliquer] ou sur [OK].

[Rétablir toutes les préférences par défaut] les réinitialisera par celles que MuseScore avait
lorsque vous l'avez installé.
[Annuler] abandonne tous les changements que vous venez de faire et ferme la fenêtre.

Général

Ici vous pouvez définir :

La partition qui s'ouvre au démarrage
Le dossier par défaut pour ouvrir ou enregistrer vos partitions, banques de sons, modèles
La fréquence d'enregistrement automatique
La langue de MuseScore (les traductions peuvent être mises à jour à partir d'ici également)
Le style de votre fenêtre MuseScore et la taille des icônes.
Les fenêtres à afficher au démarrage (Fenêtre de lecture, Navigateur, MuseScore Connect).
Notez que les traductions linguistiques peuvent également être mises à jour via Aide →
Gestionnaire de ressources

Fond
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Utiliser cet onglet pour définir vos couleurs ou papiers peints préférées, pour la partition et pour
l'arrière-plan de la fenêtre principale.

Faire défiler les pages, vous permet de changer le mode de défilement par défaut, des pages de
votre partition, dans la fenêtre principale.

En dessous Divers, l'option Anticrénelage (activé par défaut) rend les lignes et les bords des formes
diagonales plus lisses (moins irrégulières). Proximité des éléments sélectionnés contrôle la distance
de laquelle la souris peut être d'un objet et agir encore sur elle. Une valeur petite demande plus de
précision, ce qui rend plus difficile la sélection de petits objets. Les valeurs plus grandes autorisent
moins de précision, mais rendent plus difficile de ne pas cliquer involontairement sur des objets
proches. Choisissez une valeur de travail confortable.

Saisie des notes
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Dans cet onglet se trouvent les préférences de saisie des notes et du contrôle du MIDI à distance :

Activer l'entrée MIDI
Jouer les notes pendant l'édition
Jouer l'accord entier lors de l'ajout d'une note
Mettre en couleur les notes au-dela de la gamme tonale utilisable
Contrôle à distance du MIDI

Partition

Les préférences de la partition comportent :
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Listes d'instruments par défaut
Style par défaut pour la partition et les parties séparées
Zoom par défaut

E/S

Entrée/Sortie (I/O imput/Output en anglais)

Import

Ces réglages définissent comment les fichiers provenant d'autres sources sont importés :
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Utiliser le style embarqué de MuseScore ou un style choisi
Définir les caractéristiques d'import des fichiers Guitar Pro et Overture
MusicXML : options de mises en page
Plus courte note en MIDI

Exporter

Ces réglages définissent comment les fichiers MuseScore sont exportés :

PNG/SVG résolution de l'image (en DPI) et si utiliser un fond transparent
Etendre les répétitions dans les fichiers MIDI exportés
Echantillonnage audio
Exporter la mise en page et comment exporter les sauts de système et de page en MusicXML

Raccourcis clavier
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Chaque action possible de MuseScore est listée, avec le raccourci clavier associé, s'il existe. En
utilisant le bouton "Définir", vous pouvez définir un nouveau raccourci pour une action. Vous pouvez
utiliser jusqu'à 4 touches pour définir un raccourci.
Vous pouvez également rétablir les raccourcis par défaut, ou effacer un raccourci que vous auriez
sélectionné.

(À noter que quelques raccourcis, incluant certains par défaut, ne peuvent pas être utilisés avec
certains claviers. À tester.)

Mises à jour
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Définit si MuseScore doit vérifier les mises à jour au démarrage.

Les mises à jour peuvent être vérifiées manuellement dans Aide → Rechercher les mises à jour

Voir aussi

Paramètres linguistiques et mises à jour des traductions
Rechercher des mises à jour

Une question sans réponse ? Postez la sur le forum.

Récupération de fichiers après un crash
Lors du redémarrage du logiciel, après un crash de MuseScore ou de votre ordinateur, ou en cas de
coupure électrique, vous devriez voir la fenêtre suivante, vous demandant si vous voulez restaurer la
session précédente :

Si vous cliquez Non, tout le travail de votre dernière session sera perdu, Si vous cliquez Oui,
MuseScore essaiera de récupérer les fichiers qui étaient ouverts au moment du crash.

Méthode pour sauvegarder des partitions après une session de récupération

Quand MuseScore récupère des partitions après un crash, il les renomme avec le chemin complet
in front of the original file name. This very long name will appear in the tab(s) above the active score
window. On some operating systems, when a user saves any of these recovered files, it will be saved
in the folder in which the program itself is running. This is not necessarily the same directory in
which the scores were saved when they were created. You may not be able to locate the
revised file in the usual folder.

Pour éviter cela, n'utilisez pas la fonction "Enregistrer", mais "Enregistrer sous...", avant de
retravailler sur vos partitions, pour les enregistrer dans leur nom d'origine (ou un autre nom) ; vous
aurez accès à une boîte de dialogue qui vous permettra de naviguer vers l'emplacement d'origine.
Cela vous permettra de retrouver vos partitions à l'endroit où elles sont censées être.

Retrouver les partition récupérées et enregistrées automatiquement

Au cas où vous auriez utilisé la fonction "Enregistrer" au lieu de "Enregistrer sous..." (voir
paragraphe précédent), allez dans le menu "Fichier > Partitions récentes", voir si elles ne sont pas
dans la liste ; si non, vous pourriez les trouver, suivant le système d'exploitation utilisé :

Windows 7, répertoire C:\Program Files (x86)\MuseScore2\bin (dans le cas d'une installation
standard de MuseScore).

Windows 10, répertoire C:\Users\[User Name]\AppData\Local\VirtualStore\Program Files
(x86)\MuseScore 2\bin

Si aucune des méthodes précédentes ne vous permet de localiser vos fichiers, vous devrez faire une
recherche globale sur votre disque, en utilisant des parcelles de nom de partition et en vous aidant le
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cas échéant de jokers (*)

Voir aussi

Enregistrer / Exporter / Imprimer

Liens externes

Comment retrouver la copie de sauvegarde d'une partition

Une question sans réponse ? Postez la sur le forum.

Têtes de notes
Une quantité de têtes de note alternatives – en plus de la "normale" – peuvent être trouvées dans la
palette Têtes de note de l'Espace de travail avancé et via l'Inspecteur (voir Changer de groupe de
têtes de note, ci-dessous).
Note : Le style de tête de note varie en fonction de la police choisie (Emmentaler, Gonville ou
Bravura), la palette montre par défaut la police "Bravura"..

Groupes de tête de note

MuseScore supportes plusieurs styles de têtes de note :

Normal : Forme standard.
Croix (Ghost note) : Notation pour percussions (cymbales). Signifie aussi étouffé (angl. muted)
pour les instruments à cordes comme la guitare.
Diamant : Utilisé pour les harmoniques pour les instruments à cordes (guitare, violon, etc).
Slash : Utilisé pour la notation rythmique.
Triangle : Utilisé en notation pour percussions.
Notes de formes géométriques : Do, Ré, Mi, Fa, Sol, La, Si.
Croix cerclée : Utilisé en notation pour percussions.
Alt. Brevis : Utilisé en notation ancienne
Parenthèses : Elles s'appliquent autour de la note (ou de l'altération).

Changer de type de tête de note

Vous pouvez être amené à changer la durée d'une note sans changer son apparence, ou
inversement, pour cohérence d'écriture :

1. Sélectionner une ou plusieurs notes,

2. Choisir une des options suivantes de l'inspecteur sous Note → Type de tête :

Auto : La durée correspond à l'apparence.
Note carré : Double ronde.
Ronde :
Blanche :
Noire :

Changer de groupe de têtes de notes

Pour changer l'apparence d'une ou plusieurs têtes de note, procédez comme suit :

Sélectionnez une ou plusieurs notes et double cliquez une tête de note dans la palette têtes de
note.
ou
Glissez une tête de note depuis la palette têtes de note sur une note de la partition.
ou
Sélectionnez une ou plusieurs notes et changez la tête de note dans l'inspecteur, option Note →
Groupe de tête (non supporté sur les portées pour percussion).

Têtes de notes partagées
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Il est fréquent de partager des têtes de notes dans l'écriture pour guitare, lorsque des notes dans
différentes voix tombent sur le même battement.

Par défaut MuseScore partage les têtes :

des notes de même durée (sauf les rondes),

des notes avec "têtes noires" (toutes les deux pointées ou aucune des deux pointées).

Si seulement l'une des deux notes est pointée, ou si l'une d'elles n'est pas une "tête noire", alors
MuseScore décale les deux notes :

Ce décalage peut être facilement modifié en créant une tête de note invisible, en la sélectionnant et
en utilisant le raccourci clavier V, ou en décochant l'option "Visible" dans l'Inspecteur ; ou en altérant le
type de tête de note pour qu'elle corresponde à la plus longue (dans la section "Note" de l'Inspecteur,
changez le paramètre "Type de tête" de "Automatique" à "Blanche").

Les têtes de notes partagées dans une portée classique sont converties en deux notes séparées dans
une portée de tablature liée. Pour corriger cela, masquez simplement une des notes dans la portée de
tablature avec le raccourci clavier Vou en décochant l'option "Visible" dans l'Inspecteur.

Une question sans réponse ? Postez la sur le forum.

Nouvelles fonctionnalités de MuseScore 2
Pour une vue d'ensemble des nouveautés, voir :

Changements dans MuseScore 2.0.
Nouveautés de MuseScore 2.0,
Notes de version pour MuseScore 2.0,
Notes de version pour MuseScore 2.0.1,
Notes de version pour MuseScore 2.0.2,
MuseScore 2.0.2 is released,
Notes de version pour MuseScore 2.0.3,
MuseScore 2.0.3 est sortie, et
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Documentation of new features are available in the chapter they belong to logically (except the one
that is referring to upgrading from 1.x) , but for users coming from 1.x here's a collection of links to be
able to see at a glance what can be done now...

voir aussi

Album (→Fonctionnalités avancées)
Modes d'affichage : Vue continue et Navigateur (→Bases)
Copier - Coller : Filtre de sélection (→Bases)
Palette personnalisée (→Fonctionnalités avancées)
Early music features (→Fonctionnalités avancées)
Basse continue (→Fonctionnalités avancées)
Aligner des éléments (→Text)
Capture d'écran (→Formatting)
Inspecteur et propriétés d'objet (→Fonctionnalités avancées)
Opérations sur les mesures : Scinder et joindre (→Bases)
Import MIDI (→Son et lecture)
Changement d'instrument en cours de portée (→Son et lecture)
Extraction des parties séparées (→Fonctionnalités avancées)
Repères : génération de repère automatique et Recherche de repère (→Text)
Enregistrer/exporter/imprimer (→Bases)
Propriétés de la portée (→Fonctionnalités avancées)
Swing (→Son et lecture)
Tablature (→Fonctionnalités avancées)
Espaces de travail (→Bases)
Palette Principale (→Fonctionnalités avancées)
Mise en page et formatage (quelques options ont changée, et une nouvelle : "appliquer à toutes
les parties") (→Formatage)
Sauts et espacements : Saut de section (→Formatage)
Nouvelle option : Modes de sélection : Sélectionner tous les éléments similaires (même sous-
type) (→Bases)
Centre de démarrage : Créer une nouvelle partition (→Bases)
Paramètres linguistiques et mise à jour des traductions (→Bases)
Aider et améliorer la traduction (→Support)
Altérations : Recalculer les altérations (→Notation)
Changer les hauteurs des notes sans changer le rythme (→Fonctionnalités avancées)
Outils (→Fonctionnalités avancées)
Propriétés de la Partition (→Fonctionnalités avancées)

Une question sans réponse ? Postez la sur le forum.

Support
This translation is outdated, see the English version for a reference: Support

Ce chapitre décrit comment trouver de l'aide pour utiliser MuseScore : le meilleur endroit où regarder,
la meilleure manière de poser une question sur le forum, et des conseils pour signaler un bug.

Aider et améliorer la traduction
Avez-vous une traduction à ajouter ? Cela peut se faire facilement via internet, comme indiqué dans
Développement / Traduction ...

Traduction du logiciel

1. Demander le droit de modification sur le forum Traduction
2. Connectez-vous à Transifex/MuseScore http://translate.musescore.org, qui vous redirigera sur

https://www.transifex.com/projects/p/musescore
3. Sélectionnez la langue et la section pour lesquelles vous souhaitez apporter votre aide

(musescore ou instruments)
4. Cliquez sur le bouton "Traduire" (le texte du bouton dépend de votre langue...)
5. Recherchez les "chaînes" que vous voulez traduire (vous pouvez filtrer les chaînes déjà

traduites)

Ici vous trouverez une explication technique (en anglais) : Continuous translation for MuseScore 2.0
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Traduction du site et du manuel en ligne

Voir aussi Translation instructions

Voir aussi

Paramètres linguistiques et mise à jour des traductions

Une question sans réponse ? Postez la sur le forum.

Incompatibilités connues

Incompatibilités matérielles

Le matériel suivant est connu pour faire crasher MuseScore au démarrage :

Microphone USB Samson, nom du driver "Samson ASIO Driver", samsonasiodriver.dll. Plus
d'infos
Digidesign MME Refresh Service. Plus d'infos
Windows XP SP3 + Realtek Azalia Audio Driver. Plus d'infos
Wacom tablet. Plus d'infos et QTBUG-6127

Incompatibilités logicielles

Maple virtual cable is known to prevent MuseScore from closing properly.
Les paramètres de la fenêtre de KDE (Linux) peuvent provoquer le déplacement de la fenêtre
entière lorsque l'on fait glisser une note. Changer les paramètres de la fenêtre du système
d'exploitation permet d'éviter ce problème.

AVG Internet Security bloque MuseScore

MuseScore a besoin d'accéder à votre connexion internet avec AVG. MuseScore n'a pas besoin d'une
connexion internet pour fonctionner, mais si AVG bloque la connexion, MuseScore se bloque.

Si AVG vous y invite, Autorisez MuseScore et cochez la case "Enregistrer ma réponse comme règle
permanente et ne pas reposer la question la prochaine fois."

Si vous n'y êtes plus invité :

1. Ouvrez l'interface utilisateur d'AVG (clic droit sur l'icône AVG, vers votre horloge -> Ouvrir
l'interface utilisateur AVG

2. Cliquez sur Pare-feu
3. Cliquez sur Paramètres avancés
4. Cliquez sur Applications
5. Trouvez le fichier MSCORE.EXE dans la liste et double-cliquez dessus
6. Modifiez Application Action pour Autoriser pour tout

Problème de polices sous Mac OS X

MuseScore est connu pour afficher les notes sous forme carrée lorsque certaines polices sont
endommagées sous Mac OS X. Pour résoudre ce problème :

1. Allez dans Applications -> Livre des polices
2. Sélectionnez une police et appuyez sur ⌘+A pour les sélectionner toutes
3. Allez dans Fichier -> Valider les polices
4. Si une police est mentionnée comme endommagée ou comportant des problèmes mineurs,

sélectionnez-la et supprimez-la
5. Redémarrez MuseScore si nécessaire

Dans cet article du forum, un utilisateur croit avoir identifié la police "Adobe Jenson Pro (ajenson)"
comme la coupable, indépendamment du fait qu'elle ne soit pas mentionnée comme endommagée ou
problématique via la validation. Il a résolu le problème en supprimant cette police, cela vaut donc la
peine d'être vérifié.
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Problème de polices sous Linux

Si la police de l'environnement du bureau est réglée sur gras, MuseScore n'affichera pas les notes
proprement. Pour résoudre ce problème (utilisateurs de gnome 2.*/MATE) :

1. Faites un clic droit sur le bureau et sélectionnez Changer l'arrière-plan du bureau
2. Cliquez sur l'onglet Polices
3. Définissez le style Régulier pour la police d'application
4. Redémarrez MuseScore si nécessaire

Pour les utilisateurs de GNOME 3/SHELL :

1. Ouvrez le shell puis "Paramètres avancés"
2. Dans la liste, cliquez sur l'option Polices
3. Définissez la police par défaut sur une police non gras
4. Redémarrez MuseScore si nécessaire

Fenêtre de dialogue "Enregistrer sous" vide sous Linux

Certains utilisateurs rapportent que la fenêtre de dialogue "Enregistrer sous" est vide sous Debian 6.0
et Lubuntu 10.10.
Pour résoudre ce problème :

1. Entrez la commande suivante dans un terminal :

which mscore

2. La commande retournera le chemin de mscore. Éditez-le avec votre éditeur de texte préféré et
ajoutez la ligne suivante au début :

export QT_NO_GLIB=1

Lancez MuseScore et le problème devrait être résolu.

Une question sans réponse ? Postez la sur le forum.

Appendices
Accessibilité

This translation is outdated, see the English version for a reference: Accessibility

Introduction

Ce chapitre est destiné aux utilisateurs de MuseScore 2.0, aveugles ou mal voyants, et n'a pas
vocation à fournir une description exhaustive des possibilités du logiciel ; la lecture du reste de la
documentation reste indispensable.

MuseScore est fourni avec le support partiel pour le projet libre et open source Lecteur d'Écran NVDA
sur Windows.
Les fonctionnalités décrites dans ce document ont été testées avec NVDA sur un système Windows. Il
n'y a pour le moment, aucun support pour les autres lecteurs d'écran comme Jaws sur Windows, ou
VoiceOver sur macOS, qui pourraient fonctionner différemment, voire pas du tout.

Dans ce contexte, MuseScore 2.0 est plus un lecteur qu'un éditeur de partition. Le présent chapitre se
concentrera sur les fonctionnalités de lecture avec seulement quelques fonctionnalités d'édition de
partition

Premier lancement de MuseScore

Au premier démarrage de MuseScore, vous devriez désactiver une fois pour toutes le "Centre de
démarrage". Pour ce faire, allez dans le menu Édition (Alt puis É), puis préférences, décochez
Afficher le centre de démarrage puis OK.

Se repérer dans l'interface de MuseScore
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L'interface de MuseScore fonctionne de manière similaire à celles de tous les programmes d'édition de
partitions ou de documents, avec :

Une fenêtre principale, dans laquelle vous pouvez travailler sur votre partition ;
Des onglets, pour naviguer entre les partitions ;
La possibilité de diviser la fenêtre principale en deux parties ajustables (cote à cote ou empilées)
pour voir et travailler en même temps sur deux partitions. Chacune possédant son propre niveau
de zoom et un accès à tous les onglets ;

Une barre principale de menus accessibles par les raccourcis claviers (insensibles à la casse) :

Fichier : Alt+F
Édition : Alt puis É
Affichage : Alt+A
Ajouter : Alt+J
Notes : Alt+N
Mise en page : Alt+M
Style : Alt+S
Plugins : Alt+P
Aide : Alt+D

Le menu Fichier est celui qui nous intéressera ici, pour une utilisation de MuseScore en tant que
lecteur de partition.

Une fois le menu ouvert avec le raccourci, chaque pression sur Haut ou Bas permet de naviguer dans
les sous-menus.

Vous avez également des barres d'outils, des palettes et des sous-fenêtres à l'intérieur desquelles
vous pouvez vous déplacer par la touche Tab (ou Maj+Tab pour revenir en arrière dans le même cycle).

Quand vous démarrez MuseScore, ou que vous ouvrez une partition, le focus devrait être sur la
fenêtre principale.
La touche Tab vous permet d'accéder aux boutons (icônes) de la barre d'outils principale : Ouvrir,
Nouveau, Imprimer et ainsi de suite.

Les noms et les raccourcis pour ces boutons (s'ils existent) devraient être lus par votre lecteur d'écran
.

Après la dernière icône de la barre d'outils principale, le cycle de Tab continue sur le panneau latéral
Palettes. Cela devrait être utilisé pour ajouter divers éléments depuis une palette sur la partition, mais
ça n'est pas encore fonctionnel excepté pour le sélecteur d'espace de travail et le bouton + pour
ajouter un espace de travail personnalisé.

l'inspecteur ou le filtre de sélection sont visités, par le cycle de la touche Tab.

Vous pouvez fermer les panneaux superflus par le menu principal Affichage .

You can close windows you do not need by going to the View menu and making sure none of the first
set of checkboxes are selected (the windows that appear before the Zoom settings). By default, only
the Palette, Navigator and MuseScore Connect should be selected, and the latter two are not included
in the Tab order.

Pour ramener le focus sur la fenêtre principale, pressez Échapp ; toute sélection dans la partition s"en
trouvera désactivée.

La fenêtre principale

Quand vous démarrez MuseScore 2.0 pour la première fois, une partition de démonstration nommée
“My First Score” est chargée et vous pouvez expérimenter des actions d'édition, c'est le bon endroit
pour commencer.
Si non, vous pouvez charger la partition de votre choix.

MuseScore utilises les raccourcis claviers standards pour accéder aux boites de dialogue du système
comme :

Ctrl+O (Mac : Cmd+O) pour ouvrir une partition via la fenêtre de dialogue standard "ouvrir...".
Ctrl+S (Mac : Cmd+S) pour enregistrer la partition en cours ;
Ctrl+N (Mac : Cmd+N) pour créer une nouvelle partition,
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Ctrl+W (Mac : Cmd+W) pour fermer l'onglet actif (partition).

Au-delà de ses formats natifs '.MSCZ' et '.MSCX', MuseScore peut ouvrir des partitions dans les
formats : MusicXML, '.MID' (midi), '.GPx' (Guitar Pro 1, 2, 3, x), '.CAPX' (Capella), et Band-in-a-Box.

Chaque chargement de partition se fait dans un nouvel onglet. Vous pouvez naviguer entre les
différents onglets avec le raccourci clavier Ctrl+Tab (non applicable sur Mac).

Une fois que vous avez chargé une partition, il y a diverses choses simples et intéressantes à faire,
avant de rentrer dans les détails :

Espace, pour jouer la partition.

Menu Fichier > exporter, permet de convertir le fichier vers des formats tels que PDF, PNG,
WAV, MP3, MIDI, MusicXML, etc.

Et bien sûr, vous pouvez lancer l'impression via Fichier > Imprimer ou avec Ctrl+P (Mac :
Cmd+P).

If a score contains multiple instruments, it may already have linked parts generated. Linked parts are
presented as part tabs within score tabs, but currently, there is no way to navigate these part tabs
using the keyboard. The parts would not normally contain information different from the score; they
would just be displayed differently (each part on its own page). If a score does not already have parts
generated, you can do so through File / Parts, and that dialog is accessible. If you wish to print the
parts, you can work around the inability of accessing part tabs individually by using the File / Export
Parts dialog, which automatically exports PDF’s (or other formats) for all parts in one step.

Lire la partition - Lecture de la partition - Exploration de la partition

Sitôt une partition chargée, la fenêtre principale a le focus du clavier, c.a.d que vous pouvez agir sur la
partition depuis le clavier ; mais rien n'est sélectionné. Ctrl+Home (Mac : Cmd+Home) vous permet de
sélectionner le premier élément de la partition, probablement la clef de la portée supérieure.

Pendant votre exploration, votre lecteur d'écran devrait vous dire le nom de l'élément sélectionné et sa
position ; par exemple, “clef de Sol, mesure 1, temps 1, portée 1”. La quantité et l'ordre dans lequel
les informations sont données, ne sont pas personnalisables, mais nous avons essayé de placer le
plus important en premier, vous permettant soit de vous déplacer sans attendre la fin de la description
soit de l'interrompre par Maj.

La navigation dans MuseScore est centrée sur les notes et les silences (et les éléments qui y sont
attachés) – sans tenir compte des voix, clefs, armures, indications de mesure, barres de mesure et
autres éléments. Donc si pour vous déplacer dans la partition vous utilisez les touches standards
Droite et Gauche, seuls les notes et les silences vous seront cités. Cependant, il y a deux commandes
spéciales que vous devriez trouver utiles pour explorer la partition au plus près des détails :

Élément suivant : Ctrl+Alt+Maj+Droite (Mac: Cmd+Option+Maj+Droit)
Élément précédent : Ctrl+Alt+Maj+Gauche (Mac: Cmd+Option+Maj+Gauche

Ces commandes permettent en plus, de naviguer entre les voix, les clefs et les autres éléments qui
sont évités par la navigation de base (Droite et Gauche) qui ne permet pas de sortir de la voix dans
laquelle vous êtes, until you explicitly change voices.
Par exemple, si vous êtes sur une noire, temps 1, mesure 1, et qu'il y a 2 voix dans cette mesure,
Droite vous déplace à la prochaine note/silence en voix 1 —qui est en temps 2—alors que
Ctrl+Alt+Maj+Droite (Mac : Cmd+Option+Maj+Droite) reste au temps 1 et saute en voix 2 (voix de la
sélection +1).

C'est seulement quand vous aurez fini d'explorer le "temps 1, mesure x" de la portée, que vous
passerez au temps 2, mesure x et ainsi de suite.

Le but de ce raccourci est de naviguer verticalement à un instant de la partition, sans en connaitre le
détail.

When you navigate to an element, your screen reader should read information about it. For notes and
rests, it will also read information about elements attached to them, such as lyrics, articulations, chord
symbols, etc. For the time being, there is no way to navigate directly to these elements.
One important note: Haut and Bas by themselves, with Maj, or with Ctrl / Cmd are not useful shortcuts
for navigation! Instead, they change the pitch of the currently selected note or notes. Be careful not to
inadvertently edit a score you are trying to read. Haut et Bas should only be used with Alt/Option if
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your intent is navigation only. See the list of navigation shortcuts below.

Se déplacer en avant ou en arrière dans le temps

Les commandes suivantes sont très utiles pour se déplacer "horizontalement" dans une partition.

Élément suivant : Ctrl+Alt+Maj+Droit
Élément Précédent : Ctrl+Alt+Maj+Gauche
Prochain accord ou silence : Droit
Accord ou silence précédent : Gauche
Prochaine mesure : Ctrl+Droit
Mesure Précédente : Ctrl+Gauche
Aller à la mesure N° : Ctrl+F
Premier élément : Ctrl+Home
Dernier élément : Ctrl+Fin

Déplacements entre les notes d'un accord - Moving between notes at a given point in time.

Les raccourcis clavier suivants sont très utiles pour vous déplacer “verticalement” dans la partition :

Élément suivant : Ctrl+Alt+Maj+Droit.
Élément précédent : Ctrl+Alt+Maj+Gauche.
Note suivante au-dessus dans la voix, la voix précédente ou la portée au-dessus : Alt+Haut.
Note suivante en dessous dans la voix, la voix suivante ou la portée au-dessous : Alt+Bas.
Note la plus haute de l'accord : Ctrl+Alt+Haut.
Note la plus basse de l'accord : Ctrl+Alt+Bas.

Les commandes Alt+Haut et Alt+Bas sont similaires aux commandes Ctrl+Alt+Maj+Droit et
Ctrl+Alt+Maj+Gauche dans le sens où elles sont prévues pour vous aider à découvrir le contenu de la
partition.
En utilisant ces commandes, vous n'avez pas besoin de savoir de combien de notes est constitué un
accord ni de savoir combien il y a de portées dans la partition pour vous déplacer verticalement.

Filtrer l'exploration de la partition

Exclure certains éléments comme les paroles ou les noms d'accord pendant l'exploration est
possible en utilisant le Filtre de sélection (F6). Décochez les éléments que vous ne voulez pas
explorer.

Joueur de partition - Lecteur de partition

La touche Espace démarre / arrête la lecture (playback)
La lecture commence à la note sélectionnée, ou à la dernière note +1 de la lecture précédente
(poursuivre) si aucune sélection n'est active ou alors au début de la partition dans les autres cas.

MuseScore supporte la lecture de boucles programmables, vous pouvez donc lire une portion
choisie de la partition, en boucle. Pour définir les bornes de cette boucle, procédez comme suit :

1. Dans la partition sélectionnez la note du début de la boucle ;
2. Allez dans la "Fenêtre de lecture" (F11) et cliquez sur " Définir la position initiale de la boucle

" ;
3. Retournez sur la partition et sélectionnez la dernière note de la boucle ;
4. À nouveau dans la "Fenêtre de lecture" cliquez sur " Définir la position finale de la boucle " ;
5. Pour activer / désactiver la fonction de lecture en boucle cliquez sur le bouton idoine (entre les

deux bornes de la boucle).

Dans la fenêtre de lecture (F11), vous pouvez également contrôler le tempo ainsi que le volume
sonore, tout deux en % des valeurs de la partition.

Éditer une partition

L'édition de partition, dans le contexte qui nous occupe, n'est pas chose aisée – trop d'éléments
nécessitent une action de la souris pour leur positionnement sur la partition. De plus, des références
visuelles et des ajustements fins de position d'éléments sont parfois nécessaires, dû à la capacité
limité de MuseScore à éviter les conflits entre des éléments très proches.
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In contrast, MuseScore does often provide ample default, and a platform to experiment with the basics
of note input.
To enter note input mode, first navigate to the measure in which you would like to enter notes, then
press N. Almost everything about note input is designed to be keyboard accessible, and the standard
documentation should be good to help you through the process. Bear in mind that MuseScore can
either be in note input or normal mode, and it won’t always be clear which mode of these you are in.
When in doubt, press Esc. If you were in note input mode, this will take you out. If you were in normal
mode, you will stay there, although you will also lose your selection.

Personnalisation

Vous pouvez adapter les raccourcis clavier par le menu Édition > Préférences > raccourcis clavier.
Nous pourrions mettre à disposition un ensemble de raccourcis clavier optimisés et une solution pour
les enregistrer dans un fichier pour réemploi.

Une question sans réponse ? Postez la sur le forum.

Glossaire

This translation is outdated, see the English version for a reference: Glossary

Le glossaire est en constante évolution, vous pouvez aider si vous le voulez. Pour en discuter,
allez sur la page documentation forum.
La liste suivante est un glossaire de termes souvent utilisés dans MuseScore, avec leur signification.
Les versions américaines et anglaises sont respectivement notées "(AE)" et "(BE)".

Acciaccatura : Les fioritures courtes sont représentées par une petite note barrée d'un trait sur
sa hampe. Elles sont placées avant la note de taille normale.
A short →fioritures.

Accidental : Altération accidentelle : Les altérations accidentelles les plus communes sont →le
dièse, →le bémol ou →le bécare, le double dièse et double bémol sont également utilisés.
C'est un signe qui précède une note et qui augmente ou diminue sa hauteur et ce jusqu'à la fin
de la mesure en cours, ou jusqu'à une autre altération accidentelle.
In notes tied across a →barline, the accidental continues across the →barline to the tied note,
but not to later untied notes on the same →staff position in that measure.

Anacrusis (BE) : See →Pickup Measure.

Anchor : Ancre, point d'attache de symbole dans la partition (texte, lignes, etc)
The point of attachment to the score of objects such as Text and Lines: When the object is
dragged, the anchor appears as small brown circle connected to the object by a dotted line.
Depending on the object selected, its anchor may be attached to either (a) a note (e.g. fingering),
(b) a staff line (e.g. staff text), or (c) a barline (e.g. repeats).

Appoggiatura : Fioritures longues, ne sont pas barrées. Elles sont placées avant la note de taille
normale.
A long →fioritures.

Bar (BE) : See →Measure.

Barline : Barre de mesure, ligne verticale délimitant les mesures, les portées ou tout le système.

Beam : Notes with a duration of an →eighth or shorter either carry a →flag or a beam. Beams
are used for grouping notes.

BPM : (B)attements (P)ar (M)inute est l'unité pour mesurer le tempo.
Voir →Metronome mark

Breve : Brevis : A double whole note or breve is a note that has the duration of two whole
notes.

Chord : Accord, groupe de deux notes au moins, jouées ensemble.
MuseScore however calls even a single note a chord internally, with the note describing the
pitch, the chord decribing the duration. Chords are based on the choices made by a composer
between harmonics of one, two or three (and more) fundamental sounds. E.g. in the chord of C,
G is the second harmonic, E the fourth of the fundamental C. Now in C7, the B flat is the 6th
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harmonic of C and in C Maj7 B is the second harmonic of E and the fourth harmonic of G...

Clef : Symbole en tout début de →portée, elle sert à identifier les hauteurs de notes.

Fa, 2 clefs, 3ème et 4ème ligne ;
Ut, 4 clefs, 1ère, 2ème,3ème et 4ème ligne et
Sol, 2 clefs, 1ère et 2ème ligne (aka treble)
Les clefs de Sol 1ère ligne et Fa 4ème ligne sont équivalentes.
Les clefs sont très pratiques pour la transposition.

Concert Pitch : Tonalité de concert
:Enables you to switch between concert pitch and transposing pitch (see Concert pitch and
Transposition).

Crotchet (BE) : Croche :A crotchet is the British English term for what is called a quarter note in
American English. It's a quarter of the duration of a whole note (semibreve).

Demisemiquaver (BE) : A thirty-second note.

Duplet : Duolet, voir →Tuplet.

Eighth note : A note whose duration is an eighth of a whole note (semibreve). Same as British
→quaver.

Endings : See →Volta.

Enharmonic notes : Notes that sound the same pitch but are written differently. Example: G# and
Ab are enharmonic notes.

Flag : See →Beam.

Flat : Bémol (symbole), altération qui baisse la note de 1/2 ton

Grace note (angl. Grace note) : Fioritures
acciaccatura
appoggiatura

Grand Staff (AE), Great Stave (BE) : Système de deux portées utilisé pour les partitions de
claviers et de harpe.

Half Note : A note whose duration is half of a whole note (semibreve). Same as British →minim.

Hemidemisemiquaver (BE) : A sixty-fourth note.

Key signature : Armure (ou armatures), ensemble des altérations dièse(s) ou bémol(s) au début
de la portée, juste après la clef. L'armure est valide pour toute la partition, sauf si il y a d'autres
sections avec un changement d'armure et sauf si on rencontre une altération accidentelle.
Elle donne une idée de la tonalité et évite la profusion d'altérations accidentelles.
Une armure avec si bémol (si bémol à la clé) signifie "fa majeur" ou "ré mineur"

Koron : An Iranian →accidental which means lower in pitch and it lowers a note by a quarter tone
(in comparison to the →flat which lowers a note by a semitone). It is possible to use this
accidental in a →key signature.
See also →Sori.

Longa : A longa is a quadruple whole note.

Ledger Line : Line(s) that are added above or below the staff.

Measure (AE) : Mesure, segment de portée.
Dividing music into bars provides regular reference points to pinpoint locations within a piece of
music.

Metronome mark : Tempo texte de tempo.
are usually given by a note length equaling a certain playback speed in →BPM.
In MuseScore, metronome marks are used in tempo texts.

Minim (BE) : A minim is the British term for a half note. It has half the duration of a whole note
(→semibreve).
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Natural : Bécarre (symbole), annule l'effet d'une altération.

Operating System : Système d'exploitation
Underlying set of programs which set up a computer, enabling additional programs (such as
MuseScore). Popular OSes are Microsoft Windows, macOS, and GNU/Linux.
Not to be confused with a sheet music →System.

Part : Partie,
Music to be played or sung by one or a group of musicians using the same instrument. In a
string quartet, 1st part = Violin 1, 2nd part = Violin 2, 3rd part = Viola, 4th part = Cello, in a choir
there might be parts for soprano, alto, tenor and bass. A part has one or more →staves (e.g.
Piano has 2 staves, Organ can have 2 or 3 staves).

Pickup Measure (→Anacrusis) : Incomplete first measure of a piece or a section of a piece of
music.
See also Create new score: Time Signature... and Measure operations: Exclude from measure
count.

Quaver (BE) : The British quaver is what is called an →eighth note in American English. It has
an eighth the duration of a whole note.

Quadruplet : See →Tuplet.

Quarter note : A note whose duration is a quarter of a whole note (semibreve). Same as British
→crotchet.

Quintuplet : See →Tuplet.

Respell Pitches : Tries to guess the right accidentals for the whole score (see Altérations).

Silence : Silence, d'une durée spécifiée selon le symbole.
Les silences sont : La pause, la 1/2 pause, le soupir, le 1/2 soupir, le 1/4 de soupir, le 1/8 de
soupir, le 1/16 de soupir...

Re-pitch Mode : Changer les hauteurs des notes sans changer le rythme
A way in MuseScore to rewrite a passage with note changes but no rhythm change

Semibreve (BE) : A semibreve is the British term for a whole note. It lasts a whole measure in
4/4 time.

Semiquaver (BE) : A sixteenth note.

Semihemidemisemiquaver (Quasihemidemisemiquaver) (BE) : An hundred and twenty eighth
note.

Sextuplet : See →Tuplet.

Sharp : Dièse, altération (symbole) qui augmente la note de 1/2 ton.
Voir aussi →Bémol.

Slur : Liaison de phrasé, ligne courbe entre plusieurs notes ; ces notes doivent être jouées
harmonieusement (legato).
Voir aussi →Liaison de prolongation.

Sori : An Iranian →accidental which means higher in pitch and it raises a note by a quarter tone
(in comparison to the sharp which raises a note by a semitone). It is possible to use this
accidental in a →key signature.
See also →Koron.

Spatium (pluriel: Spatia) : Espace de portée, esp. (abbr./unit)
Distance entre les lignes d'une portée standard (5 lignes). Dans Musescore, c'est l'unité de
référence.
Voir aussi →Layout and Formatting, Layout / Page Settings.

Portée : ligne ou groupe de ligne (max 5) utilisées pour écrire les figures de notes. En notation
ancienne (avant le XIe siècle), le nombre de lignes n'était pas limité à 5.

System : un système est l'ensemble des portées jouées en même temps.
Voir aussi →Système d'exploitation (OS).
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Tie : Liaison de prolongation, ligne courbe entre plusieurs notes de même hauteur, une seule
note est jouée, de la somme des durées des notes liées.

Deux noires liées = une blanche
Une noire et une croche liées = une noire pointée
Une noire, une croche et une double-croche liées = une noire double pointée
Voir aussi →Liaison de phrasé.

Transposition : A tune can be played in any tonality. There are many reasons to change the
tonality of a score:

1. The tune is too low or too high for a singer.
2. The score is written for a C instrument and has to be played by a B Flat one.
3. The score is written for an orchestra and you want to imagine what the horn, the flute and

the clarinet are playing.
4. A darker or a more brilliant sound is desired.

In the first case all the orchestra will have to transpose, which is very difficult without
professional musicians. MuseScore can do it very easily for you.
In the second case the musician must play D when a C is written. If the score is written
with a G 2nd Clef, he'll have to think that the staff begins with a C 3rd Clef.
In the third case the conductor has to transpose all the staves which are not written for C
instruments.
In all cases the key signature must be mentally changed.
On some instruments (Horns and Tubas for instance) the musicians transpose using
alternative fingerings.

Tuplet : Triolet
A tuplet divides its next higher note value by a number of notes other than given by the time
signature. For example a →triplet divides the next higher note value into three parts, rather than
two. Tuplets may be: →triplets, →duplets, →quintuplets, and other.

Velocity : The velocity property of a note controls how loudly the note is played. This usage of
the term comes from MIDI synthesizers. On a keyboard instrument, it is the speed with which a
key is pressed that controls its volume. The usual scale for velocity is 0 (silent) to 127
(maximum).

Voice : Voix
Polyphonic instruments like Keyboards, Violins, or Drums need to write notes or chords of
different duration at the same time on the same →staff. To write such things each horizontal
succession of notes or chords has to be written on the staff independently. In MuseScore you
can have up to 4 voices per staff. Not to be confused with vocalists, singing voices like soprano,
alto, tenor and bass, which are better viewed as instruments.

Volta : In a repeated section of music, it is common for the last few measures of the section to
differ. Markings called voltas are used to indicate how the section is to be ended each time.
These markings are often referred to simply as →endings.

Liens externes

http://www.robertcarney.net/musical-terms-definitions.htm

Une question sans réponse ? Postez la sur le forum.

Limitations connues de MuseScore 2.1
Même si tous les membres de l'équipe de développement font de leur mieux pour rendre le logiciel
facile à utiliser et sans bug, MuseScore 2.0 comporte quand-même quelques limitations connues.

Indications de mesure locales

La fonction d'indications de mesure locales, qui vous permet d'avoir des indications de mesure
différentes dans différentes portées au même temps, est très limitée. Vous pouvez seulement ajouter
une indication de mesure locale dans des mesures vides, et uniquement si elles ne comportent pas de
parties liées. Lors de l'ajout des notes dans des mesures comportant des indications de mesure
locales, vous pouvez entrer les notes normalement via le mode de Saisie des notes, mais le
copier/coller ne fonctionne pas correctement et peut engendrer des corruptions voire un crash. Les
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commandes Joindre les mesures et Scinder la mesure  sont désactivées pour les mesures
comportant une indication de mesure locale.

Regrouper les rythmes

La commande Regrouper les rythmes du menu Mise en page pourrait avoir des effets inattendus,
notamment :

Par le renommage des notes par leur enharmonique ;
Par la suppression (perte) d'éléments tels articulations, glissandos, tremolos, fioritures, liaisons
de prolongation...

Ne l'utilisez qu'avec précautions et sur une sélection limitée, de telle façon que vous puissiez
visualiser rapidement une éventuelle perversion.

Portée tablature liée à une portée standard

Avec les portées tablature et standard liées, si plusieurs accords sont entrés dans la portée standard,
chaque accord doit être saisi de haut en bas, sinon les cases assignées automatiquement note par
note dans la portée tablature risquent de ne pas correspondre.

À noter que cela ne s'applique pas à des notes saisies directement dans la portée tablature ni à des
notes saisies dans une portée standard non liée à une tablature : dans les deux cas l'ordre de saisie
est indifférent.

Changement d'instrument

Le changement d'instrument ne modifie pas la transposition, même si l'un des instruments l'exige. Si
c'est un besoin spécifique, il est nécessaire d'utiliser des portées différentes avec l'option Masquer les
portées vides. En fait, ce n'est pas un vrai changement d'instrument, juste un changement du son
pour le rendu audio lors de la lecture. Par conséquent, il n'y pas que la transposition qui n'est pas
prise en compte, mais aussi l'étendue de l'instrument et le nom de la partie.

Mélangeur

Dans le mélangeur, changer les valeurs autres que le son (par le sélecteur d'instruments), n'affecte
pas définitivement la partition, dans le sens où si vous fermez la partition, vous n'aurez pas
l'avertissement Enregistrer les modifications de la partition avant de fermer ?. De plus, la
commande Édition > Annuler (Ctrl+Z) ne fonctionne pas pour les valeurs changées dans le
mélangeur.

En-tête et Pied de page, Nombres

Il n’est pas possible d'éditer en WYSIWYG l'en-tête et le pied de page. Les champs dans Style →
Général → En-tête, Pied de page, Nombres, sont en texte brut. Ils peuvent contenir une syntaxe
proche du HTML, mais le style de texte, la mise en page, etc, ne peuvent être édités avec un éditeur
WYSIWYG.

Une question sans réponse ? Postez la sur le forum.

Raccourcis clavier
La plupart des raccourcis clavier peuvent être personnalisés via le menu Édition → Préférences →
onglet Raccourcis (Mac : MuseScore → Préférences → onglet Raccourcis).

Voir Préférences : Raccourcis clavier

Ci-dessous une liste des raccourcis définis par défaut :

Navigation

Aller au début de la partition Home
Aller à la dernière page de la partition Fin
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Rechercher (numéro de mesure, repère, ou pXX si XX est un numéro de page): Ctrl+F (Mac :
⌘+F)

Partition (onglet) suivante Ctrl+Tab

Partition (onglet) précédente Maj+Ctrl+Tab

Zoom avant : Ctrl++ (ne fonctionne pas sur certains systèmes) (Mac : ⌘++) ou Ctrl (Mac : ⌘) +
molette en avant

Zoom arrière : Ctrl+- (Mac : ⌘+-) ou Ctrl (Mac : ⌘) + molette en arrière

Page précédente / suivante : Page haut / Page bas ou Maj + molette

-----------------------------------> : Molette (avec l'option Faire défiler les pages > Verticalement).

Mesure suivante : Ctrl+→ (Mac : ⌘+→)

Mesure précédente : Ctrl+← (Mac : ⌘+←)

Note suivante : →

Note précédente : ←

Note du dessus (à l'intérieur d'un accord ou dans la portée du dessus) : Alt+↓

Note du dessous (à l'intérieur d'un accord ou dans la portée du dessous) : Alt+↑

Note supérieure d'un accord : Ctrl+Alt+↑ (Ubuntu uses this shortcut for Workspaces instead)

Note inférieure d'un accord : Ctrl+Alt+↓ (Ubuntu uses this shortcut for Workspaces instead)

Saisie des notes

Activer le mode de Saisie des notes : N
Quitter le mode de Saisie des notes : N ou Échap

Valeurs rythmiques

1 ... 9 sélectionne la valeur rythmique. Voir aussi Saisie des notes.

Diviser par deux la valeur rythmique de la note précédente : Q

Doubler la valeur rythmique de la note précédente : W

Diminuer la durée d'une note, par un point : successivement, une noire pointée devient une
noire, puis une croche pointée, puis une croche et ainsi de suite ; disponible depuis la version
2.1 : Maj+Q

Augmenter la durée d'une note, par un point : successivement, une noire devient une noire
pointée, puis une blanche, puis une blanche pointée et ainsi de suite), disponible depuis la
version 2.1 : Maj+W

Voix

Voix 1 : Ctrl+I Ctrl+1 (Mac : ⌘+I ⌘+1)
Voix 2 : Ctrl+I Ctrl+2 (Mac : ⌘+I ⌘+2)
Voix 3 : Ctrl+I Ctrl+3 (Mac : ⌘+I ⌘+3)
Voix 4 : Ctrl+I Ctrl+4 (Mac : ⌘+I ⌘+4)

Hauteurs

Les hauteurs de notes peuvent être entrées par la lettre correspondant à leur nom selon la
notation anglo-saxonne (A-G), ou via un clavier MIDI. Voir Saisie des notes pour obtenir plus de
détails à ce propos.*
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Répéter la note ou l'accord précédent : R (the repeat can be of a different note value by selecting
duration beforehand)

Répéter une sélection : R (La sélection sera répétée à partir de la position de la note qui suit la
fin de la sélection.

Augmenter la hauteur d'une octave : Ctrl+↑ (Mac : ⌘+↑)

Abaisser la hauteur d'une octave : Ctrl+↓ (Mac : ⌘+↓)

Augmenter la hauteur d'un demi-ton (préférence aux dièses) : ↑

Abaisser la hauteur d'un demi-ton (préférences aux bémols) : ↓
Augmenter la hauteur diatoniquement : Alt+Maj+↑

Abaisser la hauteur diatoniquement : Alt+Maj+↓

Changer une hauteur de note pour son enharmonique : J

Silence : 0 (zéro)

Intervalles

Ajoute un intervalle au-dessus de la note courante Alt+1à8

Mise en page

Étirer/Rétrécir la(les) mesure(s) sélectionnée(s) : }/{
Ajuster l'espace entre 2 portées dans un système, pour toute la partition : Maj+ cliquer/glisser.
Ajouter un saut de système : Sélectionner la dernière barre de mesure de la ligne puis Entrée
(une deuxième pression l'annule)

Ajouter un saut de page : Sélectionner la dernière barre de mesure de la page puis :
Ctrl+Entrée (Mac : Cmd+Entrée)

Inverser la direction (hampe, liaisons de prolongation ou de phrasé, crochet de division
irrégulière, etc.) : X

Tête de note en miroir : Maj+X

Articulations

Liaison de prolongation : +
Liaison de phrasé : S
Staccato : Maj+S
Crescendo : <
Decrescendo : >

Saisie des Textes

Texte de portée : Ctrl+T (Mac :⌘+T)
Texte de système : Ctrl+Maj+T (Mac : Ctrl+Maj+T)
Texte de Tempo : Alt+T
Symbole d'accord : Ctrl+K (Mac : ⌘+K)
Repère : Ctrl+M (Mac : ⌘+M)

Saisie des Paroles

Entrer des paroles sous la note sélectionnée : Ctrl+L (Mac : ⌘+L)
Syllabe précédente : Maj+Espace
Syllabe suivante si la syllabe courante et les suivantes sont séparées par un '-' : -, sinon Espace
← : Déplace la syllabe sur la gauche d'1 esp.
→ : Déplace la syllabe sur la droite d'1 esp.
Ctrl+← : Déplace la syllabe sur la gauche de 0.1 esp. (Mac : ⌘+←)
Ctrl+→ : Déplace la syllabe sur la droite de 0.1 esp. (Mac : ⌘+→)
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Alt+← : Déplace la syllabe sur la gauche de 0.01 esp.
Alt+→ : Déplace la syllabe sur la droite de 0.01 esp.
Aller au couplet précédent (en mode d'édition) : Ctrl+↑ (Mac : ⌘+↑)
Aller au couplet suivant (en mode d'édition) : Ctrl+↓ (Mac : ⌘+↓)

Découvrez plus de raccourcis pour les paroles : Paroles.

Affichage

Navigateur : F12 (Mac : fn+F12)
Fenêtre de lecture: F11 (Mac : fn+F11)
Mélangeur : F10 (Mac : fn+F10)
Palettes : F9 (Mac : fn+F9)
Inspecteur : F8 (Mac : fn+F8)
Clavier de piano : P
Filtre de sélection : F6
Affichage plein écran : Ctrl+U
Activer / Désactiver les pauses multi mesures : M

Divers

Créer une 'N'ouvelle partition : Ctrl+N
'O'uvrir une partition située sur votre disque :Ctrl+O
Rendre Invisible / Visible la sélection : V.
Ouvrir la fenêtre Instruments : I.

Une question sans réponse ? Postez la sur le forum.

Options de la ligne de commande

This translation is outdated, see the English version for a reference: Command line options

Vous pouvez démarrer MuseScore depuis la ligne de commande en tapant

mscore [options] [nom_du_fichier] (Mac etLinux)
MuseScore.exe [options] [nom_du_fichier] (Windows)

[options] et [nom_du_fichier] sont optionnels.

Voir aussi Rétablir toutes les préférences par défaut qui donne des instructions détaillées sur
comment et où trouver et exécuter MuseScore depuis la ligne de commande sur diverses plateformes
compatibles.

Les options suivantes sont disponibles

-?, -h, --help
Affiche l'aide (ne fonctionne pas sous Windows)

-v, --version
Affiche la version actuelle de MuseScore dans la ligne de commande sans démarrer l'interface
graphique (ne fonctionne pas sous Windows)

--long-version
Affiche la version actuelle de MuseScore et la révision dans la ligne de commande sans
démarrer l'interface graphique (ne fonctionne pas sous Windows)

-d, --debug
Démarre MuseScore en mode débogage

-L, --layout-debug
Démarre MuseScore en mode débogage de la mise en page

-s, --no-synthesizer
Désactive le synthétiseur logiciel intégré

-m, --no-midi
Désactive l'entrée MIDI

-a, --use-audio <pilote>
Utilise un pilote audio : jack, alsa, pulse, portaudio

-n, --new-score
Force le démarrage avec l'Assistant Nouvelle Partition quel que soit le paramétrage du mode
de démarrage
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-I, --dump-midi-in
Affiche toutes les entrées MIDI dans la console

-O, --dump-midi-out
Affiche toutes les sorties MIDI dans la console

-o, --export-to <nom_fichier>
Exporte le fichier actuellement ouvert vers le fichier spécifié <nom_fichier>. Le type de fichier
dépend de l'extension du nom de fichier. Cette option permute vers le mode "convertisseur" et
évite toute interface graphique. Vous pouvez aussi ajouter un nom de fichier avant l'option -o si
vous souhaitez importer et exporter des fichiers depuis la ligne de commande. Par exemple
mscore -o "My Score.pdf" "My Score.mscz"

-r, --image-resolution <dpi>
Détermine la résolution d'affichage pour la sortie vers les fichiers "*.png" dans le mode
convertisseur. La résolution par défaut est 300 dpi (points par pouce), soit 118 points par
centimètre.

-T, --trim-margin <marge>
Recadre les images PNG et SVG exportées pour enlever les pourtours blancs de la partition. Le
nombre spécifié permet d'ajouter autant de pixels en tant que marge ; indiquez 0 pour une image
sans aucune marge. Pour un export SVG, cette option ne fonctionne qu'avec les partitions sur
une seule page.

-x, --gui-scaling <facteur>
Redimensionne l'affichage de la partition et d'autres éléments de l'interface graphique avec le
facteur spécifié. À n'utiliser que pour des affichages à grande résolution.

-S, --style <style>
Charge un fichier de style ; utile pour convertir avec l'option -o

-p, --plugin <nom_du_plugin>
Exécute le plugin spécifié

--template-mode
Mode sauvegarde du modèle, pas de taille de page

-F, --factory-settings
Utilise seulement les préréglages standards ou "réglages d'usine", et supprime les préférences.
Pour les détails, consultez Rétablir toutes les préférences par défaut

-R, --revert-settings
Utilise seulement les préréglages standards ou "réglages d'usine", mais ne supprime pas les
préférences.

-i, --load-icons
Charge les icônes depuis le système de fichier. Utile si vous souhaitez modifier les icônes de
MuseScore et prévisualiser les changements

-e, --experimental
Active les fonctionnalités expérimentales. Voir par exemple Layer (experimental).

-c, --config-folder <répertoire>
Assigne le répertoire de configuration.

-t, --test-mode
Active le mode Test.

-M, --midi-operations <fichier>
Spécifie le fichier des opérations d'import MIDI.

-w, --no-webview
Pas de vue web dans le Centre de démarrage.

-P, --export-score-parts
Utilisé avec l'option -o .pdf, exporte la partition et les parties.

Qt Toolkit Options

-style= <style>
-style <style>

Détermine le style de l'interface graphique applicative. Les valeurs possibles sont "motif",
"windows" et "platinum". En fonction de la plateforme, d'autres styles peuvent être disponibles.

-stylesheet= <feuille_de_styles>
-stylesheet <feuille_de_styles>

Règle la feuille de styles pour l'application. La valeur "feuille_de_style" correspond au chemin
vers un fichier qui contient la feuille de styles.

-platform <nom_plateforme[:options]>
Spécifie le plugin Qt Platform Abstraction (QPA).

Exemple : MuseScore.exe -platform windows:fontengine=freetype

Voir aussi
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Rétablir toutes les préférences par défaut
Layer (experimental)

Liens externes

http://doc.qt.io/qt-5/qapplication.html#QApplication
http://doc.qt.io/qt-5/qguiapplication.html#QGuiApplication

Fichier attaché Taille
midi_import_options.xml 1.73 Ko

Une question sans réponse ? Postez la sur le forum.

219

https://musescore.org/fr/node/179376
https://musescore.org/en/node/38076
http://doc.qt.io/qt-5/qapplication.html#QApplication
http://doc.qt.io/qt-5/qguiapplication.html#QGuiApplication
https://musescore.org/sites/musescore.org/files/midi_import_options_0.xml
https://musescore.org/fr/forum

	Pour commencer
	Installation
	Chromebook
	Liens externes

	Installation sur Windows
	Windows
	Installation
	Démarrer MuseScore
	Désinstallation

	Voir aussi

	Installation sur macOS
	Installation
	Désinstallation
	Installer avec Apple Remote Desktop
	Liens externes

	Installer sur Linux
	Linux
	AppImage
	Step 1 - Download
	Step 2 - Give execute permission
	Step 3 - Run it!
	Installing the AppImage (optional)
	Using command line options

	Distribution Packages
	Fedora

	Voir aussi
	External links

	Créer une nouvelle partition
	Centre de démarrage
	Créer une nouvelle partition
	Titre, compositeur et autre information

	Sélectionner un modèle
	Instrument et partie vocales
	Ajouter une portée
	Ajouter une portée liée
	Sélectionner l'armure et le tempo
	Indication de mesure, levée (anacrouse), et nombre de mesures

	Ajuster la partition après sa création
	Modèles
	Voir aussi
	Liens externes

	Paramètres linguistiques et mise à jour des traductions
	Changer la langue
	Mettre à jour les traductions
	Voir aussi

	Vérifier les mises à jour
	Vérification automatique de mises à jour
	Vérification manuelle de mises à jour
	Voir aussi


	Bases
	Saisie des notes
	Saisie simple des notes et des silences
	Étape 1 : Choisir une position de départ
	Étape 2: Mode de saisie de notes
	Étape 3: Durée de note (ou de silence)
	Étape 4 : Saisir la hauteur (ou un silence)

	Périphériques d'entrée
	Souris
	Clavier
	Clavier MIDI
	Clavier de piano virtuel

	Autres modes de saisie
	Coloration des notes extrêmes de l'étendue de l'instrument
	Petites notes
	Propriétés des notes
	Changer la hauteur d'une note (sans changer la durée)
	Voir aussi
	Liens externes

	Affichage - Navigation
	Menu affichage
	Barres d'outils / Panneaux
	Zoom
	Afficher la Barre d'état
	Visualiser deux partitions
	Options de visibilité
	Plein écran

	Affichage par page/continu
	Affichage par page
	Affichage continu

	Navigateur
	Barre d'outils
	Panneaux latéraux
	Rechercher
	Voir aussi

	Annuler et rétablir
	Copier / coller
	Notes
	Copier ou couper
	Coller
	Échange avec le presse papier

	Autres éléments
	Copier ou couper
	Coller
	Échange avec le presse papier

	Répétition rapide
	Duplication
	Filtre de sélection
	Voir aussi
	Liens externes

	Enregistrer / Exporter / Imprimer
	Menu Fichier
	Formats dans les menus 'Enregistrer sous', 'Enregistrer une copie', 'Enregistrer la sélection', 'Enregistrer en ligne'
	Formats dans les menus 'Exporter' (et 'Exporter les parties')
	Imprimer

	Voir aussi

	Mode Édition
	Notes
	Positionnement des notes

	Voir aussi

	Modes de sélection
	Sélection d'un objet simple
	Sélection d'une plage
	Sélection d'éléments non consécutifs
	Sélectionner tous les éléments similaires
	Ces sélections sont utilisées pour :
	Voir aussi

	Opérations sur les mesures
	Ajout
	Ajouter une mesure à la fin d'une pièce
	Ajouter plusieurs mesures (à la fin d'une pièce)

	Insertion
	Insérer une mesure vide
	Insérer plusieurs mesures

	Supprimer
	Supprimer une simple mesure
	Supprimer une suite de mesures
	Supprimer depuis une mesure, jusqu'à la fin
	Supprimer depuis le début, jusqu'à une mesure

	Propriétés
	Portées
	Durée de la mesure
	Autres

	Numérotation
	Scinder et joindre
	Voir aussi

	Palettes et Espaces de travail
	Espaces de travail
	Mode Palette seule
	Accrochage / décrochage des panneaux latéraux
	Espace de travail personnalisé

	Palettes
	Ajouter des symboles à votre musique
	Palettes de base et avancées
	Palettes de l'espace de travail "avancé"
	Palettes personnalisées
	Menu contextuel des palettes

	Palette Principale
	Textes et Lignes ajoutés depuis une palette personnalisée
	Voir aussi

	Tonalité de concert
	Voir aussi

	Partager les partitions en ligne
	Créer un compte
	Partager une partition directement depuis MuseScore
	Télécharger une partition sur MuseScore.com
	Éditer une partition sur MuseScore.com
	Voir aussi


	Notation
	Alternatives de reprise
	Texte
	Lecture
	Liens externes

	Altérations accidentelles
	Recalculer les altérations
	Voir aussi
	Liens externes

	Armures
	Remplacer une armure existante
	Ajouter une nouvelle armure
	Supprimer une armure
	Rappel des armures
	Bécarres dans les changements d'armure
	Armures et pauses multimesures
	Rappels d'armure et sauts de section
	Armures personnalisées

	Arpèges et glissandos
	Liens externes

	Articulations et ornements
	Articulations
	Ornements
	Ajouter une articulation ou un ornement
	Ajouter une altération accidentelle à une articulation
	Ajouter un point d'orgue à une barre de mesure
	Raccourcis clavier

	Ajuster la position
	Propriétés des articulations
	Voir aussi
	Liens externes

	Bends
	Appliquer un bend
	Ajuster la taille
	Ajuster le positionnement
	Bends personnalisés

	Barres de mesure
	Changer le type de barre
	Créer un ensemble de portées
	Voir aussi

	Clefs
	Ajouter une clef
	Rappel des clefs
	Supprimer une clef

	Crescendo
	Crochets système
	Supprimer
	Ajouter
	Changer
	Éditer
	Décalage horizontal

	Divisions irrégulières, N-olets
	Instructions
	Mode Saisie de notes
	Propriétés
	Style
	Voir aussi
	Liens externes

	Fioritures
	Instructions
	Liens externes

	Indications de mesure
	Créer vos propres indications de mesure
	Changer les ligatures par défaut
	Supprimer une indication de mesure personnalisée
	Durée de la mesure différente de l'indication de mesure: Anacrouse et Cadence
	Indications de mesure "locale"
	Voir aussi

	Liaisons de phrasé
	Première méthode
	Deuxième méthode
	Troisième méthode
	Ajustements
	Liaisons en pointillés
	Voir aussi

	Liaisons de prolongation
	Première méthode
	Seconde méthode
	Accords liés
	Inverser une liaison

	Ligatures
	Ajuster les ligatures
	Ajuster l'angle de la ligature
	Hauteur des ligatures
	Ajuster les ligature orphelines
	Inverser le sens des ligatures
	Ligatures horizontales
	Restaurer le mode de connexion des ligatures
	Voir aussi
	Liens externes

	Ligne octave
	Appliquer une ligne d'octave
	Changer la durée
	Lignes personnalisées
	Liens externes

	Lignes
	Appliquer des lignes dans une partition
	Modifier la longueur
	Lignes spéciales et propriétés de "ligne"
	Copie de lignes
	Lignes d'ornements
	Liens externes
	Voir aussi

	Mesure de silences
	Mesure de silence
	Pauses multi-mesures
	Instructions
	Limitations

	Diviser une pause multi-mesures

	Notation pour percussions
	Palette pour percussions
	Méthodes de saisie des notes
	Clavier MIDI
	Clavier de piano virtuel
	Clavier d'ordinateur
	Souris

	Éditer le Set de batterie
	Roulement
	Liens externes

	Reprises et sauts
	Lecture
	Symboles et textes de répétition
	Sauts
	Repères
	Exemples
	Voir aussi
	Liens externes

	Respirations et pauses
	Tablature
	Modifier les propriétés de la tablature
	Créer une nouvelle portée tablature
	Avec l'Assistant de création
	Changer le type de portée

	Éditer les paramètres des cordes
	Combiner les portées standard et tablature
	Créer un système standard/tablature avec l'Assistant "Créer une nouvelle partition"
	Créer un système standard/tablature à partir d'une portée existante
	Modifier un système standard/tablature de lié à non lié (ou vice-versa)

	Saisie de nouvelles notes
	Modification des notes existantes
	Résumé des touches
	Liens externes

	Transposition
	Transposition chromatique, par "tonalité"
	Transposition chromatique, par intervalle
	Transposition diatonique
	Instruments transpositeurs
	Voir aussi{#see-also}

	Trémolo
	Voix
	Quand utiliser des voix?
	Instructions
	Cacher les silences
	Intervertir les voix
	Changer une note de voix (without swapping)
	Voir aussi
	Liens externes


	Son et lecture
	Banques de sons (SoundFonts)
	Généralités
	Installer une SoundFont
	Désinstaller une SoundFont

	Synthétiseur
	Listes de SoundFonts
	SoundFonts spécialisées

	Résolution des problèmes
	Voir aussi
	Liens externes

	Changement d'instrument en cours de portée
	Insérer un changement d'instrument en cours de portée
	Voir aussi

	Importation MIDI
	Opérations possibles

	Modes de lecture
	Fenêtre de lecture
	Décompte
	Métronome
	Boucle

	Mélangeur
	Muet et Solo
	Contrôleurs
	Sons - Instruments
	Changement de son en cours de portée (pizz., con sordino, etc.)
	Voir aussi

	Swing
	Mettre en place le swing
	Retour à un rythme binaire{#swing-off}
	Paramètres du Swing
	Paramètres du texte de Swing
	Réglage global du swing


	Synthétiseur
	Généralités
	Banque de sons (SoundFont)
	Onglet Fluid
	Charger une soundfont

	Onglet Zerberus
	Volume
	Onglet Effets Principaux
	Onglet Zita 1

	Onglet Réglage du diapason
	Changer la fréquence du diapason
	Régler la fréquence par défaut
	Changer la Fréquence du diapason pour une seule partition

	Voir aussi

	Tempo
	Indication de tempo
	Ritardando et accelerando
	Points d'orgue

	Fenêtre de lecture

	Nuances
	Indications de nuances
	Ajuster le volume de lecture des nuances

	Fenêtre de lecture
	Liens externes


	Texte
	Voir aussi
	Style de Texte
	Style et propriétés de texte
	Type de texte
	Créer un nouveau style de texte
	Options d'application
	Réinitialiser le style de texte
	Voir aussi

	Édition de texte
	Symboles et caractères spéciaux
	Voir aussi

	Doigtés
	Voir aussi

	Paroles
	Caractères spéciaux
	Ajuster individuellement les lignes de parole
	Voir aussi
	Liens externes

	Repères
	Comment créer des Repères
	Création manuelle
	Création automatique

	Remettre les repères dans l'ordre
	Rechercher un Repère
	Style de texte
	Voir aussi
	Liens externes

	Symboles d'accord
	Syntaxe des symboles d'accord
	Style de symboles d'accord
	Apparence
	Noms des notes
	Position

	Voir aussi

	Texte de portée - Texte de système
	Texte de portée
	Texte de système
	Voir aussi

	Textes de base
	Ajouter un texte
	Formater un texte
	Style de texte
	Propriétés d'un texte
	Style de caractère d'un texte

	Positionnement d'un élément texte


	Formatage
	Mise en page et formatage
	Agir sur la mise en page
	Mise en page → Paramètres de la page
	Mise en page → Étirer, Rétrécir
	Style → Général... → Partition
	Style → Général... → Page
	Interactions entre musique et marges des pages
	Distance entre les portées
	Distance entre les systèmes
	Marges des paroles
	Marges de cadre vertical
	Seuil de remplissage du dernier système

	Style → Général... → En-tête, Pied de page, Nombres
	Style → Général... → Système
	Style → Général... → Mesure
	Style → Général... → Barres de mesure
	Palette → Sauts & espacements
	Style → Général... → Notes
	Style → Général... → Clefs
	Style → Général... → Arpèges
	Style → Général... → Ligatures
	Style → Général... → Liaisons
	Style → Général... → Tailles
	Style → Général... → Lignes
	Style → Général... → Pédales et trilles
	Style → Général... → Symboles d'accord, diagrammes d'accord
	Style → Général... → Basse continue
	Style → Général... → Articulations, Ornements
	Style → Général... → Altérations
	Style → Général... → Divisions irrégulières
	Boutons [Appliquer] et [Ok]
	Appliquer à toutes les parties en une seule fois
	Enregistrer et charger un style
	Voir aussi
	Liens externes

	Style général : Mesure
	Options

	Cadres
	Cadre horizontal
	Cadre vertical
	Cadre de texte
	Créer un cadre
	Supprimer un cadre
	Éditer un cadre
	Appliquer un saut à un cadre
	Voir aussi
	Liens externes

	Capture d'image
	Voir aussi

	Image
	Voir aussi

	Paramètres de la page
	Taille de la page
	Marges
	Échelle - Espace de portée
	Divers

	Sauts et espacements
	Ajouter un saut ou un espacement
	Éditer un espacement
	Supprimer un saut ou un espacement
	Saut de section
	Propriétés d'un saut de section

	Voir aussi

	Aligner des éléments
	Aligner sur la grille


	Fonctionnalités avancées
	Changer les hauteurs des notes sans changer le rythme
	Voir aussi {#see-also} :

	Diagrammes d'accord
	Créer un diagramme d'accord
	Éditer les propriétés

	Extraction des parties séparées
	Définir les parties
	Définir toutes les parties en une fois

	Exporter les parties
	Enregistrer une partie

	Formats de fichier
	Formats natifs de MuseScore
	Format MuseScore (*.mscz)
	Format MuseScore non compressé (*.mscx)

	Fichiers de sauvegarde MuseScore
	Fichier de sauvegarde MuseScore (*.mscz, ou *.mscx,)

	Visualiser et imprimer (export seulement)
	PDF (*.pdf)
	PNG (*.png)
	SVG (*.svg)

	Écouter (export seulement)
	WAV audio (*.wav)
	FLAC audio (*.flac)
	Ogg Vorbis (*.ogg)
	MP3 (*.mp3)

	Partager avec d'autres logiciels de notation musicale
	MusicXML (*.xml)
	MusicXML compressé (*.mxl)
	MIDI (*.mid, *.midi, *.kar)
	MuseData (*.md) (import seulement)
	Capella (*.cap, *.capx) (Import seulement)
	Bagpipe Music Writer (*.bww) (import seulement)
	BB (*.mgu, *.sgu) (import seulement)
	Overture (*.ove) (import seulement)
	Guitar Pro (*.GTP, *.GP3, *.GP4, *.GP5, *.GPX) (Import seulement)

	Voir aussi

	Inspecteur et propriétés d'objet

	L'inspecteur
	Les catégories dans l'inspecteur
	Élément
	Groupe d’éléments
	Segment
	Accord
	Note
	Sélection


	Propriétés dans le menu contextuel
	Propriétés des articulations
	Propriétés du diagramme d'accord
	Propriétés des lignes
	Propriétés de la mesure
	Propriétés de la portée
	Propriétés du texte
	Propriétés de l'indication de mesure
	Voir aussi
	Les plugins
	Généralités
	Installation
	Sur Windows
	Sur macOS
	Sur Linux

	Activer / désactiver des plugins
	Créer / Éditer / Lancer des plugins
	Plugins pré-installés par défaut
	ABC Import
	Break Every X Measures
	Notes → Color Notes
	Create Score
	helloQml
	Notes → Note Names
	Panel
	random
	random2
	run
	scorelist
	ScoreView
	Walk

	Voir aussi

	Ligatures sur deux portées
	Voir aussi

	Modes de saisie
	Une à une (défaut)
	Changer les hauteurs
	Rythme
	Temps réel (automatique)
	Temps réel (manuel)
	Voir aussi
	Liens externes

	Notation pour musique ancienne
	Notation sans barre
	Mensurstrich
	Ambitus
	Mensural time signatures
	Voir aussi

	Outils
	Ajouter/Supprimer les sauts de ligne
	Éclater
	Rassembler
	Rassembler depuis plusieurs portées
	Rassembler depuis une seule portée

	Remplir avec des slashs
	Activer la notation rythmique avec des slashs
	Remettre les repères dans l'ordre
	Copier les paroles dans le presse-papier
	Voir aussi

	Palette Principale
	Symboles
	Trouver un symbole
	Utiliser un symbole
	Fusion de symboles

	Voir aussi

	Propriétés de la Partition
	Balises méta préexistantes
	Modifier une balise méta
	Ajouter une nouvelle balise méta
	En-têtes et pieds de page
	Voir aussi

	Propriétés de la portée
	Propriétés de la portée (ou de la partie) - Options
	Propriétés de la portée : Options spécifiques aux instruments à cordes pincées
	Propriétés avancées de style
	Portée Standard pour Percussion - Options spécifiques
	Tablature - Options spécifiques
	Indications de frette
	Figures rythmiques
	Prévisualisation

	Changer d'instrument
	voir aussi

	Préférences
	Général
	Fond
	Saisie des notes
	Partition
	E/S
	Import
	Exporter
	Raccourcis clavier
	Mises à jour
	Voir aussi

	Récupération de fichiers après un crash
	Méthode pour sauvegarder des partitions après une session de récupération
	Retrouver les partition récupérées et enregistrées automatiquement
	Voir aussi
	Liens externes


	Têtes de notes
	Groupes de tête de note
	Changer de type de tête de note
	Changer de groupe de têtes de notes
	Têtes de notes partagées


	Nouvelles fonctionnalités de MuseScore 2
	voir aussi

	Support
	Aider et améliorer la traduction
	Traduction du logiciel
	Traduction du site et du manuel en ligne
	Voir aussi

	Incompatibilités connues
	Incompatibilités matérielles
	Incompatibilités logicielles
	AVG Internet Security bloque MuseScore
	Problème de polices sous Mac OS X
	Problème de polices sous Linux
	Fenêtre de dialogue "Enregistrer sous" vide sous Linux



	Appendices
	Accessibilité
	Introduction
	Premier lancement de MuseScore
	Se repérer dans l'interface de MuseScore
	La fenêtre principale
	Lire la partition - Lecture de la partition - Exploration de la partition
	Se déplacer en avant ou en arrière dans le temps
	Déplacements entre les notes d'un accord - Moving between notes at a given point in time.
	Filtrer l'exploration de la partition

	Joueur de partition - Lecteur de partition
	Éditer une partition
	Personnalisation

	Glossaire
	Liens externes

	Limitations connues de MuseScore 2.1
	Indications de mesure locales
	Regrouper les rythmes
	Portée tablature liée à une portée standard
	Changement d'instrument
	Mélangeur
	En-tête et Pied de page, Nombres

	Raccourcis clavier
	Navigation
	Saisie des notes
	Valeurs rythmiques
	Voix
	Hauteurs
	Intervalles

	Mise en page
	Articulations
	Saisie des Textes
	Saisie des Paroles
	Affichage
	Divers


	Options de la ligne de commande
	Qt Toolkit Options
	Voir aussi
	Liens externes



